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PREFACE 

The innovation in Information and Communication Technology (ICT) has revolutionized 

the way of our lives. ICT has become an integral part to perform our daily activities at 

home as well as in the offices. This advancement is approaching towards paperless 

environment in which office automation are the most important skills to acquire. Office 

Automation is the process of information processing using the hardware and software 

technologies. It is used to create, store and manage digital data and information for 

executing basic tasks. A variety of ICT tools and products are available for the office 

automation. These ranges from typing official documents, setting spreadsheets and 

preparing presentations.  

This course has been designed to develop basic automation skills among the students. It 

will help to create basic professional competencies for using word processor, spreadsheet 

and presentations tools. The course is in line with the vision of our Vice Chancellor, 

Professor Dr. Zia-Ul-Qayyum, to transform AIOU as a technology-based University 

through a gradual process. It will strengthen the pool of professional curriculum and the 

courses at AIOU. It will also help students to use basic automation skills for creating 

assignments, designing research reports, perform data analysis and prepare presentations. 

They will also be prepared for the job market of today’s digital era.  

 

Dr. Moiz Ud Din Ahmed 

Incharge 
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INTRODUCTION 

Office Automation course is aimed at for students to learn about the basic office automation 

skills. The course will help students to prepare their assignments, research reports and 

presentation. It will also provide an understanding of office automation skills. This will 

help to take up job opportunities in different fields after they passed out. This curriculum 

is intended to deliver student career aptitudes and provide them with the proficiencies set 

that can be employed in the offices in common. The students will be offered exposure to 

presentation of diverse computer competencies, Microsoft Office, Data Entry, 

documentation, computer-based filing, routine office talents and associated employment 

exposure. The course is based on hand-on-experience to practical work along with the 

concept that makes our learner distinctive. 

Allama Iqbal Open University courses are devised with objective to deliver admirable and 

quality education which helps learner to gain knowledge of IT and build talents set in their 

relevant disciplines. The course is based on MS Office 365 which offered the state of the 

art office automation features and most advance functionality of this tool.  

This course covered office-based education besides of self-assessment questions and 

activities which certifies the expertise and competences, appropriately studied. The 

aptitude evaluation of learner after completion of the unit includes self-assessment tests 

will provide the learner insight about the skills gain during the study and the professional 

passion of study of our institute. Knowledge about practical competences which is the most 

important to inculcate and gain confidence about the learning objects. The leaner will be 

provided exposure to the following during studying this book: 

 

UNIT-1 Emphasis to overview the technical feature available in Word 365. 

UNIT-2 Present the understanding of graphics tools available like appearance, inserting 

graphic objects in Word Processor 

UNIT-3 Elaborate the advance features in Word 365 with step by step practice. 

UNIT-4 Covering the key and a few of the advance notion of Spreadsheet. 

UNIT-5 Illustrate the functionalities and working of different formulas, predefine 

functions and some of the customized features in spreadsheet regarding some 

financial and mathematical terms. 

UNIT-6 Inculcate the advance features in spreadsheets to filter data, import and export 

data in Spreadsheet. It covers the protection mechanism and some of the 

advance data filtering techniques. 
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UNIT-7 Provide a briefed understanding about the fundamental concepts of MS 

PowerPoint for creating presentation from template and customize the existing 

one. 

UNIT-8 Describe the techniques with step by step illustration to prepare a presentation 

slide show for presenting business idea or topic presentation including 

multimedia objects. 

UNIT-9 Deliver the learner with ability to format document in Urdu language using 

appropriate office automation tools and installing the relevant packages. 

Department of Computer Science appreciated the efforts made by our faculty member, staff 

and visiting faculty in contribution to the writeup and reviewing including Dr. Moiz Uddin 

Ahmed Siddiqui, Mr. Muhammad Asif and Ms. Asifa Awan. We are also apprceoate the 

efforts of course Editor Mr. Fazal Karim by editing the book in short time.  

 

Mohammad Qasim Khan 

Assistant Professor 
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1. WORD PROCESSOR OVERVIEW 
 

 Introduction: 
 

This unit covers advances features of word processor application. It mainly focus 

on different text formatting tools and their applications on document designing and 

also highlights the concepts of tables and different operations on table data. 

 

 Objectives: 
 

After studying this unit, the learners may be able to: 

 

 Explain and exemplify applications of various bullets and numbering in a 

document. 

 Understand the terms “Highlighting and Shading” the text. 

 Design a document using different formatting tools. 

 Identify importance of text formatting in word processor application. 
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 Introduction to Word Processor: 
 
Word processor is a software application mainly aimed to create, design and formatting 

various types of documentation. The software is very popular in every type of organization 

as most of the documentation in office and other related daily life activities are produced 

using word processor. The application is enriched with different tools for creating and 

designing diverse types of documents. Today number of different word processor 

applications are available in the market, some are open source, and others are licensed 

based. The most popular among them are OpenOffice, Apple Pages, Applix Word, 

QuickOffice, Sun Star Office, Corel Word Perfect and MS Word etc. In this course will 

emphasis on Microsoft Word (Microsoft Office 365), Figure 1.1: Application Windows of 

MS-Word shows the layout of MS-Word Application Window, taken from office 365. 

Quick Access Toolbar Menu and Toolbar

Sizing & 

Close buttons

Current 

Page

Zoom control

Status Bar

Page Views

 
Figure 1.1: Application Windows of MS-Word 

 
It enables to create multiple types of files, including text files (.txt), rich text files (.rtf), 

HTML files (.htm & .html), and documents files (.doc & .docx). Some modern versions 

can also be used to create XML files (.xml). Some of the application areas where word 

processor is used are listed below: 

 Book Writeup: Writing of a book document. 

 Document: Any text document that entails organizing. 

 Journal: Keep a digital version of routine papers. 

 Letter: Write a letter to someone and or to some many person using mail merge 

feature to automatically fill in the name, address, and other fields of the letter. 

 Product Brusher: Designing a layout and describe various features of a new product 

or service. 
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 Memo: Create a memorandum for employees. 

 Report: Generating different types of statement or book description. 

 Curriculum Vitae: Create or maintain your profile. 

 

Now we will explore the core concepts of the main topics of this unit in the next on-going 

sections of this unit. 

 

 Highlight and Shading Text: 
Highlighting and shading are important in a word processor. Both serves the same feature 

to show-out the text or to palette the text with specific color. However, there is a difference 

in both as listed below in Table No. 1.1: 

 

Table No. 1.1: Difference between Highlighting and Shading Text 
Highlighting Shading 

Applied to a character or paragraph on 

selection basis. 

Applied to whole line where cursor is 

active. 

Color Palette with 15 fixed color is 

available to choose color. 
Highlighter Color PaletteHome

 
Figure 1.2: Highlighting Color Palette 

Color Palette with 60 color is available to 

choose color or select different color from 

more option available. 
Home Tab Color PaletteHighlighter

 
Figure 1.3: Shading Color Palette 

The feature is not available for table 

formatting. 

The feature is available for table formatting. 
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Home Tab Shading ToolHighlighter

 
Figure 1.4: Highlighting and Shading on Table 

Highlighting is proposed to brighten the 

text. 

Shading is proposed additional as an 

attractive feature 

 
Please Note that shading refers to the background color of the text, and generally 

corresponds to something similar as background color of a table call.  Highlighting is 

exactly like using a highlighter pen to color character where a word or a paragraph needs 

to make it attractive, just to highlighting text in a book. Now we will tart our activity how 

to highlight and shaded a text in step by step procedure. Please open MS Word 365 

application in your system. 

 

1.4.1 Highlight Selected Text: 

 
To highlight the text, follow the following steps:  

Step 1: Select the text using keyboard or by using mouse device to be highlighted. 

Step 2: Go to “Home” Tab and, select the arrow next to “Text Highlight Color” . 

Step 3: A color palette will be displayed as shown in figure 1.2, choose the desire color 

from the color palette. 

 

1.4.2 Highlight Multiple Parts of a Document: 

 
To highlight the text at multiple places in a document, follow the following steps:  

Step 1: Go to “Home” and select the arrow next to “Text Highlight Color”. 

Step 2: Choose your desired color from the palette. The highlighter tool shows the 

same color you choose and the pointer shape changed to  now you can 

select the text which you want to highlight. 
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Step 3: Select the text or graphic to highlight. 

Step 4: To stop highlighting, click the highlighter tool again to “Stop Highlighting”, 

or press Esc. The mouse pointer becomes a  when you point to your 

document. 

 

1.4.3 Remove Highlighting from Part or All of a Document: 

 
To remove the highlighting effects from the text at multiple places in a document, follow 

the following steps:  

Step 1: Choose the text to remove highlighting or press “Ctrl + A” for selection of all 

the text in the current working document. 

Step 2: Go to “Home” tab and click the tools of “Text Highlight Color”. 

Step 3: Select “No Color”. 

 

 Past Special: 
 
Word processor provide the facility of Paste Special. It is a feature that have control over 

the content to be displayed when pasted from the clipboard (a short memory where copied 

material is resided). Paste special is a generic tool of most of the word processor 

applications like Microsoft Office and OpenOffice etc. For example, a text copied from a 

website may have HTML formatting, we can bring it in required format by using paste 

special. These steps of implementing paste special are as follows. 

Step 1: Select text, picture, text, or object that you want to paste and click cut or copy 

option. 

Step 2: Open the word processor and place the cursor at the location where you want to 

insert it. 

Step 3: On the “Home” tab, in the “Clipboard” group, click the arrow under Paste, click 

“Paste Special”,  and then choose one of the enlisted options. 

Step 4: Select one of the text formatting options given in the window. For example, 

HTML Format. 

Step 5: Then click OK. 



8 

Home Tab Paste Special Dialog Box

 
Figure 1.5: Paste Special Dialog Box 

It allows few choices as shown in the figure above to facilitate the user. One can also use 

this command in Excel and other applications when pasting data into cells. 

 

 Change Text Case: 
 
Change Case means changing the selected text from one case to another such as an 

Uppercase, Lowercase, Capitalize Each Word, Toggle Case or Sentence Case, as shown in 

Figure 1.6 and Figure 1.7 

Home Tab

 
Figure 1.6: Change Case Menu 
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Home Tab

 
Figure 1.7: Changing Text to Sentence Case 

 

1.6.1 Sentence Case: 

 
This option convert the first letter into its capital form. It is usually used with writing the 

document contents. Following steps are used to practice the sentence case. 

Step 1: Select the desired text. 

Step 2: Go to “Home” tab and select the “Change Case” icon as shown in Figure No. 

1.4 

Step 3: Select “Sentence Case” option, which is the first option in the drop-down list. 

 

1.6.2 Lower Case: 

 
This option converts all letters into lower form. We also call it small letters case as shown 

in the Figure 1.8 . 
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Figure 1.8: Changing Text to Lower Case 

 
The steps for converting all the selected text in the document is describe bellow: 

Step 1: Select the text which is to be changed to small letter. 

Step 2: From the tab menu select the “Home” tab and select the “Change Case” icon a 

drop-down menu appears. 

Step 3: Choose the “lowercase” option from the display list. 
 

1.6.3 Upper Case: 

 
The purpose of this change case is to capitalize all the selected letter of the text. Upper 

case or capitalization will change the text formatting. The procedure is as follows: 
 

Step 1: Make a range of the text in your document that is be changed to upper case. 

Step 2: Go to “Home” tab and then select the “Change Case” icon as shown in the figure 

below. 

Step 3: Choose the “Uppercase” option. 
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Home Tab

 

Figure 1.9: Changing Text to Upper Case 
 

1.6.4 Capitalize Each Word Case: 

 
Word processor application provide the facility “Capitalize Each Word”. To do this, 

follow the steps below: 

 
Figure 1.10: Changing Text to Capitalize Each Word Case 

 

Step 1: Select the desired text. 

Step 2: Go to “Home” tab and choose the “Change Case” icon. 

Step 3: From the list of option choose “Capitalize Each Word”, which is the fourth 

option in the list displayed. 
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1.6.5 Toggle Case: 

 
This option of change case provides the facility to convert all the text to upper case except 

of the first character in each sentence lower as shown in the figure 1.11. Following these 

steps to convert the text into toggle case. 

Home Tab

 
Figure 1.11: Changing Text to Toggle Case 

 

Step 1: Select the desired text. 

Step 2: Go to “Home” thttp://www.addbalance.com/word/ribbonsHome.htmab, click 

on the “Change Case” icon. 

Step 3: Click on the then select the “tOGGLE cASE”, which is the fifth option of the 

drop-down list. 

 

 Copy Formatting: 
 
In addition to copy and paste, the formatting style can also be copied and applied to a 

desired text. For example, your document has some type of headings style and you want to 

apply the same style to the remaining headings, then you can follow the following steps  

Note: As already mentioned in the start of our unit we are using Microsoft Word 365 

throughout in this course, the instructions are similar or maybe there is some difference for 

other versions of Microsoft Word.  

The use of format painter is explained in the following steps:  

Step 1: Go to “Home” tab, as highlighted in the Figure 1.12. 

http://www.addbalance.com/word/ribbonsHome.htm
https://www.digiruns.com/different-30-ways-to-select-text-in-ms-word-2007-to-2019/
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Home Tab

 
Figure 1.12: Use of Format Painter 

 

Step 2: Position your mouse pointer from where the formatting is to be copy. 

Step 3: Click the “Format Painter”, the cursor shape become like  which shows that 

format painter is now selected. So, apply it to any other text in the document, by 

moving the mouse as shown in the figure 1.13: 

Home Tab

 
Figure 1.13: Copy the Formatting using Format Painter Tool 

 

Step 4: The format of the sentence will be copied as shown in the Figure 1.14. 
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Home Tab

 
Figure 1.14: Formatted Text with Format Painter 

 

Note that the same procedure is used for copying same format to multiple area by only 

double clicking the format painter tool in the Home tab. 

 

 Change Text Direction: 
 
To change the direction of text in a textbox, follow the following steps: 

Step 1: Go to “Insert” tab in the “Ribbon” bar, click “Text Box” and choose a style from 

the drop-down menu.  
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Insert Tab Text Box

 
Figure 1.15: Textbox Insertion in the Word Document 

 

Step 2: Select the shape and style from the drop-down menu. 

Step 3: Type the text into the text box.  

Step 4: Select the textbox and go to “Format” tab in “Ribbon” bar, and select the 

direction as shown in figure 1.16. 

Insert Tab

 
Figure 1.16: Text Direction from Format Tab 

 
To change the direction of text in a table, follow the following steps: 
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Step 1: Insert table in the document, position the pointer in table cell to be change its 

text direction. 

Step 2: Go to “Layout” tab in the “Ribbon” bar, click “Text Direction” and choose the 

desire style as shown in Figure 1.16. 

Layout Tab

 
Figure 1.17: Changing Text Direction in Table 

 

 Quick Toolbars: 
 
The general purpose of Quick Toolbar is to access the most wanted actions quickly, for 

example, saving, printing or viewing the documents. It is also called Quick Access Toolbar 

(QAT) as shown in Figure 1.18 that provides on click options when needed. It can also be 

customized for future use. In this section we will investigate the procedure, how to add and 

remove command from QAT. The same procedure can be applied to Excel and PowerPoint. 

There are two methods to add and remove commands to and from the toolbar.  

Quick Access Toolbar

 
Figure 1.18: Layout of Quick Access Toolbar (QAT) 
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By using the firtst method we can add and remove a command to QAT in the following 

steps: 

Step 1: Select the “Combo Box”, it will open the option list as shown in the Figure 1.19. 

Combo Box

 
Figure 1.19: Combo Box Opens List of Options 

 

Step 2: Select the desire command to add to the QAT, as “Automatically Save”, “Save”, 

“Undo” and “Redo” are preselected. The same will enlisted in the QAT as shown 

in the Figure 1.20. 

Added Commands

 
Figure 1.20: Newly Enlisted Command in QAT 

 

To see the complete list of commands, follow the procedure describe in the steps bellow. 

Step 1: Select the option of “More Commands” as in the Figure 1.21.  
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More Commands Option

 
Figure 1.21: More Command Option 

 

Step 2: A new dialog box will be displayed, select the command and click the “Add >>” 

button. 

Step 3: The selected command will be added to the list as shown in Figure 1.22. 

Follow these steps to remove the desired command. 

Step 1: Select the desired command from the added command list  

Step 2: Press the “Remove” button,  

This will remove the selected command from the list. 
More Commands Option Add Command Button Added Command

Remove Command Button
 

Figure 1.22: Word Option for Command Selection to QAT 
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Follow these steps to use the second method. 

Step 1: Go to “File” tab and select “Option” as shown in Figure 1.23. 

Word Option

 
Figure 1.23: Word Option Choice in File Tab 

 

Step 2: “Word Option” dialog box will appeared as shown in Figure 1.24. Now click on 

the “Quick Access Toolbar”. 
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Quick Access Toolbar

 
Figure 1.24: Word Option Dialog Box 

 

Step 3: You can customize “Quick Access Toolbar”  either for all documents by default 

or it can be applied to currently opened document only as shown in Figure 1.25 

and Figure 1.26. 
More Commands Option Add Command Button Added Command

Remove Command ButtonDisplay Option for the QAT

Selection option for all and 

for current document

 
Figure 1.25: Word Option QAT Toolbar Customization Dialog Box 
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Current 

Document 

“Document4”

 
Figure 1.26: Application of QAT to Current Opened Document 

 

The command from the customized ribbon section can be move to the quick access toolbar 

using following steps. 

Step 1:  Right click on the desired command from customized ribbon section  

Step 2: Select “Add to Quick Access Toolbar”  

Step 3: Similarly you can remove any command from the quick access toolbar using 

“Remove from Quick Access Toolbar” option from the shortcut menu as shown in the 

Figure 1.27. 

 

Add Option

Shortcut Menu

Shortcut Menu

 
Figure 1.27: Adding Ribbon Command to QAT Using Shortcut Menu 
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Quick Access Toolbar is positioned above the Ribbon by default, but it can also be set 

below the Ribbon by using the option “Show Quick Access Toolbar Below the Ribbon” 

describe in figure 1.26 above. 

 

 Multilevel Bullets: 
 
Bullets and numbering are used to arrange important points by giving each point a bullet 

or a number. Single and multilevel list can be created in office 365 by using the following 

steps.  

Step 1: Select the desired text as shown in Figure 1.28. 

List

 
Figure 1.28: Selected Written List 

 

Step 2: Click the “Home” tab and go to the “Bullet” Option as shown in Figure 1.29. 

Home Paragraph GroupBullets

 

Figure 1.29: Paragraph Group 

 
Step 3: Select the desired bullet style as shown in Figure 1.30. 
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Bullet StyleBullets

 
Figure 1.30: Bullet Style Dialog Box 

 
Step 4: In order to create multilevel, select the desired text and click the “Tab” key from 

the keyboard. The selected text will be indented at one level as shown in Figure 

1.31. 

Leveled 

Item

 
Figure 1.31: List Indented at Next Level 

 

Step 5: To define another level, select the text and press tab key repeatedly. 



24 

Multilevel Bullet List

 
Figure 1.32: Description of Multilevel Bullet List 

 

Step 6: To remove the multilevel, select the desire list and press “Shift + Tab”. The list 

will be restored to first level bullet list as shown in Figure 1.33. 

First Level Multilevel Bullet List
 

Figure 1.33: Retaining the First Level in Multilevel Bullet List 
 

 Multilevel Numbering: 
 
Multilevel numbering is same as multilevel bullet style in a document. Instead of choosing 

the bullet option from the paragraph section select the numbered list for multilevel 

numbering. The process is described in the steps below. 

Step 1: Select the desired text as shown Figure 1.34. 
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List

 
Figure 1.34: List Items 

 
Step 2: Select the “Home” tab and go to “Multilevel Numbering” Option as shown in 

Figure 1.35. 

Home List LibraryMultilevel Numbering Option

Multilevel Numbering

 
Figure 1.35: Add Multilevel Numbering to List 

 
Step 3: Different Multilevel numbering, bullet and heading styles are available in the list 

library, select the desired numbering style. 

 
Figure 1.36: Multilevel Numbering Style Applied to List 
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Step 4: To change the level of numbering, select the list again and then click the tab key 

from the keyboard. The selected list will be indented at one level in the list as 

shown in the Figure 1.37. 

Item 

Shifted to 

Next Level

 
Figure 1.37: Item Shifted to Level 2 

Step 5: To define more levels, simply select the text and press the tab key from the 

keyboard, Multilevel numbering will be created as shown in Figure 1.38. 

Level-1

Level-2
Level-3

Level-4

Level-5

 
Figure 1.38: Application of Multilevel Numbering 

 

Step 6: To remove the multilevel numbering, select the desire list and press “Shift + 

Tab”. All the list will be shifted to first level numbered list. 

There are number of options available in the multilevel numbering for customizing; like 

change the starting level of list, define new multilevel list and define new list style. You 

can play with these options for more practice. 

 

 Auto Number Using Headings: 
 
Word processors provide built in headings ( Heading 1, Heading 2 and Heading 3) as 

default heading styles. The top level heading is the “Heading 1” which is numbered as 1 , 

2 and 3 etc. the next level is the “Heading 2” which is numbered as 1.1, 1.2 and 1.3 etc. 

Heading 2 is the sub-heading under heading 1. Similarly “Heading 3” is the subheading 

under heading 2 and so on. Follow these steps to apply heading to your document. 

Step 1: Open your document and select the first level “Heading 1”. 

Step 2: Open “Home” tab, go to “Paragraph” group, and select the “Multilevel” List. 

Step 3: Under “List Library”, choose the numbering style you would like to use as shown 

in figure 1.39. 
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Multinumbering Style

Style 

Library

Heading 

Numbering 

Style

 
Figure 1.39: Number Style Heading Application 

 

 Convert Text to Table and Table to Text: 
 
Word application provide the facility to convert the piece of text into a table. This feature 

is useful when a text is to be arranged in a tabular form. 

 

1.13.1 Convert Text to Table 

 
At the start first click “Show/Hide” paragraph mark on the “Home” tab to display the text 

separation icon as shown in figure 1.40. 
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Show/Hide Paragraph Mark

 
Figure 1.40: Show/Hide Paragraph Control 

 

Now follow these steps to convert the text into table. 

Step 1: Select the desired text 

Step 2: Go to “Insert” tab and click the “Table” item. 

Step 3: Click “Convert Text to Table” as shown in Figure 1.41. 

Insert TabTable Item Convert Text to Table Option

 
Figure 1.41: Text to Table Conversion 

 

Step 4: There are number of choices in dialog box as shown in Figure 1.42. The first 

one is “Table size”, here the numbers of columns and rows for the desired table 

should be given. 
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Size of the 

Table Item

Behavior of 

the Rows 

and 

Columns

Text 

Separation 

Format

 
Figure 1.42: Text to Table Option Box 

 
Step 5: In the second choice is about the behavior like width of column etc. Select 

your desired options. 

Step 6: Third option is about “Text Separation Format”. We select the “Other” to 

insert dot(.) which is also called the fullstop. 

Step 7: Click “OK” button. 

 

You will see the tabular form of the selected text as shown in Figure 1.43. 
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Converted Table

 
Figure 1.43: Converted Table 

 

1.13.2 Convert Table to Text 

 
There are number of option available to convert table into text. The process of converting 

table to text is described in following steps. 

 

Step 1: Select the desire table in your word document. 

Step 2: Go to “Layout” tab, select “Data” item and click the “Convert to Text” option as 

shown in the Figure 1.44. 
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Selected Table Layout Tab Data Item Converting Option

 
Figure 1.44: Convert Table to Text Option 

 

Step 3: Select the text separation option in the dialog box shown below.  

Step 4: Now select “Other”, and insert full stop (.) and then click the “OK” button. 

 
Figure 1.45: Dialog Box Table to Text 

 
Step 5: The selected table will be converted to text as shown something like in the 

Figure1.46. 
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Figure 1.46: Table Data Converted to Text 

 

 Sorting Table Data: 
 
Sorting is the arrangement of data into assending or decending order. It can be done on 

numbers, names and other records of data. It is used in research and development work for 

the decision making. Word processors provide the option to sort a set of data in any order. 

We will demonstrate the sorting of table data. Here are the steps to follow.  

 

Step 1: Select the desired table to be sorted 

Step 2: In the “Layout” tab, Click “Data” Item and choose “Sort” as shown in the Figure 

1.47 



33 

Table Sort OptionData ItemData Item

 
Figure 1.47: Sorting Table Data 

 
Step 3: A dialog box will appear. Select the “Column” based for the sorting, Typ the 

options like Number, Text or Date also select the sorting order (Ascending or 

Descending) as shown in Figure 1.48. 

Field Type

Table’s Column

Sorting Order

 
Figure 1.48: Sorting Dialog Box 

 
Step 4: Click “OK” button, the desired table will be sorted as shown in the figure 1.49. 
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Figure 1.49: Sorted Data Based on Marks Obtained 

 
There are different options in the dialog box for additional settings, such as case sensitive, 

sort language. These options can be used accordingly. 

 

 Multi Column Text: 
 
Multi Column Text is an interesting feature of word processor which convert a piece of 

text into a number of columns. It is used in Newspapers and Magzines to make text easier 

to read. Here are the steps to follow. 

 

Step 1: Open the document where column command to be applied. 

Step 2: Go to “Layout” tab in the “Page Setup” group. Select “Add and Remove 

Column” Option as shown in the figure 1.50. 
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Layout TabColumn Option List of Choices

 
Figure 1.50: Column Option Dropdown List 

 
Step 3: Select the desire number of column options from the dropdown list. We select 

three column option as shown in the Figure 1.51. 

Column 1 Column 2 Column 3

 
Figure 1.51: Three Column Formatted Text 

 
Step 4: If you want to define more columns, you can click the option “More Column” 

available at the end of option list as shown in Figure 1.52. 
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Figure 1.52: More Column Dialog Box 

 
Word 365 allows to define upto 13 columns. Users is also provided a preview to check the 

look and feel of the document. 

 

 Line Spacing: 
 
Line spacing regulates the size of upright space among lines of text in a paragraph. Word 

application has “Single Line Spaced” by default. It means that this size will accommodates 

the largest font and slight space. The user can increase or decrease line spacing according 

to document requirement. Line spacing are measured in unit of inches by default however, 

it can be change to centimeter, picas, points or pixels as per requirements. Moreover, line 

spacing is used to increase the readability of a document.  Here we will explain the 

procedure to change the line spacing in a step by step procedure. 

 

Step 1: Go to “Home” tab, choose “Paragraph” group and click “Line and Paragraph 

Spacing” Option as shown in the figure 1.53. 
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Home Tab Paragraph Group Line and Paragraph Spacing

 
Figure 1.53: Line and Paragraph Spacing 

 

Step 2: A list of predefine line spacing will be displayed as shown in Figure 1.54. We 

choose 3.0 and the text of the paragraph shall be formatted according to our 

choice. For more option “Line Spacing Option” is available. 

 

Dropdown List of Line Spacing

 
Figure 1.54: Line or Paragraph Spacing Application 
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Step 3: Choose the “Line Spacing Option” from the dropdown list or Go to “Layout” 

Tab, select “Paragraph” Group and click the “Paragraph Setting”, small button. 

 

The following dialog box will appeared as shown in Figure 1.55. 

Layout Tab Paragraph Group Paragraph Setting Dialog BoxParagraph Setting

 
Figure 1.55: Paragraph Setting Dialog Box 

 
Step 4: From the “Line Spacing” option line spacing can be adjust to desired size. Then 

click “OK” button.  

 

Suppose we set the line spacing to 1.5lines and press the “Set As Default” button, a message 

displayed showing two options as shown in the Figure 1.56.  
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Figure 1.56: Message Box Showing Two Choices 

 
Step 5: “This document only” option is for the current opened document only and “All 

documents based on the Normal template?” option is used to apply setting to all 

documents based on the current word template. 

Step 6: Select the desire choice and click the “OK” button. 

 

 Character Spacing: 
 
Character spacing specifies the distance in between the characters. There are two options 

i.e. Expanded and Condensed. Expanded option looses the text by stretching, while 

condensed tighten it by compressing the text.  The procedure is as follows. 

 

Step 1: Go to “Home” tab, under the “Font” group and click “Font Customize” option, 

a dialog box will appear as shown in Figure 1.57. 



40 

Font Tab Font Dialog Box Font Size Spacing AmountFont Customization Option

 
Figure 1.57: Font Dialog Box Options 

 
Step 2: Select the desire option and click “OK”. 

 
Figure 1.58: Select Expended Text 

 
Step 3: Select the “Expanded” and “Condensed” option alternatively and see the effect 

of changes. 
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 Indent: 
 
Indentation is the distance between the left and the right margins. The position of 

indentation or indent can be viewed in left or right margin or ruler. Indent is mostly used 

with numbering or bullet to identify a new paragraph opening.  

To indent the first line of a paragraph, position the cursor at the beginning of the paragraph 

and press the Tab key { } in the key board, the first line will be indented. But for default 

indent of first line follow the steps below. 

 

Step 1: Go to “Home” tab and follow “Style” group. 

Step 2:  Place the curson on “Normal” option and right click. Now select the “Modify” 

option as shown in the Figure 1.59. 

Home Tab Style Group Modify Listed ItemNormal Option

 
Figure 1.59: Paragraph Dialog Box with Indentation 

 
Step 3: A dialog box will appear as shown in Figure 1.60. Go to “Format” button and 

select  the “Paragraph” option. 
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Figure 1.60: Modify Style Dialog Box 

 
Step 4: A “Paragraph” dialog box will appear. Go to  “Indentation” Section and click 

the “Special” option. Choose “First line” choice as shown in the Figure1.61. 
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First Line 

Choice

 
Figure 1.61: Paragraph Dialog Box 

 

Step 5: Click “OK” button to close this dialog box and click “OK” button of the “Modify 

Style” dialog box button to implement the choice. The document will be look 

like as shown in the Figure 1.62. 
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Default 

First Line 

Indentation

 
Figure 1.62: First Line Indentation Formatted Document 

 

Step 6: To set this setting as a default for all new document to be created, on the “Modify 

Style” dialog box, select the “New document based on this template” choice and 

click the “OK” button as shown in the Figure 1.63. 

Select this 

choice

 
Figure 1.63: Default Setting for Indentation 

 

The first unit of our course Office Automation is completed. In the next section we are 

going to present some assessment activities related to this unit. The student will be 

encouraged to complete these activities so that they can assess their study and improve 

their professional skills. 
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Self-Assessment Questions 
1. What is the main purpose of highlighter in word processor application? 

2. How shading of text is performed in a word processor? Describe with the help of word 

document. 

3. differentiate between highlighting and shading. 

4. Exemplify the word feature Paste Special, how do you differentiate it from Paste 

function? Explain. 

5. Why paste special is an important function? What are its benefit in document 

formatting? 

6. What do you mean by change case in word processor application? Describe its various 

types with the help of a suitable example. 

7. Differentiate between copy and copy formatting. 

8. What do understand by changing text direction? Explain in detail with examples. 

9. How text direction in a table cell will be change? Elaborate the procedure in detail. 

10. What is main purpose of Quick Access Toolbar (QAT)? Explain. 

11. How can we add and remove tool from/in the QAT? Also explain the procedure to add 

tool in QAT from the Ribbon. 

12. Write down the process of adding multilevel bullets and numbering in a document. 

13. What are the advantages of multilevel numbering in word application? 

14. Describe the usage of Heading in word document. 

15. How multilevel numbering is implemented using Heading? Describe the step involved. 

16. Word processor provide the facility of converting text to table, elaborate in detail. 

17. Exemplify the process of table to text conversion in detail. 

18. Explain data sort process with the help of word application document including some 

table data. 

19. What is word column? Explain with help of example. 

20. Describe the procedure of changing the line spacing of a specific paragraph in word 

document using different choices. 

21. What is character expanded and condensed feature? Elaborate with the help of word 

document. 

22. Why indentation is so important in documents? Explain in detail. 
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Self-Assessment Activities 
 

1. Prepare your C.V and highlight and shade the different section for review purposes by 

using tools in the review toolbar and commands in the Insert menu. These changes 

should appear in printed documents. 

2. Copy a web content or some portion of web site and paste the contents as it is on the 

website using the paste special feature of word processor. 

3. Create a document having many pages of text. Apply the Change Text Case formatting 

using its different option and discuss it with your classmate. 

4. Using two different section of documents, copy the text formatting of one section of 

the document and then apply the formatting to the other using format painter tool. 

5. Create a word document and elaborate the usage of changing of text direction feature 

of word processor. 

6. Start with a new document, add commands Add Table, See Multiple Pages, and View 

Whole Page command to Quick Access Toolbar (QAT) only for the current new 

document. 

7. Open your C.V as prepared in activity No.1, convert its different section into list using 

the bullets and numbering style available in word application so that your C.V look 

like attractive. 

8. Create a template for book writing using auto numbering with Heading available in 

word processor. The template can be used for book writer as a prototype. 

9. Make a document of your education qualification separated by Comma (,), apply 

convert text to table using comma (,) as base create a table. Table should describe your 

education qualification in table format having each record in separate row. 

10. Start with a blank document, copy a large size table from any source. Now apply 

convert table to text in such a manner that the text describes the information in good 

looking way. 

11. Using internet copy a huge size of table with the help of paste special paste it. Now 

apply different data sorting techniques you learned on that data. 

12. Take a piece of any English newspaper, select any article having multi columns 

structure, write down and format it as published in the newspaper. 

13. Take the paragraph of the above activity No. 12. Apply the line spacing 2.0 to the first 

column and line spacing 1.5 to the second column and same way do it with your own 

choice of line spacing, if it is more than two column the apply different line spacing to 

other columns as well.  

14. Create two paragraph having line spacing 1.7 and 3.2 respectively. Now condensed the 

first paragraph 2.7point and the second one with expanded 1.9 points. Show the result 

to your teacher. 

15. Take any document having multiple page and many paragraphs. Apply the indentation 

of First Line with 3.89 points. Set your changes for the current document only, so that 

it will affect other documents. 

16. Create a word document, with the help of bullets and numbering explain the idea of 

Hanging in the topic of Indentation. 
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2. APPEARANCE, GRAPHIC IN WORD PROCESSOR 

 Introduction 

This unit elaborate some of the most interesting features of word processor that provide 

learner to work on preliminary graphics designing and visual aids in word document. In 

this unit the students will be introduced to various graphic design techniques such as 

embedding Pictures, SmartArt, Chart, WordArt, etc. It also covers some most pleasant and 

interesting features of word processor like comments insertion and textbox controls. 

Moreover, customizing the template and page properties will also be covered in the last 

sections of this unit. Furthermore, customizing the page theme and watermarking feature 

will also be studied in this unit. 

 

 Objectives 

After studying this unit, the learners may be able to: 

 Design quickly and easily graphical representation of information to present the 

ideas. 

 Identify importance of Chart and Word Art designing representation. 

 Illustrate the importance of Textbox and Template in document processing. 

 Design a document having various types of Page Layout features. 

 Apply the usage of Watermarking in word document.  
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 Insert Pictures 

Picture processing in documentation is very important and effective way of describing 

one’s idea or thinking. Presenting a document enriched with graphics is very important to 

make a document as illustrative as credible. Word processor software has provided a 

variety of image acceptance in documentation and accept large image sizes. Moreover, it 

also allow to resize the image. Here in this section we will discuss how to insert image in 

a document. Inserting picture is very easy in Word, with the following steps. 

 

Step 1: Create a blank document and Go to the “Insert” tab. 

Step 2: Select the “Pictures” item in the “Illustrations” Tab as shown in the Figure 2.1. 

Picture OptionInsert Tab

 
Figure 2.1: Insertion of Picture in a Document 

Step 3: Select the desired picture from the list and Click the “Insert” button as shown 

in Figure 2.2. The picture will be inserted at the required place 
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Picture

Inset 

Button

 
Figure 2.2: Insertion Dialog Box 

 Smart Art 

MS word also provides graphics processing tools to form a pleasant visual fashion and 

prompt representation of ideas. There are different types of pattern and layouts available, 

which can make the document effective and communicating for conveying the message 

pictorially. The feature SmartArt is a visuals illustration. This feature is provided by 

Microsoft in all the applications provided in the Microsoft Office 365 suit. 

To insert the Smart Art, follow the following steps. 

Step 4: Go to “Insert” tab, then in the “Illustrations” group, click “SmartArt” otpion 

as shown in the Figure 2.3. 
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Inset Tab
Illustrations GroupSmart Art Option

 

Figure 2.3: Inserting Smart Art 

Step 5:  “Choose a SmartArt Graphic” dialog box will appear as shown in Figure 2.4. 

Select the category and then the desired layout of the art from the list and then click “OK” 

button. Please note that layout description will be highlighted with that dialogue box. 

List of Catagories
Description of Current 

Selected Art
List of Arts

 

Figure 2.4: Selecting Smart Art Options 

Step 6: The inserted Smart Art will look like as shown in the Figure 2.5: 
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Text Pane

Text Pane Arrow

 
Figure 2.5: First Layout of Smart Art Graphic 

 

Step 7: Enter the text by clicking [Text] in the “Text” pane. You can copy text from 

other location also. 

There are number of other Arts available for user to apply in the “Layout” group and 

different colors in the “SmartArt Style” group as shown in the figure 2.5 above. 

2.4.1 Adding Shapes to SmartArt Graphic: 

Smart Art graphics also provide the facilities to enhance the layout by adding more shapes 

to the layout structure. The following is the procedure to add shape to existing layout: 

Step 1: Once the Art is created user can add more shape by clicking the “SmartArt” at 

the specified location. 

Step 2: Under “SmartArt Tools”, on the “Design” tab, in the “Create Graphic” group, 

click the “Add Shape” option, this will add one additional shape to the layout 

as shown in Figure 2.6. 
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New 

Added 

Shape

Design TabCreate Graphic GroupAdd Shape Item

 
Figure 2.6: Adding New Shape to Smart Art 

Step 3: To delete a shape, first select the desire shape. 

Step 4: Go to “Design” Tab and select the “Demote” option under the “Create 

Graphic” group. The selected shape will be deleted as shown in Figure 2.7. 

Deleted 

Shape

Design TabCreate Graphic Group
Demote Shape 

Item

 
Figure 2.7: Deleting the Existing Shape from Smart Art 
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2.4.2 Adding Shape from SmartArt Graphic in Order: 

The orders (Before or After) of shapes can be specify while inserting them as shown in 

Figure 2.8.  

Step 1: Insert the shape after some specific shape clicking on “Add Shape After” 

option and before the selected shape by clicking on “Add Shape Before” 

option. 

Shape Option

 
Figure 2.8: Shape Ordering in SmartArt Graphic 

 Charts 

Another interesting and most useful feature that is provided by most of the word processor 

is the facility of Chart Object in documentation for presenting the statistical layout of 

different types of financial data and assets. This tool is used to communicate the 

information in a graphical way. Adding a chart to a document can help the reader to 

understand the analogy of different types of numerical data by comparison and most 

suitable data trends for easiness and better decision making. Here different types of charts 

categories are available for user to show and present the statistical layout in comprehended 

way. Word has several types of charts, to demonstrate the user data. it required a data sheet 

like spreadsheet as a placeholder for chart data. The following subsection describes the 

method of inserting a chart.  

2.5.1 Insert a Chart: 

For insertion of Chart object in the word document follow the step described below: 

Step 1: Go to the “Insert” tab, under the “Illustrations” group click the “Chart” Option 

as shown in the figure 2.9. 
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Insert Tab Chart Item

 
Figure 2.9: Chart Object Selection 

Step 2: A dialog box will appeared, now user can choose the desired category for chart 

and its types as pointed out in the figure below. A short preview the charts will 

also be appeared in right-side as shown in Figure 2.10. 

Chart Category

Chart Type

 
Figure 2.10: Chart Dialog Box 



57 

 

Step 3: Choose the desired category and types of chart, then click OK. 

Step 4: The default chart with data will be appeared as shown in Figure 2.11. User can 

edit the settings and add new data as required. 

Spreadsheet 

with the Data

Chart

 
Figure 2.11: Data Series and Chart 

Step 5: Here a new data is entered with user defined categories and different series as 

shown in the Figure 2.12. 

Spreadsheet 

with the Data

Chart

 
Figure 2.12: Updated Data Series and Chart 
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Step 6: Now Close the Datasheet, The chart will be completed as shown in Figure 2.13. 

Chart

 
Figure 2.13: Updated Data Series and Chart 

Step 7: Options can also be updated when required. Choose the “Design” tab and then 
select the “Edit Data” and then update the datasheet as per requirement, shown 
in the Figure 2.14. 

Design Tab Edit Data Option

 
Figure 2.14: Updated Data Series and Chart 
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 Word Art 

Working with text in word processor mean to deal with the transformation of text in to 

different shape. Word processor provides an Art called WordArt, which is a text modifying 

technique having different properties like text shadow, coloring, outlining, gradients and 

three-dimensional effects. Some of the additional properties like text skewing, shaping, 

bending and stretching are also applicable using the same feature. FontWork is the same 

feature provided by the OpenOffice application. Similarly, WarpText is the feature 

available in Adobe Photoshop 7 having the same the properties. To insert a WordArt in 

word 365 document, follow the steps below: 

Step 1: Go to “Insert” tab and locate “Text” group at the right side then select the 

desired style of text art from the gallery as shown in the Figure 2.15. 

Inset Tab WordArt OptionText Group

  

Figure 2.15: WordArt Gallery 

Step 2: A Word Art placeholder text will appear showing “Your text here” highlighted 

text as shown in Figure 2.16. 
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Enter Your Text for 

Transformation

 

Figure 2.16: Word Art Placeholder 

Step 3: Type the desired text as shown in Figure 2.17. You can also apply different 

transformation techniques available. 

Entered Text

 

Figure 2.17: Updated Text Entries in Word Art 
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 Comments 

Word process has a provision for the text editors and reviewers to edit and review 

documents and puts comment for the writer using the “comment” feature of word 365. 

Generally, comments are notes or explanations that a writer or reviewer put into the 

document for communicating the review. In word 365, comments are placed in the 

“Review” tab or displays in the left margin in a shape of balloon in the document. These 

balloons do not affect the layout and other feature of the document. However, if the user 

wants to use it in document layout to work on it or update it. This will ease to make the 

feedback clear-cut. If someone else is commenting on the document, replying to their 

comments, lets a discussion, even without the owner at the same time. Here, we are going 

to show how to insert, delete and update the comments. To process comments in word 

document, follow the following sections. 

2.7.1 Inserting a Comment 

Inserting comment in a document can be done through the step by step procedure as 

described below: 

Step 1: Make a desire range of the text to comment, go to “Review” tab and click 

“New Comment” Option as shown in the Figure 2.18. 

Selected Text to 

Comment on it

Comment GroupReview TabNew Comment Option

 
Figure 2.18: Inserting Comments in a Document 

Step 2: A message box will appear to enter your comment as shown in Figure 2.19. 
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Comments Box Appreared

 
Figure 2.19: Comments Box 

Step 3: Now user can type the respective comment which will be displayed in right 

margin in a shape of balloon as shown in Figure 2.20. 

Balloon With Comment

Reply Comment

 

Figure 2.20: Balloon with Comments 
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2.7.2 Reply a Comment 

Replaying a comment quoted by the user include the following steps. 

Step 1: Go to the “Comment Box”, locate and click the “Reply” option at the bottom 

as shown in the Figure 2.20 above. 

Step 2: Write the reply which will be appeared beneath the comment balloon as shown 

below in the Figure 2.21. 

Replying a Comment

 

Figure 2.21: Replying a Comment 

2.7.3 Delete a Comment 

Deleting a comment means to remove the comments from the document. The procedure is 

described in the following steps. 

Step 1: Go to “Review” tab, select the comment to be deleted in the document. 

Step 2: Locate and click the “Delete” Option in the “Comment” group as shown in the 

Figure 2.22. 
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Deleted CommentDelete Option

 

Figure 2.22: Deleting a Comment 

Step 3: User can always go back to the previous comment by clicking “Previous” 

option, or go to next comment by clicking “Next” option under “Review” tab 

as shown in Figure 2.23. 

CommentPrevious and Next Option

 

Figure 2.23: Move Forward and Backward to Comment 
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 Text Box 

Word processor provide a feature for mobile text container called textbox object. This 

object gives a facility for user to add a textbox in a document at the desire desired location. 

Textbox is very useful feature for representing and drawing attention to a special type of 

literature. It can also be effective, when we need to change the position of certain type of 

text across document. Word 365 also lets the user to structure the text box and the text 

inside with a number of patterns and effects. To add a textbox in word document, locate 

the “Insert” tab and then “Text” group. There will be two choices where you can select one 

of the options (a) Choose a ready-made text box (2) Draw a conventional text box as per 

user need and requirement. 

After inserting a textbox, text can be typed in it, the text entered can be formatted using 

“Format” tab. Every shape can be turned into textbox like circle or triangle etc. (Place 

cursor over the object, right-click it and select the “Add Text” and start the typing). Now 

we are going to describe the procedure for adding textbox to a word document in the 

following section. 

2.8.1 Add a Textbox 

To insert a textbox into the word document, follow the steps below. 

Step 1: Go to “Insert” tab, locate the “Text” Group and click the “Text Box” Option 

as show in the Figure 2.24. 

Text GroupInsert Tab Textbox Optioin

 

Figure 2.24: Inserting Textbox 
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Step 2: A “Drop-Down” list will be displayed then select “Draw Text Box” option to 

draw a textbox or select the predefined one as shown in Figure 2.25. 

Text Group

Text Group

 
Figure 2.25: Draw Text Box Option 

Step 3: Click it and draw textbox of choice anywhere on the page.  

Step 4: After drawing the textbox, enter the required text in it like shown in the Figure 2.26.  

Textbox

 
Figure 2.26: Entering Text in Textbox 
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2.8.2 Copy a Textbox 

The procedure to copy the textbox is described below. 

Step 1: Locate and click on the border of the textbox that is to be copied and then Press 

“Ctrl + C” keys or click the right button of the mouse, drop down menu will 

appear, here you click the “Copy” Option. 

Step 2: Now choose the desired location where to paste it and press “Ctrl + V” or click 

the right mouse button and then click the “Paste” option. The textbox will be 

copied at the location. 

2.8.3 Deleting Textbox 

The inserted textbox can be deleted from the document when required. The procedure is as 

follows. 

Step 1: Click the border of the textbox that you want to delete. 

Step 2: Press the “Delete” button on the keyboard. This will delete the selected textbox 

or click the right mouse button and click the “Delete” option. 

2.8.4 Moving Textbox: 

Textboxes can be moved from one point to another in a document, Here are the steps. 

Step 1: Select the “Textbox” that is going to be moved. 

Step 2: Place the mouse cursor above one of the edges of the Textbox. The mouse 

pointer shape will be changed to cross sign with arrows as shown in Figure 2.27. 

Textbox

 
Figure 2.27: Moving Textbox 
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Step 3: Click and drag the Textbox to the desired place. Moreover, textbox can be 

resize by clicking and dragging on the corners sides. 

Step 4: Word also provide functions to change the shape, style and color of text box 

provided in “Shape Format tab”. 

2.8.5 Change Textbox Shape Style 

Shape style provide some of the predefine properties of textbox like color and effects to 

change it appearance. The following steps will elaborate the shape style properties. 

Step 1: Choose the desired textbox to apply changes. 

Step 2: Go to “Shape Format” tab and then in the “Shape Style” group click on the 

“More” drop down arrow as shown in Figure 2.28 . 

Shape Format TabShape Style Group More Drop-Down Menu

 
Figure 2.28: Shape and Style Formatting Textbox 

Step 3: A list of styles for the textbox will appear as shown in Figure 2.29. 
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Style List

 
Figure 2.29: Various Style Templates of Textbox 

Step 4: Select the desired shape. The text box will be converted as shown in Figure 2.30. 

Stylish Textbox

 
Figure 2.30: Applied Style Textbox 

For applying more properties of textbox, different formats of shapes are available. These 

can be applied to fill the textbox with the desired color and outline. 
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 Apply a Template 

A template is a container that serves as a theme for creation of new word document. When 

we open word, it provides different patterns or shapes called template to create the 

document as shown in the Figure 2.31. 

Templates Templates Categories

 
Figure 2.31: Word Templates 

 

Templates can also come by default with word processor and other application software or 

it may be created by the customer. Templates not only saves the time but also ease the job 

of creating a document. By creating a container and then just open the template and start 

from there is one of the best choice for the documents creator.  

It is good idea to create various type of document, such as a scheduled report, a trades 

prediction, or a demonstration with a business logo, save it as a template and use that as 

beginning as a replacement for recreating the document from start each time when needed. 

The process is very simple and easy just start with a document that is already created, a 

document copied, or a new personalized template.  

2.9.1 Saving Template 

To create a template for the document, follow the steps below. 

Step 1: Open new document, go to “File” tab and click “Save As” option. 
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Step 2: Now select “This PC” option and then go to ocument save options as shown 

in the Figure 2.32. 

This PC OptionSave As Option Word Template OptionNew Template Name

 
Figure 2.32: Creating Word Template 

Step 3: Give proper name to the template in the “Enter file name here” combo box. 

Step 4: Select “Word Template” from the template list. If document contains macros, 

then select “Word Macro-Enabled Document” template option. Office 

automatically moves to the “Custom Office Templates” folder for saving the 

template. 

Step 5: Then click “Save” button at the right side. 

2.9.2 Edit Template 

Word 365 also have provision of editing a template. You can do it by following these steps: 

Step 1: Open the document by just going to “File” tab and then “Open” option in the 

word menu bar. 

Step 2: Select “This PC” option in the open container. 

Step 3: Go to the right side pane and click the “Custom Office Templates” folder 

which will  under “Documents” Folder as shown in Figure 2.33. 



72 

 

This PC OptionOpening Option Custom Office Template

 
Figure 2.33: Opening Word Template for Updating 

Step 4: Select the customized template from the list and then click “Open” button as 

shown in the Figure 2.34. 

This PC OptionOpening Option Custom Office Template

 
Figure 2.34: Selecting Word Template for Updating 

Step 5: Update the template as needed and save it. 
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 Page Layout 

Page layout is visualization of the working area in a word processor including text, images, 

and other objects in a document. This feature is used to describe the design of the document 

as well. It is used to adapt various types of documents like periodicals, newspapers, books, 

websites, and other categories of publications. In the word processor terminology, it 

includes various objects like page margins, page size etc. This term is also used in other 

software applications like Adobe InDesign and QuarkXpress for page design. 

Now we are going to discuss the various components of page layout feature in detail in the 

forthcoming sections. 

2.10.1 Page Orientation 

Word 365 offers two types of page orientation choices: first one is “Landscape” and the 

second is “Portrait”. Compare the example below to see how orientation can affect the 

appearance and spacing of document pages. Landscape visualize the page in horizontal 

layout and Portrait option convert the page oriented to vertical layout. To change the 

orientation of the page, follow the steps below. 

Step 1: Go to the “Layout” tab and locate “Page Setup” group and click on the 

“Orientation” option as shown in Figure 2.35. 

Layout TabPage Setup Group

Orientation Choices

 

Figure 2.35: Selecting Page Orientation 

Step 2: Orientation list will be displayed. Choose one of the options among the two 

choices: Portrait or Landscape. 
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Step 3: Clicking the option will change the page orientation for the current document. 

2.10.2 Page Size 

Word 365 provide predefined page size of a newly created document which is 8.5 inches 

by 11 inches. The size can be customized depending upon the user requirement or printing 

format. Page size is the working area where the user can work and resize as per 

requirement. To choose a page size follow the steps below: 

Step 1: Go to the “Layout” tab and within the “Page Setup” group click on the “Size” 

option as shown in Figure 2.36. 

Page Setup Group Layout Tab List of Page Size

  
Figure 2.36: Selecting Page Size 

Step 2: A drop-down menu will be appeared the current page size will be highlighted 
as shown in the Figure 2.36.  

Step 3: The desired page size to change. Remember that changing the page size will 
also affect the printer setup as well. The same page size should be loaded on 
printer otherwise a printing error will be appeared. 

2.10.3 Custom Page Size: 

Word 365 has a provision to define custom page size using the Page Setup dialog box. 

Follow the steps below. 

Step 1: Go to the “Layout” tab and within the “Page Setup” group click on the “Size” 

option as shown below. 



75 

 

Step 2: A drop-down menu will be appeared among which the current page size is 

highlighted as shown in the figure above. Here select the “More page sizes” 

option as shown in the Figure 2.37. 

Page Setup Group Layout Tab More Page Size Option

 
Figure 2.37: Custom Page Size 

Step 3: A dialog box appeared as shown in Figure 2.38. Now choose the values 

for Width and Height of page size and then click OK. 

Page Setup Dialog Box

 
Figure 2.38: Custom Page Size Dialog Box 
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Step 4: A customized size page will be adjusted for the current opened document. 

2.10.4 Page Margins 

The space between the boundary and the working area of document is known as the margin. 

Also called the space between the text and the side of the document. Word 365 provide 

normal margin for new document which has only one-inch space between the text and each 

edge all around the working area. However, word provide the option for user to change it 

as per user requirements and needs. To configure page margins Word application has a 

range of predefined margin sizes to pick from. To choose the page margin’s follow the 

steps below. 

Step 1: In the word “Ribbon” go to “Layout” tab, in the “Page Layout” group choose 

the “Margins” option as shown in the Figure 2.39. 

Page Setup GroupLayout TabMargin Option Margin Area

Margin 

Area

 

Figure 2.39: Page Margins 

Step 2: A predefined margin drop-down menu will appear select the desire margin size 

from the list as shown in the Figure 2.40. 
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Predefined Margin s ListLayout TabMargin Option

 
Figure 2.40: Predefined Page Margins List 

Step 3: Select the desire margins of the document the size of will be changed. 

2.10.5 Customizing Page Margins: 

The user can define or adjust the page margin according to need and requirement of the 

document design. Word also permits to modify the size of margins by using the “Custom 

Margin” option as shown in the Figure 2.41. 

Step 1: From the “Layout” tab, under the “Page Setup” group click “Margins” then 

select “Custom Margins” from the drop-down menu. 
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Custom Margin OptionLayout TabMargin Option

 
Figure 2.41: Custom Page Margins Option 

Step 2: The customizing page setup “Dialog Box” will appear as shown in Figure 2.42. 

Custom Margin Option

 

Figure 2.42: Adjusting Page Margins Option 

Step 3: Adjust the values for Top, Bottom, Left, Right and as well as Gutter position margins. 

Gutter position is binding side of the document in case of making a booklet, thesis etc. 
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Step 4: The margins of the document will be changed. 

Step 5: Alternatively, “Page Setup” dialog box can be open by navigating to the 

“Layout” tab click the small arrow in the bottom-right corner of the “Page 

Setup” group as shown and highlighted the Figure 2.43. 

Small Arrow 

 

Figure 2.43: Alternative Page Margins Option 

 Page Border 

Page border is the working area and the margin’s area together in a document visual layout. 

This feature comprises a collection of small illustrations that seem decent while repeated 

all around the boundaries of the side. It is displayed outside the margins on each page of 

document. It is an art which repeatedly appeared in solid line or small size image that cover 

the border nearby the beside of the document boundaries. This is usually used as decoration 

that can use any design, color, and line texture as desired. Sometime graphical borders can 

be used (or border art) that repeat a small image as a pattern around a document side. 

To apply this feature in word 365, follow the steps below. 

Step 1: In the “Ribbon” go to “Design” tab, then in the “Page Background” group, 

choose the “Page Borders” option as shown in the Figure 2.44. 
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Design Tab Page Borders OptionPage Background Group

 

Figure 2.44: Adding Border of Document 

Step 2: A page borders dialog box “Borders and Shading” appeared as highlighted in 

the Figure 2.45. Which present various tabs like borders, page borders and shading. Go to 

the page border tab. 

Page Borders Dialog Box

 

Figure 2.45: Page Border Dialog Box 
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Step 1: Here various types of features are available like page border setting where user 

is given some predefined settings. Style of the border, its color, width in points. 

It also presents some arts to apply to border. The preview section shown the 

current application of these features. The user can apply these features to the 

current document as well as to the current section first page and to all the other pages. 

Step 2: Select OK the page will be look like in Figure 2.46. 

 

Page Borders Appearance

 
Figure 2.46: Layout of Page Border Feature 

Step 3: Page art can be applied to page border as well. For this user will select any art 
from the “Art” section as shown in the Figure 2.45 above.  

Step 4: Select “OK” button, the page will be look like in Figure 2.47. 
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Page Borders Appearance

 
Figure 2.47: Art Page Border Layout  

        Page Colour & Theme 

Page coloring and theme application means that make the document or decorate the 

document with different coordinate colors, fonts, and graphic formatting effects. The 

working area of the page in word processor will be appeared in different color as needed 

by the user. To change the color theme of the page in word 365 follow the steps below.  

Step 1: Choose the “Design” tab and go to “Page Background” group and then click 

the “Page Color” option as shown in the Figure 2.48. 
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Page Color Appearance Page Color Theme

 
Figure 2.48: Layout of Page Color 

Step 2: Select the desire color and click it, the page color will be change. 

 Adding Watermark 

Water marking is the technique of entrenching information into the contents of some 

documents, pictures etc. to verify the credibility of the content or to acknowledge the 

distinctiveness of the information's owner. It can be used for different purposes like 

privacy, copyright, source tracking, and hidden information given in the watermark. 

Generally, it is a logo, text, or outline that is deliberately embedded onto another content 

for the purpose to make it further tricky for the initial concept idea to be reproduced or 

employed with no authorization. In word processor a watermark is a lightened contextual 

information that flashes at the back of the text in a document. The owner or the producer 

use this type of feature to signify a document’s state (personal, summary, public etc.), put 

in a delicate firm design, or just as for a small piece of creative style. To add and deploy 

watermarks to Word document follow the steps below. 

Step 1: Choose the “Design” tab and go to “Page Background” group and then click 

the “Watermark” option as shown in the Figure 2.49. 
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Design Tab Page Background and Watermark

 

Figure 2.49: Word Document Watermarking 

Step 2: A drop-down list of choices appeared as shown in the Figure 2.50.  

Predefined List of Watermarks

 

Figure 2.50: Drop-Down List of Watermarking 
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Step 3: Choose a pre-configured watermark, like “DO NOT COPY” or 

“CONFIDENTIAL” after deploying the documents be look like as shown in 

the Figure 2.51. 

Application of Watermark  DO NOT COPY 

 
Figure 2.51: Application of Watermarking 

Step 4: User can add custom watermark by clicking the “Custom Watermark” option 

in the drop-down list as shown in the Figure 2.52. 

Predefined List of Watermarks

Custom Watermarking Option

 
Figure 2.52: Customizing Watermarking 
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Step 5: The following dialog box appeared. 

Custom Watermarking Dialog Box

 

Figure 2.53: Customizing Dialog Box of Watermarking 

Step 6: User can choose “Picture Watermark” and also “Text Watermark” by choice. 

Step 7: In the figure above we choose “Text Watermark”, it language “Urdu”, its text 

 its font “Time New Roman”, its size “Auto”, its color “Purple”, its ,”اصل “

fading “Semi Transparent” and its layout “Diagonal” in the document. 

Step 8:  Click the “Apply” button and then “OK” button the desire watermark will 

appeared in the background of the document. Similarly, user can click the 

“Picture Watermark” option and then select the desire picture. The same 

picture become the watermark of the word document. 
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Self-Assessment Questions 

1. What is meant by word picture option? What are its application? 

2. What is the application of imaginary presentation? How it is useful. 

3. Explain the main idea of SmartArt in a word application.  

4. Explain different types of pattern and layouts with the help of examples. 

5. Describe the procedure for the customization of the predefined Smart Art object in a 

word document. 

6. What is meant by chart? Also describe its various types with explanation. 

7. Differentiate between Smart Art and Word Art. 

8. Explain the use of Word Art. Hwo it is useful for making documents more attractive? 

9. What is the use of comment command in a document? How comments are inseted? 

10. Describe the procedure of adding, replying and deleting comments in a word 

document. 

11. Write down the steps of adding a textbox in a document, with different shapes. 

12. What are the advantages of templates in a word application? Elaborate with the help 

of examples. 

13. Describe the usage of page layout features in detail. 

14. How page orientation can be changed from Portrait to Landscape? 

15. Describe the procdure of creating document having multiple pages with different 

orientation layout. 

16. Explain the process of changing the size of word document page. 

17. Exemplify the process of page size customization in detail. 

18. What are page margins? How can user modify the margins to user defined types? 

19. Elaborate the usage of page border, also explain the procedure to add page border to 

a document. 

20. Describe the procedure of changing the color and theme of a word document using 

different choices. 

21. How can a user protect a word document from unauthorized use? Explain.  

22. Can we embed a personalized image as watermark to a document’s state? Explain 

with the help of word document. 
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Self-Assessment Activities 

1. Prepare and design a brochure of your choice with various design and options. 
2. Design organizational hierarchy (pattern) of any business firm using smart art 

techniques. 

3. Design an organizational chart of any company using different techniques studied in 
the Chart section. 

4. Create a document having data of 10 students (including marks of matric, 
intermediate marks) and prepare a chart showing diverse performance of students. 

5. Design a logo for any department using different word tools. 
6. Create a word document and insert different reviewing comments and then inset 

answer on these comments. 

7. Create the following design using textbox features with in a word document: 

 
8. Create a template for BS final year project report, that contains all the requirement 

for report writing by default. 
9. Create a document for your first course assignment, the first should be of size “A4”, 

while the second will be of size “Letter” and third page of size “Legal” the remaining 
pages should be of size “A4” but in “Landscape” orientation. 

10. Create a document with custom margins of “Top = 0.3”, “Bottom = 0.5”, “Right = 
1.3” and “Left = 0.5”. 

11. Design course assignment with the following: 

a. University Logo on title page with border on page. 

b. Page number starting from 2nd page. 

c. Headings and subheadings should be bold. 

d. Table of contents on 2nd page. 

e. Use deferent color in pages. 

f. Apply watermark of appropriate position. 

12. The page color of document design in question-11 will be of different pattern each. 
13. Apply watermarking to your document created in the above question-12. The 

watermark will be of university logo at the first and the other pages with different 
pictures and information. 
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3. ADVANCE FEATURES IN WORD PROCESSOR 

3.1  Introduction 

This unit covers some advanced features in a word processor. These are the additional 

features used to format your document in a word processor. It includes styling, referencing, 

proofing, citation, document protection and mail merging. 

3.2 Objectives 

After complete study of this unit, you will in position to: 

 Apply, modify and create and clear the styles in word processor 

 Insert, automate, format, or delete captions  

 Create a bibliography, citations, and references  

 Document proofing and revising, mail merging and securing it. 

 Create a table of contents, footnotes and endnotes in word processor  
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3.3 Styles 

Word processors programs commonly have software feature of styling as in Microsoft 

Word. In Microsoft Word styling is a predetermined combination of font formatting such 

as font color, font style and font size to apply on our desired document. Styles in Word are 

a powerful tool that can help you to provide consistency throughout the document to 

achieve a more professional look by applying the same properties throughout the 

document. 

We can make several changes in our document at once using Styling. 

3.3.1 Apply Styles 

Styles can be applied to your document using two different methods. 

1: Using styles sets 

2: Using style section 

 

3.3.1.1 Using Styles Set 

We can make changes in our whole document format at once using Style sets instead of 

formatting every line separately. These sets includes titles, heading and paragraph styles 

etc. The formatting steps are as follows:  

Step 1: Go to “Style” section in “Design” tab and click the dropdown arrow to get 

more options as shown in Figure 3.1. 

Step 2: Select the desired set of styles from the dropdown menu. 

Step 3: Selected style will be applied on the entire document. You can change it by 

repeating the above steps. 
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Design Tab Style sets
More

Applied 

Style set

 
Figure 3.1: Style Set 

3.3.1.2 Using Styles Section 

Follow these steps to apply styles using style section. 

Step 1: Select the desired text or just place cursor next to a line of desired text and 

click on the “Styles” section of “Home” tab as shown in Figure 3.2. 

Step 2: Select any predefined style from the style section. You can get more options 

by clicking the dropdown. 

Step 3: Click on the style that you would like to apply to your desired text such as a 

heading, title or subtitle.  

Step 4: Text will be changed as per your selected style. Practice more options. 
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Home Tab
Style 

Section

Desired 

Text

Selected 

Style

 

Figure 3.2: Style Section 

3.3.2 Modify Style 

Modifying a style means to change all instances of that style in your document. Styles can 

be modified as per desired formatting requirement by using following steps. 

Step 1: Go to the “Style” section under “Home Tab”, right click any style to make 

changes as shown in Figure 3.3. 

Step 2: Click on the “Modify” from dropdown menu. 

Step 3: Change the formatting of Font style, size and color as desired. Here you can 

change the style name also.  

Step 4: Click “OK” and the changes will be saved. 
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Right 
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and 

Modify

Modification 

window

 
Figure 3.3: Modifying Style 

3.3.3 Create New Style 

For creating new styles, follow the steps below: 

Step 1: Click in the “bottom right corner arrow” of “Style” section under “Home” tab. 

Step 2: Enter the name you want to use for the new style and choose the formatting as 

desired. 

Step 3: Click “OK” to add it in the predefine styles as shown in Figure 3.4. 
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Home

Tab

New 

style

 
Figure 3.4: New Style 

3.4 Clear Formatting 

Sometimes formatting option like bold, italic or underline may cause complications during 

copying and pasting, when a user requires to move a text without any style. This can be 

handled by clear formatting tool, which has the following two methods. 

1: Using style section 

2: Using clear all formatting button 

3.4.1 Using Styles Section 

Style section can be used to clear the formatting of a small section or the entire document 

by using following steps.  

Step 1:  To remove formatting select your desired text. Or select all for entire 

document selection. This will highlight entire text in the word file. 

Step 1: Go to “Styles” section under home tab. Click in the bottom right corner arrow 

to get more options as shown in Figure 3.5.  

Step 2: Select “Clear Formatting”. Any applied formatting will be removed. 
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Home Tab Styles section

Clear 

Formatting

Selected

Text

 

Figure 3.5: Clear Formatting Using Style Section 

 

3.4.2 Using Clear All Formatting Button 

Formatting can also be cleared by using one shortcut button from the ribbon. To clear 

formatting from the entire document or from small desired text selection, follow these 

steps:. 

Step 1: Select the text from which you want to remove the formatting. Or select all for 

entire document selection. This will highlight entire text in the word file. 

Step 2: Select “Clear all Formatting” icon  in the upper-right corner of the Font 

section under the home tab as shown in Figure 3.6.  

Any formatting applied to your desired selected text will be removed. 
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Home Tab Clear 

Formatting

Text Selection

 

Figure 3.6: Clear Formatting Using Clear All Formatting button 

3.5 Captions 

Captions are the autonumbering of labels used in a word processors to label the objects. 

They are used mostly under tables, figures and can be combined with their page numbers. 

List of all captions for figures and tables can be combined in the document with their page 

numbers. MS Word have the options to add, delete and format the captions. Apart from 

figures and table we can also caption the figures, charts, screencasts, videos, textboxes etc.  

3.5.1 Add Captions 

There are two different methods used to add a caption 

1: Using Right Click 

2: Using Reference Tab 

3.5.1.1 Using Right Click 

Follow these steps to add captions. 

Step 1: Select the desired figure or table and “Right Click” on it. 

Step 2: Select “Insert Caption” as shown in Figure 3.7. 
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Desired Table

Insert Caption

 

Figure 3.7: Captions Using Right Click 

Note: This method will work only on figures and tables. 

3.5.1.2 Using Reference Tab 

Follow these steps to add captions using “References” tab. 

Step 1: Select figure or table and go to the “References” tab.  

Step 2: Select “Insert Caption”   from “Captions” section. The “Caption” dialog 

box will appear on clicking the “Insert Caption”, with several options for you 

to set as shown in Figure 3.8. 

Step 3: Type in the text you want in the caption. 

Step 4: Select from label that perfectly defines the object. You can also create a new 

label if needed. 

Step 5: Click on “Numbering” and the “Caption Numbering” a dialogue box will 

appear. You can choose the numbering format as per requirement. 
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Step 6: Select the position of your caption and click “OK”. 

Step 7: For Auto caption go to “Caption” dialog box, and click on the “AutoCaption” 

field. 

Step 8: Scroll for the desired object, to link it with an auto caption and click “OK” as 

shown in Figure 3.8. 

Reference 

Tab Insert Caption

Caption

Name

Caption 

Position

Caption 

Numbering

Auto

Caption

Figure 1

 

Figure 3.8: Captions Using References Tab 

3.5.2 Cross Reference 

Variety of objects can be inserted in word processors. Some of the objects used in word 

processors are Charts, Figures, Slides, Spreadsheets and Pdf files. Cross references in word 

processor allows you to link set of these objects in a document.  It appears as a link to move 

in between the connected objects. Follow these steps to add cross reference to the object. 

Step 1: Go to the “ Text” section under “ Insert” tab and click on the object icon  

to create the desired object as shown in Figure 3.9. 
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Insert Tab

Text Section

Object

 
Figure 3.9 Creating an Object 

Step 2: Go to the “Caption” section in reference tab, click the “Cross References”. A 
dialogue box will open up as shown in Figure 3.10. 

Step 3: Select the desired reference type from the dropdown menu.  

Step 4: You can choose betweens the different ways of presenting your refrences by 
selecting the desired option from “Insert reference to” dropdown. 

Step 5: Under the “For Which Caption” section, check for the figure you want to refer 
to such as figure one. 

Step 6: Select “Insert as Hyperlink” check box. Hyperlink will help users to move 
directly to the referenced figure. 

Reference 

Tab
Cross-reference 

button

Reference 

Type

Dropdown

Insert 

Cursor 

Place

Cross Referenced 

figure  
Figure 3.10: Cross References 
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3.5.3 Format Captions 

Once you have added a caption. You can always change the formatting of your caption 

throughout your document. 

Step 1: To Modify the formatting in caption style “Right click” on the desired caption 

as shown in Figure 3.11.  

Step 2: Choose “Modify”.  Here you can change the font size, color etc.  

Desired Figure 

Caption

Home Tab

Caption style

 
Figure 3.11: Format Caption 

3.5.4 Delete Captions 

Caption can be deleted by simply selecting the desired caption and pressing the delete key. 

If you have more than one captions in your document after deleting the required caption 

you need to update the remaining captions using the following steps.  

Step 1: Press “CTRL+A” key for whole text selection of your document. 

Step 2: Press “F9” key to update all in the document.  

This will make sure that caption numbers are updated accordingly after deleting some of 

them. 
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3.6 Citation 

Citation is added in word processors to show that there is a bibliographic reference in your 

document. There are many predefined styles for citation available in MS Word i.e. APA 

style, Chicago style, ISO 690, IEEE and MLA 

3.6.1 Create Citation 

Follow these steps to create a citation in the document. 

Step 1: Go to “Citation and Bibliography” under “Reference Tab” as shown in Figure 

3.12. 

Step 2: Click on Style’s drop-down menu and choose the desired style for the citation 

in your document i.e. IEEE. 

Step 3: Click on the “Insert Citation” then add the“new source” or add  the 

“Placeholder”. 

3.6.1.1 Add New Source 

Follow these steps to add a new source. 

Step 1: Go to “Citation and Bibliography” section under the “Reference Tab” as 

shown in Figure 3.12 

Step 2: Click dropdown arrow on the side “Insert Citation” and select  the“Add New 

Source’.  

Step 3: Click on the “Show all Bibliography” field to add more details about your 

resource.  

Step 4: Click “OK”. 

Source will not be added as a citation at cursor place but once you have added the new 

source it will be available to cite again. 

3.6.1.2 Add New Placeholder 

Placeholder is used to create the citation without the source information which can always 

be added later. To create a placeholder, follow these steps. 

Step 1: Click on “Insert Citation” and choose “Add New Placeholder” this time from 

the drop-down menu as shown in Figure 3.12.  

Step 2: Enter the placeholder name in the text field.  



104 

 

Step 3: Click “OK” the citation placeholder will appear at the cursor placed. Question 

mark in source manager shows that it’s a placeholder. Just like the regular 

citation it will be added in the document.  

Reference 

Tab
Citation & 

Bibliography

 

Figure 3.12: Citation Placeholder 

3.7 Bibliography 

Listing out all the materials that is consulted during the research work is called the 

bibliography. After completing all steps for adding the citation sources in desired 

document, you can create bibliography for these documents using following steps. 

Step 1: Click on “Bibliography” from “Citation and Bibliography” section under 

“References” tab and choose a Bibliography as shown in Figure 3.13. 
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Tab

Bibliography

 

Figure 3.13: Bibliography 

3.8 References 

“References” and “Bibliography” terms can be used synonymously but there is a slight 

difference among them. References are the list of sources, referred in the research work to 

add references in your document and Bibliography is the list of everything you read, even 

if you have not reffered it in. Follow these steps to add References in your document.  

Click on “Bibliography” from “Citation and Bibliography” section under references tab. 

And choose “References” as shown in Figure 3.14. 
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Reference 

Tab

References

 
Figure 3.14: References 

3.9 Proofing 

Inside a document you can see multiple words with red lines underneath them which 

represent the spelling errors as well as words with two blue lines beneath them which are 

the grammatical errors. Document proofing means reading each word of your document 

carefully to check for any grammatical, spelling or punctuation errors to make it an error 

free document. 

Proofing Section under Review tab provide you features like “Spelling & Grammar”, 

“Thesaurus” and “Word Count” as shown in Figure 3.15. 

Review Tab

Proofing Section

 
Figure 3.15: Proofing Section 
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3.9.1 Spelling and Grammar 

Revising and rechecking your document for grammer and Spelling mistakes is the most 

important task to do before distributing your document. Now a days word processors have 

this  job easy to implement. Follow these steps to check the spelling and grammar of your 

document. 

Step 1: Go to “Review” tab as shown in Figure 3.16. 

Step 2: Click on “Spelling & Grammar”   button from proofing section. It will 

highlight the incorrect spelling. 

Step 3: Correct suggestions will be shown in the right side of  your document in the 

editer. You can make changes accordingly. 

These grammar and spelling checker will not always show the correct results. Sometimes 

error words will not even noticed by grammer checker or sometimes wrong errors will be 

pointed out. it is because sometimes special words doesn’t exist in dictionary but you can 

add such words into dictionary or ignore with the command option. 

Word will move one by one through all errors until you will review all errors as described 

below:  

Step 1: After the last error review, a dialogue box will be open for the confirmation 

that the grammer and spelling check is completed now. 

Step 2: Click OK. 

3.9.1.1 Command Options 

Ignore Once 

You can choose the “Ignore once” to skip the error for one time without making any 

changes from given suggestions. 

Ignore All 

You can choose the “Ignore all” to skip all instances of that specific word error in your 

document without making any changes from given suggessions. 
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Add to Dictionary 

You can choose “Add to dictionary”  to add new word in to the dictionary. By adding a 

word into dictionary, next time error will not appear to this word. Spelling should carefully 

check before adding it to the dictionary. 

Spelling & Grammar Review Tab

Ignore once

Ignore All

Add to Dictionary

 

Figure 3.16: Spelling and Grammar 

3.9.2 Thesaurus 

Thesaurus is used to look for the synonyms and antonyms. To use Thesaurus, follow these 

steps.  

Step 1: Click on the desired word you wanted to change as shown in Figure 3.17. 

Step 2: Go to “Proofing” section in review tab 

Step 3: Click on “Thesaurus”. In the right side of your document Thesaurus window 

will appear with all the alternate words suggestion in it. 

Step 4: To replace your selected word “Right click” on the given words in “Thesaurus” list  

Step 5: Click “Insert” or you can do it by selecting insert from the dropdown menu 

given next to each word. 

Step 6: To copy any word from Thesaurus list select insert from the dropdown menu 

given next to each word. 
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Thesaurus
Review Tab

Insert

Copy

 

Figure 3.17: Thesaurus 

3.9.3 Word Count 

While working on a homework, assignment or an article it is important to know how many 

words you have written. Word processors have this built in tool to keep count on the words, 

pages lines and paragraph etc. Follow these steps to use word count tool in MS Word. 

Step 1: Go to “Proofing” section in “Review Tab” as shown in Figure 3.18. 

Step 2: To get all the required information Click on the “Word Count”. 
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Word count 
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Figure 3.18: Word Count 

3.10 Revising 

Word processors revision tracking tool can make review by comparing two versions of the 

same document. 

Lets suppose you have two versions of a document, one typed by you and the other was 

edited by someone else. You may compare both copies to check exactly what has been 

changed from the original copy. Follow these steps to revise your document. 

Step 1: Go to “Compare section” the Review tab as shown in Figure 3.19. 

Step 2:  In “Compare section” click on “Compare”. The compare dialogue box will 

open. 

Step 3: There will be two drop-down lists. One for the original document and one for 

the revised document. From the drop-down list Browse and select “Original 

and Revised” accordingly. 
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Step 4: Click “OK” 

Review Tab

Compare

 
Figure 3.19: Revising 

Word will compare both documents and the changes will be shown in third document 

having comparison details on the right side as shown in Figure 3.20. 
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Figure 3.20: Document Comparison 

3.11 Footnote and Endnotes 

Footnotes and endnotes carry extra information and clarification apart from the main text 

of a document. Superscripted numbers in your document shows that footnote or endnote 

exists.   

Placement is the only difference between them. Footnote is shown at the end of every page 

and endnote at the end of every document. 

3.11.1 Footnote 

To add footnotes at the bottom of your document Follow these steps. 

Step 1: First of all cursor should be Placed at the desired location to add footnote in 

your document as shown in Figure 3.21. 

Step 2: Go to the “References Tab” and select “insert” footnote from “Footnotes and 

Endnotes” section. the cursor will now be moved down to the bottom of the 

page  

Step 3: Type the content of your footnote. 

Step 4: A superscripted number will be inserted at the cursor place showing that 

footnote belongs to this section of document. You can repeat this process to 

add additional footnotes. 



113 

 

Step 5: Adjust the formatting of footnotes by clicking the right arrow button as shown 

in Figure 3.21. 

References Tab
Insert Footnote

Superscripted

Number

Properties

Footnotes

 

Figure 3.21: Footnotes 

3.11.2 Endnotes 

Follow these steps to add footnotes in your document. 

Step 1: First of all cursor should be Placed at the desired location to add Endnote in 

your document as shown in Figure 3.22.  

Step 2: Go to the “References Tab” and select insert Endnotes from “Footnotes and 

Endnotes” section. Cursor will automatically move to the last page of your 

document. 

Step 3: Type the “Content” of your endnote. 

Step 4: To adjust the formatting of endnotes click the arrow button under the 

“Footnotes & Endnotes” section. 
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Insert Endnote
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Properties

 

Figure 3.22: Endnotes 

 

3.12        Table of Contents 

While working on a large document in word processor like a book or a report that will have 

hundreds of pages, it is very difficult to remember which page got what information. To 

solve this problem word processors allow you to add table of contents in the start of 

document so that it will be easy to organize and navigate through the document. 

Table of contents are the list of chapters placed in the beginning of your document. It lists 

the name of each chapter and section along with the page numbers as shown in Figure 3.23. 
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Figure 3.23: Table of Content Example 

3.12.1 Create and Remove Table of Contents 

Follow these steps to insert table of contents at the start of your document: 

Step 1: First of all cursor should be Placed at the desired location to add table of 

content in your document. 

Step 2: Click on “References” tab and go to “Table of content” section as shown in 

Figure 3.24. 

Step 3: Click on “Table of contents” and choose any style as desired. 

Step 4: You can also remove table of content by clicking the “Remove Table of 

Contents”. 
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Figure 3.24: Add and Remove Table of Contents 

3.12.2 Update Table of Contents 

After any modification in the headings of your document, Table of content must be 

updated. You can do it by Right click on the Table of  content and click on “ update table 

of contents” from the list as shown in Figure 3.25. 

 

Figure 3.25: Update Table of Contents 

3.13 Mail Merge 

Mail merge is very useful feature in word processors that provide the facility to create 

named letters in bulk from a mailing list. It is used to print names and addresses of multiple 

persons on letters, envelops and newsletters by saving the typing work. Its implementation 

requires a word document along with a spreadsheet filled with the list of recipients. 
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Follow these steps to use Mail Merge in Microsoft Word: 

Step 1: Open a “Word Document”. 

Step 2: From Mailings tab, click on the “Start Mail Merge” tab from “Start Mail 

Merge” section and click on “Step-by-Step Mail Merge Wizard” from the 

drop-down menu as shown in Figure 3.26. 

Mail merge will now automatically guide you through following Six main steps to 

complete the process.  

Start Mail Merge
Mailings Tab

Mail Merge 

Steps

 

Figure 3.26: Start Mail Merge 

3.13.1 Step 1: 

On the Right side of your document “Mail Merge window” will appear. Select the type of 

document for example “Letters” as shown in Figure 3.27.  

Click next for step 2 “Starting Document”. 
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Figure 3.27: Step-1 

3.13.2 Step 2 

Select your desired setup like template, current or existing document as shown in Figure 

3.28. 

Click “Next” for step 3 “Select Recipients”.  
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Figure 3.28: Step-2 

 

3.13.3 Step 3 

Recipients list in form of excel workbook will be used in step 3 to place each address 

automatically in the document. New list can be typed from the mail merge wizard. 

To use any existing recipient list you need to choose “use an existing list” from the wizard 

and browse open the recipients file as shown in Figure 3.29. 

Mail Merge recipients dialogue box will open. Select the desired recipient’s name from the 

list by clicking on check and uncheck. “Create” option is used to create new recipient list. 

Click “OK” when finished selecting the desired recipients, and it will take you to the step 
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4. Writing a letter 

Step 3

Select the 

Recipient List

Select the 

Worksheet

Add or Remove 

Recipients

 
Figure 3.29: Step-3 

3.13.4 Step 4 

In this step you will write the letter and add the placeholder. You can also customize the 

display of recipient information as shown in Figure 3.30. 

Click “Next” for step 5 to preview your letter before printing. 
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Figure 3.30: Step-4 

3.13.5 Step 5 

Body of every letter will be same except for the recipient’s information that will keep 

changing in each letter. On step 5 you can preview all letters by using left and right scroll 

arrows. In case you want any change, click on “Edit recipient list”. When everything looks 

good, click “Next” for step 6 to complete the Mail Merge as shown in Figure 3.31. 

Step 5

Preview 

your letters 

here by 

clicking 

next to 

recipient 1

 
Figure 3.31: Step-5 
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3.13.6 Step 6 

In this last step of Mail Merge process click on the Print option.  “Merge to Printer” dialog 

box  will appear. Choose the required options and click “OK”. The “Print”  window box 

will appear now as shown in Figure 3.32. Change the desired print setting and click “OK”. 

All letters will get printed one after another .  

Print all

Step 6

 

Figure 3.32: Step-6 

3.14          Document Protection 

To wirte a confidential document, most important thing is to protect that document and 

keep it secure from unauthorized access. By default, all the documents in word processor 

are not protected and anyone can open and change these unless you protect your document. 

Follow these steps for your document protection. 

Step 1: Click “File Tab”. 

Step 2: Click the “Protect Document” from the “Info” pane as shown in Figure 3.33.  

Step 3: Choose any of the desired options from drop-down menu. 
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Protect Document

 

Figure 3.33: Protect Document 

3.14.1 Read only 

Read only option provide convenience to use the document as read only and protect it from 

the unintentional changes. Follow these steps to save your document as read only. 

Step 1: Click the “Protect Document” button from “Info” pane.  

Step 2: Mark your document as read only and Save the document 

Step 3: Close and reopen your document . A message will pop up saying “the author 

would like you to open it as read-only” as shown in Figure 3.34.  

Step 4: Click “Yes” and document will be open in read only mode. 

Step 5: To disable the read only, click on the protect document from info panel in file 

menu and select “Always Open Read only” again.  
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Figure 3.34: Read Only 

3.14.2 Encrypt with Password 

Follow these steps to to apply password to your document. 

Step 1: Click on the “Protect Document” button from “Info” pane file menu and this 

time select “Encrypt with password”.  

Step 2: A window will popup with the name of Encrypt document having password 

field in it as shown in Figure 3.35. “Enter the password” and click “OK”. 

 Now every time when you open this document you will be asked for the password. 

 

Figure 3.35: Encrypt with Password 

3.14.3 Restricted Access 

Restricted access in word processors allows you to restrict your document to only specific 

individuals. Follow these steps to restrict the limited access to your document.  

Step 1: Go to protect document from info panel in file menu and this time select 

Restricted Access. Permission window will open as shown in Figure 3.36. 

Step 2: Select the “Restrict Permission to This Document” check box. 
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Step 3: Enter the email addresses you wanted to allow the access to this document. 

Step 4: Click “OK” to apply. 

 

Figure 3.36: Restricted Access 

3.14.4 Restricted Editing 

Restricted editing will lock the document but allows only specific part of the document to 

be edited. Follow these steps to restrict the editing option. 

Step 1: Go to protect document from info panel in file menu and this time select 

Restricted Editing. You will see the Restricted editing in the right side of the 

document as shown in Figure 3.37. 

Step 2: In this panel you can allow people to read as well as select which section is 

editable for them. Make changes as per your requirement.  

Step 3: To stop restricted editing go to “Restricted editing” option and in the restrict 

editing panel click on “Stop Protection”.  
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Figure 3.37: Restrict Editing 

3.14.5 Add a Digital Signature 

Digital signature is an electronic stamp of authentication for your document. It protects 

your document from the unauthorized editing. These signatures will confirm that the 

document is only edited by a signer. Follow these steps to use the digital signature. 

Step 1: Click on the “Protect Document” from “Info pane” in File menu. Select “Add 

a Digital Signature”.  

Step 2: A “Sign window” will open as shown in Figure 3.38.  

Step 3: Select the type of “Commitment” as desired from dropdown list. This will tell 

this file reader that you have created it or approved it and you were the last one 

to revise this file.  
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Figure 3.38: Add Digital Signature 

3.14.6 Mark as Final 

Last option in document protection list is marking it as final.  

Step 1: Click on the “Protect Document” from “Info Panel” in “File” menu and select 

“Mark as final”. Marking the document as final will discourage to edit this file.  

Step 2: A pop-up message will tell that “this document has been marked as final” as 

shown in Figure 3.39.  

Step 3: Click “OK”.  

 

Figure 3.39: Message box 

Step 4: Another message box will popup as shown in Figure 3.40. "This document 

has been marked as final to indicate that editing is complete and that this is the 

final version of the document. When a document is marked as final, the status 

property is set to 'Final' and typing, editing commands, and proofing marks are 

turned off. You can recognize that a document is marked as final when the 
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Mark as Final icon displays in the status bar." 

Step 5:  Click “OK”. 

 

Figure 3.40: Mark as Final 

Now on every edit this pop up message will appear to remind that this document is marked 

as final. Click “OK”.  

3.15         Document Properties 

Properties of the Document are the metadata details about that document. The properties 

of document consist of Title of that document, Arthur name, Subject and other keywords 

to identify that document’s topic. 

Microsoft Word can store the advance properties of document. Few of them are displayed 

on the “Info” tab. You can change any property from there as shown in Figure 3.41. 

Files can be easily organized and searched using these properties. There are four type of 

properties exist in Microsoft Word. Theses properties are  

 Standard 

 Customized 

 Automatically updated 

 Document Library 

3.15.1 Standard Properties 

Standard properties are the default properties of word processors. i.e. Author, Title and 

subject. You can add and change these properties as per your convenience to make it easier 

for search and organizing purpose. Standard properties allow you to add Keywords/Tags 

that can help you in file search. 

3.15.2 Automatically updated properties 

Automatically updated properties are system properties that will be updated automatically 
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i.e. file size or the date when file was created or when was the last changes made in the 

file. It will help you in file search. 

3.15.3 Custom Properties 

Custom properties are the advanced properties you can define for your document. i.e. you 

can assign name of your document as shown in Figure 3.41. 

Properties

Advance Properties

 

Figure 3.41: Document Properties 
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Self-Assessment Questions 

1. What is meant by Style and how many different ways are available to create styles 

in MS Word? 

2. What is meant by caption? How many ways are available to create captions in MS 

Word? 

3. Explain Cross reference with the help of an example. 

4. What is the purpose of Citations in a MS Word? Write down the steps to insert the 

citation. 

5. What is a place holder? How do we add it in word processor? 

6. What is the difference between bibliography and reference? 

7. What is the difference between Proofing and Spell Checking? 

8. Explain the difference between Thesaurus and dictionary? 

9. What are the important steps of adding table of contents? 

10. What is the main purpose of mail merge in MS Word? 

 

Self-Assessment Activities 

1. Create a new Style in MS Word by using following data and name as 

My_New_Style. 

a. Language: Time New Roman 

b. Font: 14 

c. Bold 

d. Underline 

2. Create a table in MS Word and Insert a caption on it? 

3. Create two MS Word files named as, File1.docx and File2.docx. Create a cross 

reference in File 1 for File 2. 

4. Check if the following word exists in your MS Word dictionary if not add it into it? 

So, that MS Word don’t give error on it? 

“YourFirstName_YourLastName_YourRegistrationNumber”.  

5. Remove the above added word from the dictionary so that MS Word give error on it. 

6. Create the MS Word Document and add following Foot Note. “This is my first foot note” 

7. Create the MS Word Document and add following End Note. “This is my last page” 

8. Create a document and protect it by making it read only? 

9. Create a document and protect it by applying password “AIOU_IS_BEST”? 

10. Create a document and protect it by adding digital signature in it? 
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4. SPREADSHEET OVERVIEW 

4.1 Introduction 

A document consist of rows and columns is called the spreadsheet. Spreadsheets are used 

to store, sort and calculate the mathematical data. Spreadsheet’s are unique in a way to to 

calculate with the help of mathematical formulas. Data is stored in the data cells. Microsoft 

Excel is the leading spreadsheet program among all. It is a part of Microsoft Office suite. 

Other than Microsoft Excel, Google sheets, Libre office, Lotus Symphony, iWork Numbers 

and Open office are the alternative spreadsheet programs used for spreadsheets purpose. In 

this Unit you will learn the creation and format customization of the spreadsheets in 

Microsoft Excel, using the Styling, Theme, Layout and Properties features. 

 

4.2 Objectives 

After complete study of this unit, you will be able to: 

 Understand basics of spreadsheet  

 Create file from Templates 

 Format data in spreadsheet with styles 

 Set theme of spreadsheets 

 Freeze data in spreadsheets 
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4.3 Microsoft Excel Spreadsheet Overview 

An overview of different parts of Excels Spreadsheet is show in Figure 4.1. 

 Sizing & Close Button: This area has three buttons, left button  minimize 

spreadsheet, middle button  changes the size of spreadsheet and right button  

close the spreadsheet and MS Excel window. 

 Ribbon and Toolbar: Ribbon groups the tools into different tabs named as File, 

Home, Insert, Page Layout etc.  

 Quick Access Toolbar: Quick Access Toolbar consists of frequently used tools e.g. 

save file, undo, Redo etc. You can add on more tools here by clicking on a small 

down shape arrow icon  at right side of this area. 

 Name Box: Name box is used to displays the name and location of the desired 

selected cell in MS Excel spreadsheet. 

 Formula Bar: Formula bar in MS Excel spreadsheet is used to create new formula 

or function or  view the existing formula/function applied on the selected cell. 

Formula bar is also used to enter data into a selected cell. 

 Spreadsheet: This is main area consist of rows and column available to work in MS 

Excel. it is used to store, sort and calculate the mathematical data. 

 Column: Column in MS Excel spreadsheet is a vertical group of cells identified by 

Letters A,B,C…etc. 

 Row: Row in MS Excel spreadsheet is a horizontal cells group that start from page’s 

left side end in the right side. Rows have uniquely identification in form of row 

numbering 1,2,3…etc. 

 Cell: The intersection between a column and a row is called the cell. Cell numbering 

consists of column and row name i.e. A1 where A is the Column name and 1 is the 

row. 

 Add New Sheet: You can add more spreadsheets just by clicking on the  icon  . 

 Worksheet View Options: There are three ways to view a spreadsheet. Click on 

 icon to select your desired view. 

 Zoom Control: You can increase or decrease the visible size of spreadsheet by using 

zoom in, zoom out and reset zoom of slide as shown in Figure 4.1. 
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Figure 4.1: Overview of MS Excel Spreadsheet 

4.4       Creating File 

There are two ways to create a file in MS Excel: 

 Creating Blank File 

 Creating from Existing Template 

4.4.1 Creating Blank File 

To create a new blank MS Excel file in your computer, follow these steps: 

Step 1: In Microsoft Windows, go to “Start menu”. 

Step 2: Scroll to find MS Excel program and click to open. Excel program will be 

opened. 

Step 3: Click on “New” Panel. 

Step 4: Select “Blank Workbook” Thumbnail to create file as show in Figure 0.2. 
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New MS Excel file with blank spreadsheet will be created and opened to work on it. 

Blank Workbook

New 

Pannel

 

Figure 0.2: Blank Workbook 

4.4.2 Creating from Existing Template 

In MS Excel a template have predefined sample contents, styles, set of colors, and visual 

effects etc. Predefined template will give professional look to your spreadsheet. You can 

also create and customize your own template according to your data. There are many 

predefined templates available in MS Excel program. These templates are categorized in 

different categories e.g. educational, marketing, business etc. You can use them according 

to your requirement. Follow these steps to create template-based presentation file. 

Step 1: Open “MS Excel” program. 

Step 2: Click on “New” Panel. 

Step 3: Different categories of different predefined Excel workbook templates will be 

displayed e.g. Education, Business, Sports etc as shown in Figure 0.3. 

Step 4: Select your category. It will show available templates for the selected category. 

Step 5: This will show you available templates for selected category. 
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Step 6: Click on “Thumbnail” of template, which you want to select for your file. 

Step 7: Click on “Create” button. 

New file with selected templated will be created. On creation of templated based file, you 

will see some predefined formatting including text, images and tables. You can observe 

that workbooks are well formatted, and styles are according to template theme. 

Template Thumbnail

New

Pannel

Templates Categories

 

Figure 0.3: Categories of Predefined Templates 

4.5 Creating Template File 

You can create your own template and then store it in the templates folder. In this way a 

new worksheet can be created without help of the original file. 

Follow these steps to create the Template file. 

Step 1: Create a new worksheet and make changes as desired as shown in Figure 0.4. 

Step 2: In “File” tab click on “Save As”. 

Step 3: Click “Browse” and open office templates folder. 

Step 4: Enter a file name.  

Step 5: Select file type as “Excel Template” from the drop-down list. 

Step 6: Click “SAVE”. this file is now saved as an Excel Template for future use. 
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Figure 0.4: Creating Template File 

 

4.6 Conditional Formatting  

Conditional formatting is a command or tool that applies a condition or format to a range 

of cells, MS Excel enables to apply conditional formatting in a quick and efficient way. 

For example you can sort the employee spreadsheet on the basis of their grades or salary 

etc. 

4.6.1 Highlight Cell Rules 

In this section we will create a conditional formatting for a range of cells to be highlighted. 

To create cell rules follow these steps: 

Step 1: Select the desired range of cells as shown in Figure . 
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Selected Cells

 

Figure 4.5 Cells Selection 

Step 2: Go to “Styles” section under “Home” tab as shown in Figure 4.5. 

Conditional Formatting
Home Tab

Style Section

 

Figure 4.5: Conditional Formatting 

Step 3: Click on “Conditional Formatting”, a dropdown menu will appear. 

Step 4: Select “Highlight Cell Rules” another dropdown menu will appear that will 

contain rules as shown in Figure 4.6. 
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Highlight Cells Rules Select any from the 

dropdown list

 

Figure 4.6: Highlight cells rules 

Step 5: Hover the mouse on desired rule to apply and “Click” on it. A dialog window 

will appear as shown in Figure 4.7. 

Desired Cell Value Highlighting Color

 

Figure 4.7: “Greater Then” Rule 

Step 6: Add the condition as in Figure 4.7 we have 80 as our greater than value. 

Step 7: Select the format from the dropdown menu. 

Step 8: Click “Ok”. 

Step 9: Selected cells are now shown after conditional formatting in Figure 08.  
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Greater Then 80

 

Figure 08: Applied Rules 

You can add more rules by clicking on “More Rules” in “Highlight Cell Rules” dropdown 

menu. You can also customize your own rules using the dialog window as shown in Figure 

4.9. 

 

Customize New Rules

 
Figure 4.9: Customize Rules 
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4.6.2 Top/Bottom Rules 

Top/Bottom rules are also conditions that can be applied to specific cells under a given 

threshold. Follow these steps to apply Top/Bottom rules: 

Step 1: Select desired cells as shown in Figure 4.10. 

Selected Cells

 

Figure 4.10: Cells Selection 

Step 2: Go to “Styles” section under “Home” tab. 

Step 3: Select “Conditional Formatting” to get the dropdown menu. 

Step 4: Click on the “Top/Bottom Rules” another dropdown menu will appear with 

multiple top/bottom rules in it. 

Step 5: Select any desired rule as shown in Figure 4.11. 
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Figure 4.11: Top/Bottom Rules 

Step 6: A dialog box will appear as shown in Figure 4.12. Choose any formatting style 

for your selected rule. 

Highlighting Color

 

Figure 4.12: "Above Average" Rule 

Step 7: Click “OK”. 

Formatting rule will be applied to your selected cells as shown in Figure. 
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Above Average

 

Figure 4.14: Applied Above Average Rule 

4.6.3 Conditional Formatting Presets 

In MS Excel, there are several predefined styles that can be applied to the conditional 

formatting data. These presets are grouped into three categories: 

 Data Bars 

 Color Scales 

 Icon Sets 

4.6.3.1 Data Bar 

Data bar is used to highlight the values with a horizontal bar. To add data bar in your sheet 

follow these steps: 

Step 1: Select cell range. 

Step 2: Go to “Styles” section under “Home” tab. 

Step 3: Select “Conditional Formatting” to open a drop down menu. 

Step 4: Click on the “Data Bar” and Choose any subtype out of “Gradient Fill” or 

“Solid Fill” as shown in Figure 4.13. 
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Data Bar Gradient Fill

Solid Fill

 

Figure 4.13: Data Bar 

All cells will be filled proportionally as per given values. The cell with minimum value 

will not have any data bar, and the cell with maximum value will have maximum length as 

shown in Figure 04.14. 

Proportionally 

filled Bars

 

Figure 04.14: Applied Data Bar Rules 

You can always customize your Data bar by using edit formatting rules options. 
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4.6.3.2 Color Scales 

Colors Scales are used to highlight the cell values by using color shades. For example: you 

can give different colors to highlight the highest average and lowest values in desired cell 

range: Follow these steps to apply color scales to your desired cell range 

Step 1: Select the desired range of cells. 

Step 2: Go to “Styles” section under “Home” tab. 

Step 3: Select “Conditional Formatting” for a dropdown menu. 

Step 4: Click the “Color Scale” and Choose any subtype as desired as shown in Figure 

4.15. 

Color Scale

Select any 

scale

 

Figure 4.15: Color Scale 

MS Excel will calculate 50th percentile by default for 3-Color scales 

 Red color is assigned to minimum value (9) cell   

 Yellow color is assigned to median value (36) cell 

 Green color is assigned to maximum value (80) cell 

All other cells will be colored proportionally as shown in Figure 4.16.  
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Color Scale

 
Figure 4.16: Applied Color Scale 

Step 5: You can further customize the color scale by editing any rule with the help of 

manage rules option as shown in Figure 4.17.  

Customize 

Color Scale

 
Figure 4.17: Customize Color Scale 
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4.6.3.3 Icon Sets 

Icons sets are also used to highlight the cell values by using a set of icons. Each icon 

characterizes a value with its orientation. Follow these steps to apply icon sets to your 

desired cells. 

Step 1: Select the desired range to apply conditional formatting “Icon Set”. 

Step 2: Go to “Styles” section in “Home tab”. 

Step 3: Select “Conditional Formatting” for a drop down menu. 

Step 4: Click on the “Icon Set” as shown in Figure 4.18 and Choose any subtype out 

of “Directional”, “Shapes”, “Indicators” and “Ratings” as desired. 

 

Icon Sets

Select 

any Set

 

Figure 4.18: Icon Sets 

Icons set will be applied as shown in Figure 4.19. 
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Figure 4.19: Rules Applied 

Step 5: You can further customize the Icon set by editing any rule with the help of 

Manage Rules option as shown in Figure 4.20. 

Customize 

Icon Set

 
Figure 4.20: Customize Icon Set 
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4.6.4 Removing Conditional Formatting 

You can also remove “Conditional Formatting” by using the following steps: 

Step 1: Select the desired cells. 

Step 2: Go to “Styles” section under “Home” tab as shown in Figure 4.23. 

Step 3: Select “Conditional Formatting” for a dropdown menu. 

Step 4: Click on “Clear Rules”, another dropdown menu will appear. 

Step 5: Select  “Clear Rules from Selected Cells”.  

You can remove all rules from the sheet by clicking on the “Clear Rules from Entire Sheet” 

as shown in Figure 4.21. 

Remove 

Conditional 

Formatting

 

Figure 4.21: Clear Rules 

4.6.5 Manage Conditional Formatting Rules 

Rules can be managed by using conditional formatting rules manager. Follow these steps 

to use the Rule Manager: 

Step 1: Go to “Styles” section under “Home” tab. 

Step 2: Select “Conditional Formatting” for a dropdown menu. 
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Step 3: Click on “Manage Rules” window will open. 

Step 4: If you wanted to edit any previously applied formatting rule you need to select 

the cell range. Without selection you can only create new rule because edit and 

delete options. You can change the current selection from drop down list in 

Rule manager window as shown in Figure 4.22. 

Edit is used to modify and delete is used to delete the existing rules. 

Click OK

Select Cell 

Range

 
Figure 4.22: Rules Manager 

4.7         Cell Styles 

Cell styles are used to apply specific properties to a range of cells in a spreadsheet. It not 

only saves the time but also improve the look and feel of the document. The step by step 

procedure is given below: 

Step 1: Choose a cell or range of cells. 

Step 2: Go to “Styles” section under “Home” tab. 

Step 3: Click on “Cell Styles”. 

Step 4: Select the style of your choice from the dropdown menu. 

 

Selected style will be applied to your selected cells and will replace all existing cell 

formatting. 
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4.7.1 Create New Styles 

To create a new cell style Follow these steps. 

Step 1: Go to “Styles” section under “Home” tab. 

Step 2: Click on “New Cell Style” as shown in Figure 4.23. 

Click on 

New Cell 

Style

 
Figure 4.23: New Cell Style 

Step 3: New style window will pop up as shown in Figure 4.24. You can Enter the 

style “Name”. 

Step 4: Click on “Format” button to define the properties like font, format, Alignments 

and Border. If you don’t want select any formatting, uncheck the box. 

Step 5: Click “OK”. 
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New Style Name

New Style 

Formatting

 

Figure 4.24: New Style Formatting 

Now you can see your recently created style with other predefined styles. 

4.7.2 Remove Cell Style from Document 

You can remove a cell style from your data without deleting it from the pool of predefined 

styles.  Remove the cell styles by following these steps: 

Step 1: Select the desired cell. 

Step 2: Go to “Styles” section under “Home Tab”. 

Step 3: Select the “Cell Styles”. 

Step 4: Click on “Normal” under “Good, Bad and Neutral” Style group. 

All Formatting styles will be removed from your data without deleting any style. 

4.7.3 Delete Predefined/Custom Cell Styles 

You can also delete a predefined cell style to remove it from the list of available predefined 

cell styles. After deletion it will be removed from all formatted cells. Follow these steps 

for cell style deletion from the list. 
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Step 1: Go to “Styles” section under “Home” tab. 

Step 2: Click on the “Cell Styles”. 

Step 3: “Right Click” on desired style, and click “Delete”. 

4.8 Cell border 

Border create a boundry around an individual or a range of cells to distinguish it for printing 

or separate it from other data. 

Step 1: Select the desired cells to format. 

Step 2: Go to “Font” section under “Home” tab. 

Step 3: Click on the arrow of Border button   and open the drop-down menu 

showing the border options in it as shown in Figure  4.25. 

Home Tab

Dropdown 

menu

Borders

 
Figure  4.25: Insert Borders 

Step 4: Choose the desired border line from dropdown list. 
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Step 5: Click on the “More Border” and Open “Format Cell” dialog box as shown in 

Figure 4.26 and go to “Border” tab to change the other options like line type, 

color and thickness or border. 

Step 6: Another way to open the “ Format cell dialog box” is by a“Right Click” on 

desired cell. 

Click Ok

Format Cells

Border Tab

 
Figure 4.26: Format Cells 

4.9          Format painter 

Formatting painter is used to copy, the formatting style of one cell and paste to another cell 

or a range of cells. Following are the steps to apply format painter.  

Step 1: Select the desired cell you want to copy the formatting from. 

Step 2: Go to “Clipboard” section under “Home” tab.  
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Step 3: Click on “Format Painter” icon.  to copy the formatting style as shown in 

Figure  4.27 

Home Tab

Format Painter

 

Figure  4.27: Format Painter 

Step 4: Around the selected cell, from where you copied all the formatting, a moving 

dashed border will appear and the pointer will turn into a paint brush as shown 

in Figure 4.28. 

Home Tab

Format Painter
Moving dashed 

border Mouse pointer

 

Figure 4.28: Format Painter Moving Dashed Border 

Step 5: Click and drag the pointer to the desired cell to paste the style formatting. 
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Step 6: The style will be copied to the clicked cells as shown in Figure  4.29.  

Home Tab

Format Painter
Selected 

Formatting

Dragged 

Formatting
 

Figure  4.29: Format Painter Click and Drag 

If same format is to be applied on multiple cells there is no need to copy and click on the 

format painter again. Double click on the format painter after selecting multiple cells. After 

finishing all the format pasting, click on the “Format Painter” icon to exit from that mode. 

4.10 Theme 

Themes can change the look of your document and make it easy to coordinate with color, 

font and other formatting. Each theme contains two fonts heading and body, 12 colors and 

different effects of shapes.  

4.14.1 Standard Theme 

A theme is a set of effects (color, font, style etc.) that sets the look and feel of a spreadsheet. 

There are two parts of a theme in MS Excel. 

 Heading 

 Body 

There are around 12 color that are available to set the theme of a spreadsheet. 

Step 1: Go to “Themes” section under “Page Layout” tab. 
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Step 2: Select the “Themes” button under the “Themes” section from the dropdown 

list as shown in Figure 4.30. 

Step 3: Hover the pointer on themes and you will notice that formatting of your 

worksheet will keep changing according to themes.  

Step 4: Choose any theme as desired. 

Selected theme formatting will be applied to your worksheet.  

Page layout 

Tab
Themes 

Button

Theme 

Font

Themes 

Color

Selected 

Theme

 

Figure 4.30: Standard Theme 

If you have already applied any theme to your worksheet, theme color and fonts related to 

the applied theme will appear in the “Font” section under “Home Tab” as shown in Figure 

4.31. 
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Theme 

Font
Themes 

Color

 

Figure 4.31: Theme Formatting 

4.14.2 Change Theme Color 

Follow these steps to create your own color theme for your worksheet. 

Step 1: Go to the “Theme” section under the “Page Layout”  

Step 2: Click “Colors” to change the Color. You can customize your own color the 

drop down list 

Step 3: Click on the “Customize Colors” in the “Colors” as shown in Figure 04.32. 
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Page layout 

TabTheme Section Theme Color

Color

DropDown

Customize 

Colors
 

Figure 04.32: Theme Color 

4.14.3 Change Theme Font 

Follow these steps to create your own Font theme for your worksheet. 

Step 1: Go to the “Theme” section under the “Page Layout” and click “Fonts” and 

pick the font set as shown in Figure 4.33.  

Step 2: Customized font can be achieved by clicking on the “Customize Fonts” that 

comes under the drop-down list of “Fonts”. 



161 

 

Page layout 

TabTheme Section Theme Font

Font

DropDown

Customize 

Font
 

Figure 4.33: Theme Font 

4.14.4 Change Theme Effects 

Theme effects are the composition of lines, fill, reflection and shadows. To create a theme 

of your own choice you just have to select from the predesigned effects from the given 

drop down list of themes. Follow these steps if you want to customize your theme effects 

for your worksheet. 

Step 1: Go to the “Theme” section under the “Page Layout” as in Figure  4.34. 

Step 2: Click on the “Effects”. 

Step 3: Select the set of effects as required. 
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Page layout 

TabTheme Section

Theme 

Effects Button

Effects 

DropDown

 

Figure  4.34: Theme effects 

 

4.14.5 Switch/Remove Theme 

Follow these steps below to switch or remove a theme. 

Step 1: To switch the theme, just choose different theme from the “Theme” drop-down 

menu. 

Step 2: Click on “Office theme” as “Default” theme. 

Step 3: To remove theme from any section of your document select that desired 

section and change formatting as per your choice such as font, color etc. 

4.14.6 Save Custom Theme 

You can customize a theme to re-use in future by using the following steps. 

Step 1: Go to the “Theme” section under the “Page Layout”. 

Step 2: Click on Themes to open a list of themes. 

Step 3: Select “Save Current Theme” as shown in Figure 04.35. 
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Step 4: Type the name of your theme. 

Step 5: Save the theme by clicking on “Save” button. 

Theme Section

Save Current Theme

 

Figure 04.35: Save Current Theme 

4.11         Text Wrapping 

Sometimes you type more text than the space available in the cell. Text wrapping help to 

display the increase data in a single cell. MS Excel provides two methods for text wrapping. 

 Using Wrap Text Button 

 Using Right Click 

4.11.1 Using Text Wrapping Button 

The steps are as follows: 

Step 1: In the “Home Tab” go to “Alignment” section as shown in Figure 0.36. 
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Home Tab
Wrap Text 

Button

Selected 

Cell

 

Figure 0.36: Using Wrap Text Button 

Step 2: Click on the “Wrap Text”. 

Step 3: Click and drag the right corner of Column A to increase or decrease the width 

of your desired column  

Step 4: You can  also adjust the row height by clicking the bottom border of the cell. 

text is usually aligned to the bottom of cell as shown in  

Step 5: Figure 0.37. 

Selected 

Cell

Home Tab
Wrap Text 

Button

 
Figure 0.37: Text Wrapping 
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4.11.2 Using Right Click 

Follow these steps to wrap the text automatically in MS Excel:  

Step 1: Select the desired cell. 

Step 2: Right click on the desired cell.  

Step 3: Select “Format Cell” to open the Format cell window as shown in Figure 0.38. 

Step 4: Check the “Wrap Text” checkbox under the “Alignment” tab. 

Format Cells

Selected Cell

Wrap text 

checkbox

 

Figure 0.38: Using Format Cells window 

The selected cell will be wrapped. 

4.12         Merge Cell 

Merge cell command, merge two or more cells of a spreadsheet To Merge the cells follow 

these steps. 

Step 1: Select the desired “Range” from B1 to D2 as shown in Figure 0.39. 

Step 2: Click on the “Alignment” section under “Home” tab. 

Step 3: Select the “Merge & Center”. 
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Selected range will be merged together to make one cell as shown in Figure 0.39. 

Home Tab

Merge & Center

Selected Cells 

Range

Merged Cell

 

Figure 0.39: Merge Cells 

4.13           Spelling Check 

Inside a document you can see multiple words with red lines underneath them which 

represent the spelling errors as well as words with two blue lines beneath them which are 

the grammatical errors. Document proofing means reading each word of your document 

carefully to check for any grammatical, spelling or punctuation errors for a professional 

error free document. Fortunately, MS Excel includes spelling check tool to make your 

worksheet error free. Follow these steps to make sure your worksheet doesn’t include any 

spelling errors. 

Step 1: Under the “Review” tab check for the “Proofing” section  

Step 2: Click on the “Spelling” section. 

Step 3: Suggestion for all the spelling error in your worksheet will be shown in a 

dialog box as shown in Figure 0.40. 

Step 4: Choose a correct suggestion if available. 
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Step 5: Click on “Change”. You can always decide wheather to apply changes on the 

error as per suggession, ignore that error once or ignore all the similar errors 

related to that error. To avoide getting error on a noun you can always add it 

to dictionary. 

Ignore Once

Ignore All

Add to Dictionary

Change

Change All

Autocorrect

Suggestions

 

Figure 0.40: Spelling Check 

Step 6: After the last error review, a dialogue box will be open for the confirmation 

that the grammer and spelling check is completed now, as shown in Figure 

0.41.  

 

Figure 0.41: Spell Check Complete 

Step 7: Click “OK”. 

4.13.1 Ignore Once 
Ignore once will skip the error once without changing it. 

 

4.13.2 Ignore All 
You can choose the “Ignore once” to skip the error for one time without making any 

changes from given suggestions. 
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4.13.3 Add to Dictionary 
You can choose “Add to dictionary”  to add new word in to the dictionary. By adding word 

into dictionary, next time error will not appear. Spelling should be carefully checked before 

adding it to the dictionary. 

 

4.14        Page Margin 

Page Margin is used to define the area between contents and edges of the page. Default 

page margin is set to 1 inch from top and bottom and 4.75 inch from right and left side. 

You can also customize your own page margin. Follow these steps to set the page margins 

of your worksheet.  

Step 1: Select the worksheet. 

Step 2: In the “Page Layout” tab Go to the “Page Setup” section.  

Step 3: A drop down menu will appear by clicking on the “Margin”as shown in Figure 0.42. 

Step 4: You can now select from any predesigned Margin list of Normal , Wide and Narow type 

. 

Page 

Layout Tab

Margin 

Dropdown List

Margin Button

Customize Margin

 

Figure 0.42: Page Margin 
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Step 5: You can also customize the margins of your own choice by clicking on 

“Customize Margins” from the list as shown in Figure 4.43. Page Margin section exists in 

the Page setup window that can be open by clicking on the arrow at the bottom right corner 

of “Page Setup” section. 

Step 6: Go to the “Margins” tab in page setup window. 

Step 7: Define the new page margin setting as desired. 

Step 8: Click “OK” to apply the defined margin settings. 

Margin

 
Figure 4.43: Page Margin using Page Setup Window 

4.15       Page Size and Orientation 

page size is used to define the size of your printing page. The default page size in MS Excel 

is Letter with the portrait orientation. It prints up and down on the long vertical side of the 

page. Landscape prints on the horizontal side of the page which usually help printing the 

charts. 

Follow these steps to change the page size in MS Excel worksheet. 
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Step 1: Go to the “Page Setup” section under the Tab of “Page Layout”. 

Step 2: A drop down menu will appear by clicking on the “Size” as shown in Figure 0.44. 

Step 3: Select the desired paper size from the page sizes list. 

Page 

Layout Tab

More Paper Sizes

Page Size

 

Figure 0.44: Page Size 

Step 4: Or click on “More Page Size” from the list to open the Page setup window as 

shown in Figure 0.44 

Step 5: Choose the desired orientation for your page. 
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Step 6: Click “Ok” to apply the desired changes as shown in Figure 4.45. 

Page Tab

Page Orientation

Page Size

Print

Print Preview

 

Figure 4.45: Page Setup 

4.16   Print Area 

Print area is the cell range you wanted to print excluding the entire worksheet. In MS Excel 

the default print area starts from A1 to the last occupied cell in the worksheet. But it also 

allows to specify range of cells for printing. 

One worksheet can have multiple print areas. Which canbe printed on separate page. 

To set print areas on your worksheet follow these steps: 

Step 1: Select the cell range as shown in Figure 4.48. 

Step 2: Go to “Page Setup” section from the “Page Layout” tab. 

Step 3: Click on “Print Area” to open a drop down list with following options. 

 Set the Print Area 

 Clear the Print Area 
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You can select “Set Print Area” to define new print area or “Clear Print Area” to clear the 

previous selected ones. 

4.16.1 Add to Print Area 

You can add the adjacent cells to your print area by using following steps. 

Step 1: Select the desired cells. 

Step 2: Go to the “Page Setup” section under the “Page Layout” tab, as shown in 

Figure 0.46. 

Step 3: To open up the drop down list Click on the “Print Area”.  

Step 4:    Following three options exists in the list if cells are adjacent. 

 Set Print Area 

 Clear Print Area 

 Add to Print Area 

Step 5: Click on “Add to Print Area” to expand the area. 

Page 

Layout Tab Print Area

Set Print Area

Clear Print Area

Add Print Area

 
Figure 0.46: Add Print Area 

 

4.16.2 View Print Area 
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Follow these steps to view all print areas.  

Step 1: Go to the “Workbook views” section under the “View” tab. 

Step 2: Click on “Normal” to view all the print areas as shown in Figure 4.47. 

View Tab
Print Area

 

Figure 4.47: View Print Area 

4.17        Page Break 

Page break option is used to divide the worksheet into separate pages. It is used to divide 

worksheet into certain number of pages for printing purpose. 

4.17.1 Insert Page Break 

Step 1: Select the desired worksheet for print. 

Step 2: Select the last row of the desired data to insert the page break. 

Or  

Step 3: Select the desired column to insert the page break on its right side. 

Step 4: Go to “Page Setup” section under the “Page Layout” tab. 

Step 5: A pop down list will appear by clicking on the “Breaks” as shown in Figure 

0.48. It will have two options. 

 Insert Page break 

 Delete Page break 

 

 

Step 6: Select the desired row. 



174 

 

Step 7: Click on the “Insert Page Break”.  

Or  

Step 8: Select the desired column to insert the page break on its right side  

Step 9: Click on the “Insert Page Break. 

Step 10: Right click on your desired coloumn or row will give you the option to insert 

the page break. 

Page 

Layout Tab Page Break

Insert Page Break

Remove Page Break

Reset all Page Break

 

Figure 0.48: Add Page Break 

4.17.2 Page Break Preview 

Step 1: To preview existing page breaks select your desired worksheet.  

Step 2: Go to “Workbook Views” section under the “View Tab”. 

Step 3: Click on the “Page Break View” to view all the print areas and Page breaks as 

shown in Figure 0.49. 
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Preview

 

Figure 0.49: Page Break Preview 

4.17.3 Delete Page Break 

Step 1: Select the desired worksheet to delete any existing page breaks. 

Step 2: Select the last row of the desired data to delete the page break.. 

  Or  

Step 3: Select the desired column to delete the page break on its right side. 

Step 4: Go to “Page Setup” section under the “Page Layout Tab”. 

Step 5: Click on “Breaks from the page setup section to open the drop down list. 

Step 6: This list will have two options in it: 

 Insert Page break 

 Remove Page break 

Step 7: Click on “Remove Page break” option. 

4.18        Workbook Protection 

If you have confidential data in your worksheet it is important to protect and keep it secure. 

By default, all the worksheets in MS Excel are not protected and anyone can open and 

change the data. The feature of protecting a worksheet is available with many options the 

step by step procedure is as follows: 

Step 1: Open the backstage view of your worksheet by clicking on “File” tab. 

Step 2: Under the “info” pane, Click on the “Protect Workbook” option.  

Step 3: From the drop down list Choose the desired option as shown in Figure 0.50. 
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Protect Workbook

Info Pane

 

Figure 0.50: Protect Workbook 

4.18.1 Always Open Read Only 

Read only option help in opening the desired workbook in read only mode so that it will 

not allow any unintentional changes, However it can be shifted to edit mode. but anyone 

can change that easily and shift to edit mode. Follow these steps to save your workbook as 

read only. 

Step 1: Click the “Protect Workbook” button from “Info” pane, as shown in figure 4.52.  

Step 2: Click on “Always open Read Only”. 

Step 3: Save it and open it again. A message box will appear asking the “read only” option. 

Step 4: Click “Yes” and document will be opened in read only mode. 

Step 5: To disable the read only, click on the protect workbook from info panel in file 

menu and select “Always Open Read only” again.  
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4.18.2 Encrypt with Password 

You can also apply password protection to your protection by using the following steps: 

Step 1: Click the “Protect Workbook” button from “Info” pane file menu and select 

“Encrypt with Password”.  

Step 2: “Encrypt document” window will pop with the only field for the password in 

it. Enter the password and click “OK” as shown in Figure 0.51. 

After finishing encryption you will need to enter the password every time when you open 

this workbook. 

Pssword

 

Figure 0.51: Encrypt with Password 

4.18.3 Protect Current Sheet 

Cells of you worksheet can also be locked by applying password on it. Password will 

prevent others from removing the worksheet and help preventing others from making 

changes. It will also restrict the file movement and its deletion by unauthorized user. There 

are two different ways to. Implement the command:  

 Using Review Tab 

 Using File Tab 

4.18.3.1 Using Review Tab 

Protect your current worksheet by following these steps. 

Step 1: Go to the “Protect” section under the “Review” tab. 

Step 2: Click “Protect Sheet”. Protect sheet window will appear. 
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Step 3: Select all the element to allow all users to make changes in it. 

Step 4: Enter the password of your choice in “Password to unprotect sheet” field 

optionally as shown in Figure 0.52 

Step 5: Click “OK”.  

Step 6: In the “Confirm Password dialog box” re-enter password for confirmation. 

Step 7: Click “OK”. 

Password

Condition

 
Figure 0.52: Protect Current Sheet using  File Tab 

4.18.3.2 Using File Tab 

To protect your current worksheet follow these steps. 

Step 1: Select the “Protect Workbook” button from “Info” pane file menu and this 

time select “Protect Current Sheet” as shown in Figure 0.50.  

Step 2: Protect sheet window will appear. 

Step 3: Select all the element to allow editing by users. 

Step 4: Enter the password of your choice in “Password to unprotect sheet” field 

optionally.  

Step 5: Click “OK”.  

Step 6: In the “Confirm Password dialog box” enter your password one more time. 

Step 7: Click “OK”. 
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4.18.4 Protect Workbook Structure 

Workbook structure can also be made secure following two different ways:  

 Using Review Tab 

 Using File Tab 

4.18.4.1 Using Review Tab 

Follow these steps to protect workbook structure. 

Step 1: Go to “Protect” section under the “Review Tab”. 

Step 2: Click “Protect workbook”. 

Step 3: A window will pop up with the name of “Protect Structure and Windows” as 

shown in Figure 4.55. 

Step 4: Select the element for protection. You can enter a password in “Password” 

field optionally 

Step 5: Click “OK”. 

Review Tab Protect Workbook

 
Figure 0.53: Protect Workbook Structure using Review Tab 
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4.18.4.2 Using File Tab 

Follow these steps to protect your workbook structure using file tab. 

Step 1: Click the “Protect Workbook” button from “Info” pane file menu and this time 

select “Protect Workbook Structure” as shown in Figure 0.50.  

Step 2: A window will appear with the name of “Protect Structure and Windows” as 

shown in Figure 0.53. 

Step 3: Select the desired element for protection. 

Step 4: You can enter a password in “Password” field optionally 

Step 5: Click “OK”. 

4.18.5 Restrict Access 

Follow these steps to restrict the limited access to your workbook.  

Step 1: Go to protect workbook from info panel in file menu and this time select 

Restricted Access to open a dropdown list as shown in Figure 0.50. 

Step 2: Select “Restricted Access” from the dropdown list. “Permission” window will 

open as shown in Figure 4.56. 

Step 3: Select the checkbox of “Restrict Permission to This Document”. 

Step 4: Enter the email address to give special access of this workbook. 

Step 5: Click “OK” to apply. 

Restricted Access 

Checkbox

Enter Email Address

 
Figure 0.54: Restricted Access 
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4.18.6 Add a Digital Signature 

Follow these steps for digital signature application in your workbook. 

Step 1: Click the “Protect Workbook” button from “Info” pane file menu and select 

add a digital signature as shown in Figure 0.50.  

Step 2: A “Sign” window will appear as shown in Figure 0.55.  

Step 3: Select “Commitment” type from dropdown list. 

Purpose of Signing

 

Figure 0.55: Insert Digital Signature 

4.18.7 Mark as Final 

Last option in workbook protection list is marking it as final as shown in Figure 0.50.  

Step 1: Select the “Protect Workbook” from “Info Panel” in “File” menu  

Step 2:  Click on “Mark as final”. Marking the workbook as final will discourage to 

edit this file.  

Step 3: A pop-up message appear as a confirmation sign as shown in Figure 0.56.  

Step 4: Click “OK”. 
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Figure 0.56: Message Box 

Step 5: Another message will pop up as shown in Figure 4.57.  

"This document has been marked as final to indicate that editing is complete and that this 

is the final version of the document. When a document is marked as final, the status 

property is set to 'Final' and typing, editing commands, and proofing marks are turned off. 

You can recognize that a document is marked as final when the Mark as Final icon displays 

in the status bar." 

Step 6:  Click “OK”. 

 

Figure 4.57: Mark as Final 

Whenever someone will try to edit this document this message will reappear to remind the 

document protection. 

Click “OK”. 

4.19         Freeze Panes 

In case of large amount of data the cells may not be visible on one screen. User has to scroll 

up and down or left and right. It may hide the headings which can be made visible by using 

freeze panes. It is used to work on the contents from different parts of your workbook in 

one view. You can apply freeze pan  options on rows as well as columns. 

4.19.1 Freeze Row 

Lets suppose you are working on a large file and you wanted to move up and down in the 

data but you want certain rows for example the header row to be seen all the time in your 
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worksheet. Your problem will be solved by using the Freeze Row option, you can scroll 

through your content by continuously viewing that frozen row. Follow these steps to freeze 

the desired row. 

Step 1: Select the row for example header row below which you wanted to apply a 

freeze pane option.  

Step 2: Go to “Window” section under “View Tab”. 

Step 3: under the drop down list of “Freeze Panes” choose “Freeze Panes” as shown 

in Figure 0.58. gray line will appear under the frozen row. You can scroll up 

and down having header row in view all the times. 

View Tab Print Area

Freeze Panes

Freeze Top 

Row

Freeze First 

Column

Gray Line

 

Figure 0.58: Freeze Row 

4.19.2 Freeze Column 

Freeze column is used to implement the same option for a certain number of columns. 

Follow these steps to freeze the desired column. 
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Step 1: Choose the desired column. 

Step 2: Go to “Window” section under “View” tab. 

Step 3: under the drop-down list of “Freeze Panes” choose “Freeze Panes”.  

Step 4: Grey line will indicate when the column will get frozen 

4.19.3 Unfreeze Pane 

If you want modification in frozen Row or column selection. You can reset your worksheet 

by using unfreeze panes. Follow these steps to unfreeze frozen rows or column. 

Step 1: Go to “Window” section under “View” tab. 

Step 2: Choose the “Unfreeze Panes” from the drop-down list by a Click on “Freeze 

Panes”.  

Step 3: Spreadsheet will get reset. 

4.20         File Properties 

Document properties are known as metadata of the document. Document properties consist 

of all detailed information, for example the title of your document, name of the author, the 

subject of your document and the keyword that is used to classify your document. These 

properties help to organize your document. There are four types of properties: 

 Standard properties 

 Automatically updated properties 

 Custom properties 

 Document library Properties 

4.24.1 Standard Properties 

Standard properties are the default properties of your document, where author name and 

document title are included. You can edit these properties as per your requirement. You 

can also add keyword to help you search your document later. 

4.24.2 Automatically Updated Properties 

These properties are the system properties that include size of the file, date of creation and 

statistical information like numbers of words. These properties helps to search a file with 

its creation date. 
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4.24.3 Custom Properties 

You can customize additional properties of your Excel document by assigning a text or 

numeric value to your document properties. Follow these steps to create and view custom 

properties. 

Step 1: Go to the “File Tab” and Click on the “Info” panel. 

Step 2: Select the “workbook properties”. A properties dialog box will appear. Select 

the  “Advanced Properties” as shown in Figure 04.59. 

Step 3: Click on the “Custom” tab 

Step 4: You can customize your own property or select from the existing ones. You 

can also type name for the custom property, or select the name from the list 

with the help of  name box. 

Step 5: In the type list select the data type. 

Step 6: Click “Ok” 

Advance 

Properties

 
Figure 04.59: Customize File Properties 
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4.24.4 Document Library Properties 

Document library is a collection of information like categories, description about a 

document. 

You can edit and update these document properties through info panel in file tab. All the 

required document library properties will be outlined with red border. 

4.24.5 Advance Properties 

Advance properties are the advanced options in the document properties section used to 

modify the layouts formatting and performance of the document. Follow these steps to 

modify the advance properties of your document.  

Step 1: Click on the “Show all Properties” or “Show fewer Properties” link at the 

bottom of the page to show more or less properties. 

Step 2: By clicking on the arrow next to the properties name you will get the see the 

option for advance properties. as shown in Figure 0.60.  

Step 3: You can edit or update all the properties, statistics at once. 

Info Pane

Properties

 

Figure 0.60: Advanced File Properties 
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Self-Assessment Questions 

1. What are top or bottom rules of a cell? 

2. How many different types of conditional formatting options are available in MS 

Excel? Explain with the help of examples. 

3. What is meant by cell style? What are its uses? 

4. What is a cell border and what are its different types? Explain with the help of a 

diagram. 

5. What is format painter? What are its uses in MS excel? 

6. What are different past types available in MS Excel? Explain with the help of an 

example? 

7. What is meant by Theme in MS Excel? What different types of themes are available? 

8. How to switch or remove a theme from a documents. Write step by step procedure. 

9. What is text wrapping? What are its different types? 

10. What is the difference between text wrapping and merge cell in MS Excel? Explain 

with the help of an example. 

11. What is the importance of print area in a worksheet? If a text is out of print area, how 

can you fix this problem? 

12. What is page break and why it is used? 

13. What is meant by workbook protection? How many options are available to protect 

a workbook? 

14. What is freeze pan? Also explain the difference between freeze rows and  freeze 

columns with the help of an example? 

Self-Assessment Activities 

1. Create a template file in MS Excel. Demonstrate 10% rule on selected cells. Also 

practice 3-color scale by applying 50 percentile at midpoint. 

2. Create a new cell style by providing following values and apply on any document. 

a. Name: My new style 

b. Style include: Number, Alignment and Font 

3. Demonstrate the use of cell style by adding and changing different options. 

4. Demonstrate the use of paste special with the help of an example. 



188 

 

5. Create a worksheet with sample data. Apply retrospect theme and change different 

colors for practice. 

6. Let’s suppose you have horizontal set of cells in MS Excel and you want to past the 

horizontal set of cells into vertical set of cells. How would you perform this activity? 

7. Create a table in MS Excel and practice the following options: 

a. Border: full border 

b. Font: 12 Time roman 

c. Theme: Berlin 

d. Theme Color: Orange Red 

e. Theme Effects: Glossy 

8. Write a step by step procedure to add a new word into dictionary. 

9. Write a step by step procedure to add and clear the print area from a document. 

10. Create a MS Excel file and add following properties in it. 

a. Title: New file 

b. Subject: Computer Science 

c. Author: your name 

Hyperlink: www.aiou.edu.pk/CS 

http://www.aiou.edu.pk/CS
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5. WORKING WITH FORMULAS AND FUNCTIONS IN 

SPREADSHEET 

 

5.1 Introduction 

Spreadsheet is meant to perform calculations these calculations can be implementing 

different types of mathematical constructs. This unit covers the use of formulas, functions 

and equations using MS Excel. 

 

5.2 Objectives 

After completing this unit, you will be able to: 

 Apply formula for basic mathematical operations 

 Use available important functions. 

 Learn cell and absolute reference 
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5.3 Formulas 

Formula is a mathematical expression which is used to perform calculations. Standard 

mathematical operators are used to apply the formulas, for example plus sign is used for 

the addition operation, minus sign - is used for the subtraction related formulas, an asterisk 

sign * is used for multiplication and a forward slash is used for division. 

 
Figure 0.1: Operator Precedence 

MS Excel follows the default operator precedence to perform the calculations as shown in 

Figure 50.2. 

Result

Formula Bar

 
Figure 50.2: Operator Precedence in Excel Formula 
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In case of parentheses in the formula. The part of formula with parenthese will be calculated 

first because of its highest precedence. In case of having multiplication and division in the 

formula that part will be solve right after parentheses and next turn will be of Addition and 

subtraction on the remainder of the formula as shown in Figure 0.3. 

Formula Bar

Result

 
Figure 0.3: Precedence with Parentheses 

5.3.1 Enter a Formula 

Follow these steps to enter a formula in MS Excel file: 

Step 1: Select the desired cell. 

Step 2: Type an equal = sign before starting with any formula. Equal sign will pass the 

signal to Excel informing that a formula is about to be entered for the selected 

cell. 

Step 3: After equal sign start typing down the formula For example the formula 

=C1+C2. You can also select the cell C1 and C2 instead of typing it down, by 

using mouse drag.  

You can also add or remove the cells in a formula. MS Excel will recalculate the estimation 

of those cells automatically.  

5.3.2 Edit a Formula 

On clicking at the desired cell MS Excel show the detailed formula value in the formula 

bar. To edit the formula, follow these steps: 
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Step 1: Click and select the desired cell.  

Step 2: Go to formula bar and click to edit as shown in Figure 0.4. 

Step 3: Make changes and press enter formula will be updated. 

Edit Formula

 

Figure 0.4: Edit Formula 

5.3.3 Copy/Paste Formula 

You can copy and paste the formula from one cell to other. To copy and paste formula in 

MS Excel follow these steps. 

Step 1: Right click on formula bar for the desired cell and copy the formula by 

selecting the “Copy” from the list. Or use shortcut “CTRL+C".  

Step 2: Once you have copied your formula you can paste it to new desired cell by 

using the Paste from “Paste Options”  or  “CTRL+V” as shown in Figure 0.5. 
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Copy Formula Paste Here

 

Figure 0.5: Copy/Paste Formula 

OR 

Step 1: In every right bottom corner of desired selected cell you will see a small square 

shape called the fill handle as shown in Figure 5.. Instead of copy and paste again and again 

you can drag the formula to the adjacent cells with the help of fill handle. It will give you 

same result as shown in Figure 5.. if you have to perform one calculation for multiple times, 

it is much easier then copy paste and it is less time taking.  
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Fill Handle

Drag to fill

Result

 
Figure 5.6: Drag and Fill 

5.3.4 Formula for Addition 

Additon is one of the basic arithmetic operations, Generally to add one number to another 

plus (+) sign is used. MS Excel works with same method also. Addition can be perform 

using multiple methods in MS Excel including the following. 

  Adding numbers in Excel Sheet 

 Adding cells in Excel sheet 

You can perform addition operation using SUM function which will be discussed later in 

this unit. 
 

5.3.4.1 Adding numbers in cell 

For Addition operation follow these steps: 

Step 1: Select the desired cell to display the final result Type equal sign (=). 

Step 2: After the equal sign start with your first number followed by requied operator 

for example plus sign (+) and then type the second number as shown in Figure 5.7. 
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Step 3: Press “Enter” to complete the formula. The selected cell will show the final 

result. 

Adding 

Numbers

Result

 
Figure 5.6: Adding Numbers in Excel Sheet 

5.3.4.2 Adding cells in Excel sheet 

You can also add the cell contents by using the (+) opterator. For the cells addition, follow 

these steps: 

Step 1: Select the destination cell to display the final result. 

Step 2: Start your formula with the equal sign (=). 

Step 3: Enter the cell number to which another cell number is going to be added. 

Step 4: Type a (+) plus sign. 

Step 5: Enter the other cell number to be added. 

Step 6: Press “Enter” to complete the formula. 

The selected cell will show the final result as shown in Figure 5.7. 

Adding Cells

Result

 
Figure 5.7: Adding Cells in Excel Sheet 
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Similarly we can perform other basic arithmetic operations using multiple methods in MS 

Excel. 

Data Region 

Selection Result
 

Figure 0.8: Selected Data Region 

5.4 Function 

Function is a predefined formula to perform desired calculations in a perticular order. There 

are many functions available in MS Excel. Some of the important functions among them 

are: 

 Sum 

 Count  

 Minimum and maximum value 

 Average  

 

5.4.1 Syntex of a Function 

Basic syntax for a function is divided into three parts. 

 Equals sign (=) 

 Function name  

 Arguments.  

For example: the syntax of addition function for adding the cell range from A1:A20 is 

 shown below in Figure 0.9. 
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Figure 0.9: Function Syntax 

Here SUM is the name of function and argument is the cell range that is written in 

parenthesis. 

5.4.2 How to insert a Function 

In order to insert the function in MS-Excel, Follow the steps below: 

Step 1: Click on a desired cell to insert a function. 

Step 2: Select the “Insert Function” button. 'Insert Function'. A dialog box will appear. 

Step 3: Select the predefined functions from the category. 

Step 4: Click “OK”. A dialog box will appear to add the arguments of functions. 

Step 5: Select the desired cell range from the cell range box. 

Step 6: Type the condition in the criteria box if any. 

Step 7: Click “OK” once again. 

Step 8: The selected cell will display the final result as shown in Figure 5.10. 
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Function Button

Selected Cell

Selected

Function

Click OK

Click OK

Function Condition

Function Range

Result
 

Figure 5.10: Insert a Function 
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5.4.3 Types of Functions 

There are different types of Functions available in MS Excel. Some of the important 

functions are described below. 

5.4.3.1 AutoSum 

AutoSum is used to add a range of column or rows in the spreadsheet. Follow theses steps 

to use Autosum function for the desired cell range: 

Step 1: Place the cursor where you want result. 

Step 2: Go to “Editing” section under the “Home Tab”. Select the arrow next to 

AutoSum button to get the drop down list of common functions. 

Step 3: Select the AutoSum as shown in Figure 0.11. 

Home Tab

Editing Section

Auto Sum

 
Figure 0.11: Auto Sum Using Home Tab 

Step 4: Press “Enter” to complete the action. The selected cell will display the final 

result of SUM. 

Another way to access the AutoSum command is with the help of Formula” tab from the 

ribbons as shown in Figure 0.12. 

Home TabAuto Sum Sum

 
Figure 0.12: Auto Sum Using Formula Tab 
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If you want to add multiple cells at different locations, you can add by giving cell reference, 

separated by comma(,) as shown in Figure 0.13. 

Formula Bar

 
Figure 0.13: Multiple Argument 

5.4.3.2 Average Function 

Average is the central value which can be calculated in MS Excel by using Average 

Function.    

The steps to calculate the average are as follows: 

Step 1: Select the desired cell to display the final result for Average function. 

Step 2: Go to “Editing” section under the “Home Tab”. Select the arrow next to 

AutoSum button to get the drop down list of common functions. 

Step 3: Choose the average function and enter the cell range as desired. 

Step 4: For example, AVERAGE (C1:C9) is going to calculate the average of cell 

range from C1:C9.  

Step 5: Press “Enter” to complete the formula. The selected cell will display the final 

result of average as shown in Figure 0.14. 
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Home Tab

Editing Section

Auto Sum

Average

Selected Cell 

for Average 

Result  

Figure 0.14: Average Function 

5.4.3.3 Average If 

Average if is used to calculate Average of cells based on some criteria/condition as shown 

in Figure 0.15. 

Formula Bar

Result

 

Figure 0.15: AverageIf Function 

5.4.3.4 Min Function 

Min Function is used to find out the smallest value from the desired cell range. Its sytax is 

as follows: 

MIN (Number 1, Number2) 

Min function will ignore the blank cells automatically. Follow these steps to findout the 

smallest value. 
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Step 1: Select the desired cell to display the final result for Min Function. 

Step 2: Go to “Editing” section under the “Home Tab” and select the arrow next to 

AutoSum button to get the drop down list of common functions. 

Step 3: Choose the Min function and enter the cell range as desired. 

Step 4: Press “Enter” to complete the formula. The selected cell will display the 

minimum value as shown in Figure 0.16.  

Home Tab

Editing Section

Auto Sum
Formula Bar

Result

 

Figure 0.16: Min Function 

5.4.3.5 Max Function 

Similarly you can use the Max Function to find out the maximum value as shown in Figure 

0.17.  

Home Tab

Editing Section

Auto Sum
Formula Bar

Result

 

Figure 0.17: Max Function 

5.4.3.6 Count Function 

In MS Excel The COUNT function is used to count the number of enteries in a cell range. 

Its syntax is as follows: 

COUNT (value1, [value2]) 
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Value1 –  Cell range or the Cell value. 

Value2 - [optional] Cell range or the Cell value. 

Let us perform it step by step: 

Step 1: Select the desired cell to display the final result for Count Function. 

Step 2: Go to “Editing” section under the “Home Tab”. Select the arrow next to 

AutoSum button to get the drop down list of common functions. 

Step 3: Choose the Count function and enter the cell range as desired. 

Step 4: Press “Enter” to complete the formula. The selected cell will display the final 

result of count Function as shown in Figure 0.18. 

Editing Section

Auto Sum

Home Tab

Result

 
Figure 0.18: Count Function 

5.4.3.7 IF Function 

If Function is used to perform the logical comparison between a set of values. Its syntax is 

as follows:  

IF ( Logical test, value if true, value if false) 

Let us see with an example of if function that will check wheather a condition met or not. 

it will return one value if true and another value if false. 

Step 1: Select the desired cell i.e. D3 as shown in Figure 5.20 to display the final result 

for IF Function. 

Step 2: Start with the equal sign (=). 

Step 3: Write down the Function syntax starting with IF and open the parenthesis.  
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Step 4: Insert the logical condition/test in parenthesis i.e C3>=2000 as shown in 

Figure 5.25. 

Step 5: Type comma (,) sign and insert the value you wants to show when the 

condition is true. Always enclose the Text in double quotation marks (e.g. 

“High”). 

Step 6: Type comma (,) sign. and insert the value you wants to show when the 

condition is false. 

Step 7: Close the parenthesis and press “Enter”. The selected cell will display the final 

result for IF Function. 

Formula Bar

Result
 

Figure 0.19: IF Function 

5.4.3.8 Nested Funtions 

Nested functions uses another functions as and argument.  

To write Nested function follow these steps. For example, we can use SUM function as an 

argument inside an IF function. 

Step 1: Select the desired cell to display the final result. 

Step 2: Start your function with the equal sign (=). 

Step 3: Enter the nested function by adding new function inside the argument box of 

the main function as shown in Error! Reference source not found.. 

Step 4: Add arguments for nested function and press “Enter” to complete the formula. 
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Formula Bar

Result

 
Figure 0.20: Nested Funtions 

5.4.4 Multiple Conditions 

In more deeper analysis, you need to apply multiple true and false conditions, which can 

be implemented by using multiple conditions in MS-Excel. The AND, OR and NOT 

operator are used to implement the multiple conditions. 

 AND : It is used when multiple conditions are tested to be true. 

 OR : It is used when only one condition may be true. 

 NOT: It is used where you need to test your condition is not meeting the criteria. 

Let us see with an example of if function using multiple conditions as shown in Figure 5.21 

below: 

Step 1: Select the desired cell to display the final result. 

Step 2: Start your function with the equal sign (=). 

Step 3: Write down the Function syntax starting with IF with the Multiple conditions 

i.e. using AND Operator as shown in Figure 5.21. 

Step 4: Press “Enter” to complete the formula. The selected cell will display the final 

result of Multiple condition Function. 

Easiest way to make a proper function with multiple condition is to write down the 

conditions section first and then merge it with the IF Function. 
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Formula Bar

Result
 

Figure 5.21: Multiple Conditions 

5.5 Formatting Text and Numbers 

Excel has the special ability to apply the special formatting to numbers and texts. You can 

change the appearance of time, date, decimals, percentages, currency any many more by 

using these formatting options. Some of these formatting options are given below. 

General 

General is the default numbering format. 

Number 

numbers with decimal places used this format. 

Currency 

This format is used to place the currency symbol with the desired numbers.  

Accounting 

Accounting format is used to align decimal places and currency places within the column. 

This format makes it easier to read long lists of currency figures. 
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Short Date 

Short Date formats numbers as M/D/YYYY. For example, August 14, 2020, show 

as 8/14/2025. 

Long Date 

In this type of formats numbers are shown as Weekday, Month DD, YYYY. As Monday, 

March 23, 2025. 

Time 

In this type of formats numbers are shown as HH/MM/SS and with AM or PM. As 9:27:00 

AM. 

Percentage 

In this type of formats numbers are shown with the decimal places and the percent sign. 

as 75.00%. 

Fraction 

In this type of formats numbers are shown in form of fraction with the help of the forward 

slash. as 1/6.  

Follow the steps below to modify the numbering format of cells: 

Step 1: Select the desired cells to modify with new number format. 

Step 2: Go to “Number” under “Home tab”. 

Step 3: Select the desired formatting option from the drop down menu next to the 

“Number Format” as shown in Figure 5.22. Formatting will be changed as per 

selection. 
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Home Tab
Number Format 

Dropdown

 
Figure 5.22: Number Formatting 

Similary you can apply other formatting options given below to your desired cell.  

5.6 Worksheet Auditing 

When you are working with complex worksheet, relationship between cells and formulas 

are difficult to understand. To determine these relationships between cells and formulas 

auditing tool is used. Auditing feature uses series of arrows to show which cell belongs to 

which formula. On using auditing tools arrow tracer point out the cells that are providing 

data for that formula. 

Formula auditing is used for. 

 Error Cause Location 

Sometimes errors appear in one cell is caused by an error in another cell. The formula 

auditing help you locate that cell. 
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▪ Worksheet Information Understanding 

In a complex worksheet sometime, it is difficult to understand that this information is 

coming from which cell. The formula auditing tool help you understand how different cells 

are relating to each other according to formula. 

Follow these steps to trace the worksheet relationships as shown in Figure 5.23. 

Step 1: Go to “Formula Tab”  

Step 2: Click on “Formula Auditing”  section 

Step 3: Use any of the following options 

 Click on the “Show Formulas” to display all formulas used in desired worksheet. 

 Click on the “Trace Precedents” to find out cells providing data to your formula. 

 Click on the “Trace Dependents” to find out which formula is dependent to cells. 

 Click on the “Error checking”.  to Select “Trace Error” to locate the exact problem. 

 Click on the “Remove Arrows”. to Select any of the following as per requirement. 

1: Remove Precedent Arrows 

2: Remove Dependent Arrows 

3: Remove All Arrows  

Step 4: Click “OK” 
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Formula Tab
Show Formula

Trace Precedents
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Remove Arrows

Trace Dependants

 

Figure 5.23: Worksheet Auditing 
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5.7 Autofill 

Autofill is the feature to help you fill the data in desired cells automatically.  

Follow these steps to use the autofill feature of MS Excel. 

Step 1: Start with the new spreadsheet. 

Step 2: Add the desired data into it. 

Step 3: Select the desired cell to Autofill. 

Step 4: Hover the cursor in the bottom right of the cell it will turn into a solid black 

cross which is called the fill handle. 

Step 5: Drag down till the desired range to autofill.  

Step 6: Let suppose if you write January month name in one cell you can autofill 

another months name by clicking on fill handle and dragging it down. Excel 

will fill the series of months automatically. If you will exceed the number of 

cells needed. Data will be repeated after that.  

Step 7: You can drag the cursor back to erase the filled data. 

Step 8: Autofill example is shown in Figure 5.24. 

Drag and Fill

 

Figure 5.24: Autofill Using Drag Method 

Step 9: Double clicking the fill handle will copy the data of the first cell to all the 

selected cells as shown in Figure 5.25. 
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Double Click on 

fill handle

 
Figure 5.25: Autofill Using Fill Handle 

Step 10: Click on “Smart Tag” and select “Fill Formatting Only” as shown in Figure 

5.26. 

Fill Formatting only

 

Figure 5.26: Fill Formatting only 
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Step 11: Click the “Smart Tag” and select “Fill Series” to fill the numbers in a 

series The numbers will then be in numeric order as shown in Figure 5.27. 

Fill Series

 

Figure 5.27: Fill Series 

Self-Assessment Questions 

1. What are the different types of mathematical operators used in MS Excel formula 

elaborate their precedence? 

2. What are the different categories of formulas used in MS Excel? explain them with 

the help of an example. 

3. What are the statistical formulas? How to apply a statistical formula in your 

worksheet? 

4. What “count number” formula does in worksheet? Explain with the help of an 

example? 

5. What is the role of “Min” and “Max” formula in MS Excel? Explain your answer 

with an example? 

6. What is meant by a function? Explain the step by step procedure to insert a function. 

7. Explain the “AVERAGEIF” formula and its parameters? 

8. What is meant by nested function? Explain with the help of an example? 

9. While formatting a table, named the available datatypes? 

10. What is meant by cell reference? What different types of cell reference are available 

in excel? 
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Self-Assessment Activities 

1. Write three numbers (36,79,41) in the excel sheet and apply the Sum formula using 

insert function? 

2. For the above question calculate the average by write average formula in the formula 

bar? 

3. Write a formula to calculate the multiplication of both column and show results in 

next column? 

 

4. Write a formula to divide the column 1 with column 2 and show results in next 

column? 

 

5. Apply the Round Up and Round Down formula to the following data? 

 

6. Calculate the total marks obtained for the data table given below? 
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7. Calculate the percentage of the marks for the above data table? 

8. Calculate the CGPA as per grading plan for the above data table?  

9. Populate the comments as given in the grading plane image for the data table given 

above? 

10. How to set the currency datatype for some data in excel sheet along with $ symbol 

for the currency? 

Calculate the difference between two dates using MS Excel formula? 
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6. ADVANCE FEATURES IN SPREADSHEETS 

 

 Introduction 

 

This unit covers the advance features in spreadsheets. Advance features are very  helpful 

to automate even large amount of data. Some of the advance features in spreadsheets are 

importing and exporting files, Pivot tables and advance filters. 

 

 Objectives 

 

After complete study of this unit, you will be able to: 

 Import and Export data in Excel 

 Insert and Remove Hyperlinks 

 Insert, Sort and Filter Pivot tables 

 Apply Advanced Filters 
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 Working with Data 

MS Excel workbooks are intended to store tons of data. It provides you with best features 

to help with your data.  

4.3.1 Importing Data From File 

Importing is one of the feature where you can open a file that is different in the format and 

reside in some other application. The “Text Format” is one of the importing option 

supported by Excel. 

Text file is a digital file that contains sequences of electronic text. It can be opened in MS-

Excel. There are two major types of Text Files i.e. Delimited Text File and comma 

separated value text file. 

 Dilimited Text Files (.txt) 

In this type of text file, Tab character separate each field of text. 

 Comma Separated Value Text Files (.csv) 

In this type of text file, comma separate each field of text. 

Apart from these two types, you can change the separator character used in your text file 

making sure if it will work the way you want while importing or exporting your text file. 

4.3.2 Import Using Open Command in Excel 

Using this method in MS Excel you can open a text file as an Excel workbook by using 

open command. This method will not change the format of your file. Let us see the step by 

step procedure. 

Step 1: Select “Open” command under “File” tab. A browse window will appear. 

Step 2: “Browse” the location of your desired file you wanted to open in MS Excel. 

Step 3: Locate the file and “Ddouble Click” to open. 

Step 4: If file extension is .csv, MS Excel will open the file and display the data in 

new workbook.  

Step 5: In case of .txt file, double click on the text file will open th “Text Import 

Wizard”. 

Text import wizard help you import the data from text files into a worksheet. It examines 

the imported file and ensure that the data is imported as required. In this wizard you will 

have to follow three steps to complete the process. 
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Text Import Wizard Step 1:  

1. Choose the file type between “Delimited” and “Fixed Width” that best describe 

your data. 

2. To secify the start of your data type the row number. 

3. Choose the “Character Set” used in your txt file to describe your File origin. 

4. Your file will be previewed in the box display. as shown in Figure 6.1  

5. Click Next to move to Step 2. 

 

Delimited

Fixed Width

Character 

Set

Starting Row

File 

Preview

Click Next

 

Figure 6.1: Text Import Wizard Step 1 

Text Import Wizard Step 2: 

File type selections can be either “Fixed width” or “Delimited” datatype. Depending on 

your file type selection, step 2 will be further divided into two separates steps.  

Delimited Datatype  

If you have selected Delimited file type, follow these steps. 

1. Choose the “Delimiters” you can type the new character if the character is not 

listed. You can treat consecutive delimiter as one by using the check box.  

2. Select the “Text Qualifier” to enclose some values of your text file.  

3. Review your text in “Data Preview” box. As shown in Figure 6.2. 

4. Click “Next” to move to Step 3. 
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Delimiters

Data

Preview

Click Next

 
Figure 6.2: Text Import Wizard Step 2 (Delimited Datatype) 

Fixed width Datatype 

If you have selected Fixed width data type, follow these steps. 

1. Set the filed width using Data preview.  

2. Click on the “Preview” To insert the column break as shown in Figure 6.3. 

3. Click “Next” to move to Step 3. 

Data

Preview

Click Next

Break Line

 
Figure 6.3: Text Import Wizard Step 2 (Fixed Width Datatype) 
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Text Import Wizard Step 3: 

1. To specify type of decimal and thousands of separators used in your text file click 

on the “Advanced”. On import, separators will match that specified for your 

location under “Regional Setting” in Control Panel. 

2. Select the “Column Data Format”  

3. Select the date format if you have selected the data format as “Date” 

4. Click on the column from preview to skip any column from importing.. 

5. Select “Do not Import Column”. 

6. Click “Finish” to complete the import operation once you are done with all 3 steps. 

As shown in Figure 6.4. 

 

Finish

Data Preview

Column 

Data Format

Column 

Skip

 

Figure 6.4: Text Import Wizard Step 3 

4.3.3 Import Using “Get & Transform Data” Section   

Data from text file can be retrieved in MS-Excel using text import wizard. Follow these 

steps to start with Text import wizard. 

Step 1: Go to the “ Get and Transform” section under “Data” tab in your worksheet. 

Step 2: Click From Text/CSV. “Import Data”, a dialog box will open. 

Step 3: “Locate” and “Click” on the text file you wanted to import in Excel as shown in 

Figure 6.5. 
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Import from File

Data Tab

Txt File

File Import

 

Figure 6.5: Import Using Get & Transform Data Section 

Preview dialog box will appear as shown in Figure 6.6.  
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Character Set Delimiter

Load Transform Data
 

Figure 6.6: Preview dialog box 

 

Step 4: You can change “File Origin”, “Delimiter” or “Data Type Detection” as desired. 

Step 5: Move directly to new worksheet by clicking on “Load” or Click on “Transform 

Data” if you want to load the data to “Power Query”  

Step 6: “Power Query Editor” will appear by clicking on “Transform Data”.  

Power Query enables you to import data into MS Excel from Excel workbooks, SQL 

Server, Oracle, IBM DB2, SharePoint and other structured data. 

Step 7: Edit you file in Power Query before opening it in Excel.   

Step 8: Click on the “Close and Load” into MS Excel as shown in Figure 6.7. 
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Close & Load

 

Figure 6.7: Power Query Editor 

4.3.4 Exporting Data 

You can export data from MS Excel by using following two methods. 

 Using Save As command 

 Using Export 

 

6.4.3.1 Using Save As Command 

Export the Excel worksheet by Following these steps. 

Step 1: Access “Backstage view using “File” tab” 

Step 2: Click on “Save as” command in “File” tab as shown in Figure 6.8. 
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Browse

Save As

File Name

 

Figure 6.8: Export using Save As Command 

Step 3: Click on “Browse” under “Save as” command. 

Step 4: Choose the desired format from the “Save as” dialog box, to export the Excel 

worksheet. as shown in Figure 6.9. 

Save As

File Name

 

Figure 6.9: Save As dialog box 

Step 5: Click “OK”. 
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6.4.3.2 Using Export Command 

Export command can be used to export your worksheet as a PDF file by using the following 

steps: 

Step 1: Access the “Backstage view” by clicking on the “File” tab.  

Step 2: Click on the “Export” command in “File” tab. 

Step 3: Select “Create PDF/XPS” as shown in Figure 6.10. 

Export 

File

Create 

PDF/XPS

 

Figure 6.10: Export Using Export Command 

“Save As” options will show up. 

Step 4: Select the desired location to export your file. 

Step 5: Enter the “File Name”. 

Step 6: Click on “Publish” button to complete the Export process as shown in Figure 6.11. 
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File Name

Publish File

File Type

 

Figure 6.11: Publish as PDF or XPS 

Excel will export only the active worksheet by default. If you want multiple worksheets to 

be converted, follow these steps:  

Step 1: Click on “Options” in “Save As” dialog box. 

Step 2: Select the workbook and click “ok” from the “Option” dialog box, as shown in 

Figure 6.12. 
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Entire Workbook

Click OK

 
Figure 6.12: Save Entire Workbook  

Step 3:  Click “OK”. 
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 Converting Text to Columns 

You can move text into multiple columns and cells using “Text to Column Wizard”. It will 

free you from applying copy and paste options multiple times. Follow these steps to convert 

the Text into columns. 

Step 1: Open a New Excel Workbook and start with a new blank worksheet as shown in 

Figure 6.13. 

New Blank 

Workbook

 

Figure 6.13: New Blank Workbook 

Step 2: Add entries to the first column. 

Step 3: Select them all.  

Step 4: Under the “Data tab”,  Go to the “Data Tools” section. 

Step 5: Select “Text to Columns” as shown in Figure 6.14. 

New Data Entries Text to ColumnsData Tab

 

Figure 6.14: Text to Column 
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“Convert Text to columns” dialog box will appear which involve threes steps to convert 

the text into columns. 

Step 6: Select “Delimited” and Click “Next” as shown in Figure 6.15. 

Delimited

Data Preview

Click Next

 
Figure 6.15: Convert Text to Column Step 1 of 3 

Step 7: Clear each box in “Delimiters” section and select “Space” and click “Next” 

Step 8: Click “Finish” to complete the process, as shown in Figure 6.16 . 

Finish

 
Figure 6.16: Convert Text to Column Final Step 
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 Hypertext Links 

Hyperlink is a reference to another location in a worksheet. User can quickly move to this 

location and access data by clicking the hyperlink. Hyperlinks can be created for any of the 

following : 

 An existing file 

 A webpage  

 Place inside a current document 

4.5.1 Hyperlink to an Existing File. 

Follow these steps to create a hyperlink for an existing file. 

Step 1: Select the Cell to create the hyperlink. 

Step 2: Go to the “Links” section under “Insert” tab or by “Right Click” on the cell to place 

the hyperlink. 

Step 3: Click  on “Link” as shown in Figure 6.17. 

LinksInsert Tab

 

Figure 6.17: Hyperlink 

A dialog box appears with the name of “Insert Hyperlink”. 

Step 1: Select “Existing file or Web page” from “Link to” section  on the right side of the 

“Insert Hyperlink” dialog box as shown in Figure 6.18. 

Step 2: Select existing file from “Look in”. 

Step 3: Double click on the file. 

Step 4: Click “OK” as shown in Figure 6.18. 

Hyperlink will appear on the selected cell. Hypertext will be underlined and have a blue 

font color. 
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Click OK

Existing File 

or Web Page Text to display

 

Figure 6.18: Hyperlink to an Existing File 

4.5.2 Hyperlink to a Webpage  

Follow these steps to create a hyperlink to a webpage. 

Step 1: Select the Cell where you wanted to create the hyperlink. 

Step 2: Go to the “Links” section under “Insert” tab or right click on the cell to place the 

hyperlink. 

Step 3: Click on “Link” as shown in Figure 6.19. “Insert Hyperlink”dialog box will appear. 

Step 4: In the right side of the “Insert Hyperlink” dialog box, select “Existing file or Web 

page”and Type the web address in “Address” section. 

Step 5: Click “OK”. 

Hyperlink will appear on the selected cell. The hypertext will be underlined and have a 

blue font color.  
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Click OK

Address

Text to display
Existing File or 

Webpage

 
Figure 6.19: Hyperlink to a Webpage 

4.5.3 Hyperlink Place Inside a Current Document 

Follow these steps to place the hyperlink in your current document. 

Step 1: Select a desired “Cell” to display the hyperlink. 

Step 2: Go to the “Links” section under “Insert” tab or by right clicking on the cell where 

you wanted to place the hyperlink. 

Step 3: Click  on “Link” as shown in Figure 6.20. “Insert Hyperlink”dialog box will appear 

Step 4: Select “Place in this Document” from “Link to” section on right side of the “Insert 

Hyperlink” dialog box. 

Step 5: For Hypertext you wanted to display in the selected cell type in the “Text to 

display”. 

Step 6: Type the cell reference. 

Step 7: Click “OK” to finish the process. 

Hypertext will appear as an underlined and in blue color. 



238 

 

Place in This Document Click OK

Text to Display

Hyperlinked Cell 

Reference

 

Figure 6.20: Hyperlink Place Inside This Document 

4.5.4 Remove Hyperlink 

By a simple “Right Click” on your hypertext. You can easily “Edit”, “Open” or “Remove” 

the hyperlink as shown in Figure 6.21. 
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Remove Hyperlink
Open Hyperlink

Edit Hyperlink

 

Figure 6.21: Edit/Remove Hyperlink 

 Pivot Tables 

Pivot table is a summarized table of an extensive table. It allows data grouping into many 

categories. It can also break down data on the basis of time duration i.e. months and years 

etc.   

4.6.1 Insert Pivot Table 

Suppose we have a worksheet with 160 records and 6 fields i.e. Order Id, Amount, 

Category, Product, and Date and City as shown in Figure 6.22. 
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Dataset Header

 
Figure 6.22: Data Set 

Insert the Pivot table using following steps. 

Step 1: Click on any desired cell from the data. 

Step 2: Go to “Tables” section under “Insert” tab. 

Step 3: Click on “Pivot Table” as shown in Figure 6.23. 

Pivot Table Insert Tab

 
Figure 6.23: Pivot Table Command 
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Step 4: A dialog box will appear with the name of “Create Pivot Table”. Showing the data 

set range in form of “Table Range” field as shown in Figure 6.24. 

New Worksheet

Select Range

Click OK

 

Figure 6.24: Create Pivot Table 

Step 5: Default location for the new Pivot table will always be “ New Worksheet” 

Step 6: Click “OK”. 

Blank Pivot table will be created in the new worksheet, where you can insert the required 

data. 

Let us insert amount in total after each product:  

Step 1: Select the Check box of the field required and drag it down to the required 

locationsi. 

Step 2: Check “Product field” and drag it down to “Rows”. 

Step 3: Check “Amount field” and drag it down to “Values”. 

Step 4: Check “City field” and drag it down to “Filters” as shown in Figure 6.25. 
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Row

City

Amount

 

Figure 6.25: Pivot Table Fields 

Step 5: Result will show in the worksheet area as shown in Figure 6.26. 

Filter

Row Lable

Sum of Value

 

Figure 6.26: Pivot Table Result 

4.6.2 Sort Pivot Table 

Follow these steps to sort pivot table. 
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Step 1: Right click on any cell in Amount column if you wanted to sort it by largest to 

smallest amount. 

Step 2: Click on “Sort” and select “ Sort Largest to Smallest” as shown in Figure 6.27. 

 

Sort
Largest to 

Smallest

 
Figure 6.27: Sort Pivot Table 

 

In our example banana will come on top as shown in Figure 6.28. 

 

Filter

Row Lable

Sum of Value

 
Figure 6.28: Sorted Pivot Table 

 

4.6.3 Filter Pivot Table 

You can add filter to your worksheet by dragging and adding any columns in the filter area. 

For example, we can filter the worksheet on the basis of “City” information by using the 

following steps: 

 

Step 1: Click on the drop down next to Filter in the pivot table as shown in Figure 6.29. 

Step 2: Select desired “City”. 

Step 3: Click “OK”. 
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Filter

Click OK

 

Figure 6.29: Filter in Pivot Table 

Step 4: Result will be as shown in Figure 6.30. 

Filter

Row Lable

Sum of Value

 

Figure 6.30: Filtered Pivot Table 

Step 5: You can always change the summary by clicking on “Value Field Settings” as 

shown in Figure 6.31. 

Step 6: Click “OK”. 
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Value Field Setting

Custom Name

Click Ok

 
Figure 6.31: Value Field Settings 
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4.6.4 Two-Dimensional Pivot Table 

Two-dimensional Pivot table can be created by dragging and dropping field into Rows and 

column. Suppose we want to filter the total amount exported in each city by using two-

dimensional pivot table. Let us do this step by step: 

Step 1: Insert a pivot table using insertion method described earlier in this unit. 

Step 2: Click and drag the “Product” field to Column and “City” to Row Area. 

Step 3: Click and drag the “Amount” to Value area. 

Step 4: Click and drag the “ Category” to Filter area. 

Result are shown in Figure 6.32. 

Filter

Row Lable

Sum of Value

Column Lable

 

Figure 6.32: Two Dimensional Pivot Table 

4.6.5 Pivot Chart 

Pivot table can be transformed into Pivot chart, which is the visual representation of the 

Table. Let us do it step by step: 

Step 1: Click on the desired cell inside Pivot table. 

Step 2: Go to “Charts” section under Insert tab. 

Step 3: Click on “Pivot chart”. The “Insert Chart” dialog box will appear. 

Step 4: Click “OK”  

Chart will appear on your worksheet as shown in Figure 6.33.  

Step 5: You can change the type of the chart by clicking on “Change Chart Type” in design tab. 
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Figure 6.33: Pivot Chart 

 File Security and Protection 

Excel provide you the option to protect your worksheet from unauthorized users. You can 

apply password to your file to prevent users to insert, delete, rename, move, copy, hide or 

unhide worksheets. Follow these steps to protect your workbook. 

Step 1: Go to “Info” pane under File tab. 

Step 2: Choose “Encrypt with Password”. 

 OR 

Step 3: Go to “Protect” section under “Review” tab. 

Step 4: Click on “Protect workbook” as shown in Figure 6.34. 

Protect 

Workbook

 

Figure 6.34: Protect Workbook 
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Step 5: Enter the Password and click “OK”. 

Step 6: Re-enter the password to confirm and click “OK”. 

To undo the password protection. Click on the “Protect Workbook” and enter the password 

again as shown in Figure 6.35. 

Password

Click OK

 
Figure 6.35: Encrypt Document 

 

 Auto Filter 

Auto filter is a feature which is used to display relevant information efficiently. This filter 

works on the basis of a value, format or a criteria. There are three ways to add filter in 

Excel 

 Using Data Tab 

 Using Home Tab 

 Using Shortcut 

 

4.8.1 Using Data Tab 

To add filter in MS Excel, Follow these steps. 

Step 1: Select the data set where you wanted to apply the Filter. 

Step 2: Go to “Sort & Filter” section under “Data” tab. 

Step 3: Click on the Filter Button as shown in Figure 6.36. 
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Data Tab

Filter

 

Figure 6.36: Adding Filter Using Data Tab 

Dropdown arrows will appear in each column header cell showing that filter has been 

added to your data set. 

4.8.2 Using Home Tab 

To add filter in MS Excel, Follow these steps. 

Step 1: Select the data set where you wanted to apply the Filter. 

Step 2: Go to “Editing” section under “Home” tab. 

Step 3: Click on arrow next to “Sort & Filter” . 

Step 4: Select “Filter” from the dropdown menu as shown in Figure 6.37. 

Home Tab

Sort&Filter

Filter

 

Figure 6.37: Adding Filter Using Home Tab 

Dropdown arrows will appear in each column header cell showing that filter has been 

added to your data set. 

4.8.3 Using Filter Shortcut 

To add filter in MS Excel, you can use the filter shortcut  “ CTRL+Shift+L 

Dropdown arrows will appear in each column header cell. 
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4.8.4 Applying Filter in Excel 

When you add the filter in your file the dropdown arrows will appear in the column heading 

which means filter is added to your data set, but it is not really applied so far. To apply the 

Filter on your data, follow these steps. 

Step 1: Click on the drop-down arrow for the column to filter. 

Step 2: Uncheck “Select All” box to deselect all. 

Step 3: Check the boxes you want to display after filter. 

Step 4: Click “OK” as shown in Figure 6.38. 

Drop Down 

Arrow

Select/

Deselect

Click OK

 

Figure 6.38: Applying Filter 

Hovering over that filter arrow will display screen tip showing filters applied as shown in 

Figure 6.39. 
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Filter

 

Figure 6.39: Filter Screen Tip 

 

 Advanced Filter in Excel 

Standard filter provides a variety of options to filter the data. Sometimes, addional 

requirements cannot be handled by standard filter. Here comes the advance filter, which 

retrieve data with more complex criteria. To use the advance filter in Excel you need to 

prepare your data source by entering the criteria on the worksheet. 

4.9.1 Prepare the Data Source 

To get better result of filtering arrange the data set by following these rules. 

Step 1: Add a header row where each column has a unique heading name. 

Step 2: Make sure that there is no blank row in your data set. 

4.9.2 Setup Criteria 

Criteria is basically the condition applied on your worksheet. You can put it anywhere in 

the sheet, but it is more convenient to keep it on top of your data set and should be separated 

from the data set by leaving couple of blank rows in between. Criteria range should have 

same column heading as your data set.  

There are two types of Criteria. 

 AND Criteria 

 OR Criteria 
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4.9.3 AND Criteria 

Criteria List on the same row work with AND Logic, where two conditions should be met 

simultaneously. For example: you want to display sales of fruits in a city of Islamabad as 

given in the worksheet. 

Step 1: Enter the criteria above the data set, separated by few blank rows as shown in 

Figure 6.40. 

Criteria Header

Dataset Header

 

Figure 6.40: Data set for AND Criteria 

Step 2: Click on any cell within the data set. 

Step 3: Go to “Sort & Filter” section under the “Data” tab. 

Step 4: Click on “Advanced” as shown in Figure 6.41. 
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Data Tab

Advanced 

Filter  

Figure 6.41: Advance Filter Command 

Step 5: Select the range in the “Criteria range box” as shown in Figure 6.42 

Step 6: Click “OK”. 

Criteria Range

Click OK

 

Figure 6.42: AND Criteria 

Result will appear by showing changes in data set as shown in Figure 6.43. 
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Filtered Dataset

 

Figure 6.43: Filtered Dataset Using AND Criteria 

4.9.4 OR Criteria 

Criteria List on the different row work with OR Logic, where any one condition should 

met. 

For example: you want to display sales of fruits in Islamabad or vegetables in Multan. 

Step 1: Enter the criteria above the data set separated by few blank rows as shown in Figure 6.44. 
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Dataset Header

 

Figure 6.44: Data set for OR Criteria 

Step 2: Click on any cell within the data set. 

Step 3: Go to “Sort & Filter” section under the “Data” tab. 

Step 4: Click on “Advanced” as shown in Figure 6.41. 

Step 5: Select the range in the “Criteria range box” as shown in Figure 6.45 A1:F3 

Step 6: Click “OK”. 
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Click OK

 

Figure 6.45: OR Criteria 

Result will appear by showing changes in data set by showing Vegetables in Multan or 

Fruits in Islamabad as shown in Figure 6.46. 

Filtered Dataset

 
Figure 6.46: Filtered Dataset Using OR Criteria 
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 Comments 

Comments are the notes that can be inserted into cells of a worksheet. These are helpful 

for cross refrencing and reminders while working on the data. A yellow mark pops up in 

the corner of the cell after adding the comment which you can see by hovering the curson 

over the cell. 

4.10.1 Add a Comment 

Follow these steps to add a comment on a cell. 

Step 1: Select the required cell. 

Step 2: Go to “Comment” section under “Review” tab. 

Step 3: Click on “New Comment” command as shown in Figure 6.47. A “Comment Box” 

will appear. 

Review Tab

New Comment

 

Figure 6.47: Add New Comment 

Step 4: Type your comment in it. 

Step 5: Click on “Post” icon  inside the box to close the comment as shown in Figure 

6.48. 

“Red Triangle” in the top right corner to represent that comment are added to the cell.  
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Figure 6.48: Post New Comment 

Step 6: Select the “Cell” again to view the comment. 

Step 7: To Edit a comment of your cell, Place your cursor over the cell and edit. 

4.10.2 Show/Hide All Comments 

Follow these steps to show/hide a comment to your cell. 

Step 1: Go to “Comment” section under “Review” tab. 

Step 2: Click on “Show Comments”, It will display all the comments inside the worksheet 

as shown in Figure 6.49. 

Step 3: To hide all comments click back again on “Show Comments” in your worksheet. 



259 

 

Show All Comments

Comment 1

Comment 2

 

Figure 6.49: Show/Hide Comment 

 Help 

Excel provides an extensive database of help topics to help the users to overcome any 

difficulty while using the command tools. Let us see the steps of using help.  

Step 1: Go to “Help” section under “Help” tab. 

Step 2: Click on the “Help” Button. Access to Excel’s help resources will open on the right 

side. 

Step 3: Enter the keyword or phrase of the information you are researching. 

Step 4: Press “Enter” key. It will provide you with several related options. 

Step 5: Select anyone that describe the best answer for your search and click as shown in 

Figure 6.50. 

Step 6: Arrow keys can be used to move back and forth. 
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Figure 6.50: Help 
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Self-Assessment Questions 

1: How many types of data can be imported and exported in a worksheet? 

2: What is the concept of “Text to Column”? 

3: What is the Hyperlink? Write all the steps for adding a hyperlink into MS Excel 

worksheet? 

4: What is the Pivot Table? Explain with the help of an example. 

5: What is meant by filtering data in MS Excel? Explain with example. 

6: Write down the step by step procedure to create a pivot table chart. 

7: What kind of data protection is provided by MS Excel? Create a MS Excel data 

sheet with some data stored in it and apply the password? 

8: What are comments in MS Excel and how can you add comment in worksheet? 

Self-Assessment Activities 

1. Write down the step by step procedure to import data from .txt file into excel sheet? 

2. Load the following data into excel sheet? 

Col1|Col2|Col3|Col4 

43.52|25.12|12.69|36.95 

3. Let’s  suppose you have following two lines of data. Convert this data into column 

using MS Excel. 

1 2 3 4 5 6 7 

4. Insert the hyperlink for the following data given in an excel sheet? 

 

5. Edit the hyperlink for the data given in the table above as following: 
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6. Create a worksheet and insert a pivot table in it. 

7. Which method is used to ignore the blank cells. Explain with the help of an 

example? 

8. Apply Filters to display the employees having salary greater than 50,000 but less 

than 80,000. 

 

9. Using the same above table, filter out the person having salary less than 50,000 

and living in Karachi. 

10. Using the above table, filter out the person living in Lahore or Islamabad having 

salary greater or equal to 60,000. 
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7. PRESENTATION BASICS 

 

7.1 Introduction 
 
Presentation are normally used to present the information in forms of slides. These slides 

are commonly used to present the official meetings, teaching, trainings, research viva 

presentation etc. For this purpose, various software companies have introduced their 

presentation software. Microsoft provides Microsoft Power Point Software to make these 

presentation slides in s professional way. Microsoft Power Point is part of Microsoft Office 

Tools. So, when you install Microsoft Office package, Power Point is also installed and 

available to use in your computer. In this Unit you will learn about how to create and 

customize presentations. 

 

7.2 Objectives: 
 
After studying this unit, the learners will be able to: 

 

 Understand basics of presentation.  

 Create Power Point file and add new slides in it.  

 Set slide theme and layout 

 Insert Picture, Shapes, Tables, Charts and other Object in slides 
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7.3 Power Point Application Windows Overview 
 
A Screenshot of different parts of power Point application is show in Figure 7.1.  

 

Sizing & Close Button: This area has three buttons; left button  minimize presentation; 

middle button   changes the size of presentation and right button close   presentation 

and power point application.  

 

Menu and Toolbar: All tools are available here. These tools are grouped in to different 

tabs e.g. File, Home, Insert, View etc.  

 

Quick Access Toolbar: There are few tools which are frequently used. They are available 

in Quick Access Toolbar e.g. save file, print preview, print, undo etc. You can also add 

more tools here by click small down shape arrow icon  at right side of this area. 

 

Slides Thumbnails: Here thumbnails of all slides are available. You can click any 

thumbnail to open that slide. First slide will always have title, sub title and author whole 

presentation. 

 

Current slide/ Presentation windows: This is main area where current slide will be 

available. By clicking here, you can make change in slide. 

 

Notes pane: Here notes can be added again current slide. 

 

Status bar: This will show you current slide and language status 

 

Zoom Control: Here is control of zoom in, zoom out and reset zoom of slide. 
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Figure 7.1: Overview of Power Point Application Widows 

7.4 Create Presentation 
 

There are two ways to create new presentation file: 

1. Create Blank Presentation 

2. Create Template Based Presentation 

 

7.4.1 Create Blank Presentation 

To create presentation file in your computer, follow these steps: 

Step 1: In Microsoft Windows, go to “Start menu” and click “All Programs”. 

Step 2: Scroll to find Power Point program and click to open. 

Step 3: Power Point program will open. Click “New” button. 

Step 4:  Click on “Blank Presentation” Thumbnail to create file as show in Figure 7.2. 

The new presentation file with blank presentation will be created and opened 

to work. 
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Figure 7.2: Blank Presentation Thumbnail 

7.4.2 Create Template Based Presentation 

In power point a template have predefined sample contents, styles, set of colors, and visual 

effects etc. So predefined template will give professional look to your presentation. You 

can also create and customer your own template according to your requirement. There are 

many predefined templates available in Power Point program. These templates are 

categorized in different categories e.g. Educational, Sports, Business etc. To a create 

template-based presentation file, follow these steps: 

 

Step 1: Open “Power Point” program in your computer, as show in Figure 7.3. 

 

Step 2: Click on” New” button from left panel. 

 

Step 3: Click “Presentations”, Different categories of different predefined Power Point 

templates will be displayed e.g. Education, Business, Sports etc as show in 

figure 7.3. 

 

Step 4: Select your required category. This will show you available templates for 

selected category. 
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Step 5: Click on “Thumbnail” of template, and then click “Create” button. New file 

with selected template will be created as shown in Figure 7.4. 

 

 

Figure 7.3: Categories of Predefined Templates 

 

On creation of templated based file, you will see that some predefined slides including text, 

images, diagrams & tables will be opened. These slides are also well formatted and styles 

according to selected template. You can custom these slides and create other slides 

according to your information. 
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Figure 7.4: Presentation File with Template 

7.5 View Tab (Switch Slides View and Modify Theme)  
 
View tab is used to change or modify the display of your presentation. It is further divided 

into different groups and sections. Let us see some frequently used sections. 

 

7.5.1 Presentation Views Section 

The selection option, enables to switch the display mode among different views like normal 

outline etc. You can access different views by clicking “View” tab as shown in Figure 7.5 

 

Figure 7.5: Presentation View Tools 

 

This section provides tools to view slides in five different ways. Let us discuss one by one: 

 

7.5.1.1 Normal View: 

 
Normal view is default edit view of your presentation. When you open or create your 

presentation file to design your presentation, it will be visible as normal view by default. 

In this view you can create, delete, edit the slides or add, remove, modify the contents of 

slide. You can also change the order/location of slides. To access the “Normal view” of 

your presentation, follow these steps: 
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Step 1: Click on “View” tab to access “View tools” as show in Figure 7.5. 

Step 2: In “Presentation Views” section, click on “Normal” View. Now your 

Presentation view will be change into Normal view as shown in Figure 7.6 . 

Step 3: There are also quick tools to change Presentation Views. These are available 

at middle of bottom bar. Move your mouse cursor on icons will show the name 

of tool. Click on “Normal View” icon  there to quickly change the view of 

your presentation as Normal View. 

 

Slides Notes: You can show or hide slide notes with the Notes button . Notes 

button   which is at the bottom of the slide window.  

 

Change Slide Ordering: You can also change the order/ location of slides and reorganize 

them. Follow these steps to create duplication copy of slides: 

 

Step 1: Move your mouse cursor to side bar. 

Step 2: Click and hold the slide thumbnail in sidebar and move the mouse cursor up 

or down to change the location of slide.  

Duplicate Slide: You can create the duplicate copy of slide. Follow these steps to create 

duplicate copy of your existing slide.: 

 

Step 1: Move your mouse cursor to slide side bar, in slide thumbnail view. 

Step 2: Right click on thumbnail view of slide, which you want to create duplicate 

copy. 

Step 3: A dropdown menu will appear there. 

Step 4: Click on “Duplicate Slide”, this will create the duplicate copy of selected slide. 
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Figure 7.6: Normal View of Presentation 

7.5.1.2 Outline View 

 

Outline view is used to create an outline or storyboard of your presentation. It displays the. 

main points of presentation in to left sidebar, focusing on the content of all slides. Using 

this view, you can also quickly overview main points of your slides in an outline form. To 

access the “Outline view” of your presentation, follow these steps: 

 

Step 1: Click on “View” tab to access “View tools” as show in Figure 7.5. 

Step 2: In “Presentation Views” section, click on “Outline View”. 

Step 3: Now your Presentation view will be change as “Outline View”, as show in 

Figure 7.7. 

Step 4: In the sidebar, you can view your slides contents in form an outline.  

Step 5: Click on any line of slide contents and edit the text as required. 
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Figure 7.7: Outline View of Presentation 

 
7.5.1.3 Slide Sorter View 

The main purpose of “Slide Sorter” is to easily reorganize your slides. In this view, all 

slides are displayed into a horizontal sequence. You can easily change the order of slides 

and rearrange them. Simply drag and drop slide to rearrange by drag and drop. To practice 

“Slide Sorter” follow these steps: 

Step 1: Click on “View” tab to access “View tools” as show in Figure 7.8. 

Step 2: In “Presentation Views” section, click on “Slide Sorter” view. This will change 

Presentation view into “Slide Sorter” view and all slides will be shown in thumbnails as 

show in Figure 7.8. Now you can easily drag and drop slide to reorganize them.  

There are also quick tools to change Presentation Views. These are available at the bottom 

of Power Point presentation. Move your mouse cursor on these icons will show the name 

of tool. Click on “Slider Sorter” icon  there to quickly change the view of your 

presentation as “Slider Sorter”. 
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Figure 7.8: Slider Sorter View of Presentation 

 
7.5.1.4 Notes Page View 

 

The notes Page view enables user to record the comments during the presentation. To 

access the “Notes Page” view follow these steps:  

 

Step 1: Click on “View” tab to access “View tools” as show in Figure 7.9. 

 

Step 2: In “Presentation Views” section, click on “Notes Page” view. Now you can 

see in Figure 7.9 that slide is displaying at top and notes of selected slide 

displays at bottom page. In this view, you can make record notes easily.  
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Figure 7.9: Notes View of Presentation 

 

7.5.1.5 Reading View 
 

Reading view is the look and feel view of the presentation. To access “Reading View”, 

follow these steps: 

 

Step 1: Click on “View” tab to access “View tools” as show in Figure 7.10. 

 

Step 2: In “Presentation Views” section, click on “Reading View” button. Now you 

can see in Figure 7.11 that slide is displaying on whole screen of Power Point 

Application windows. 

Step 3:  

 
Figure 7.10: Button for Reading View of presentation 
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There are also quick tools to change the Presentation Views. Move your mouse cursor on 

these icons will show the name of tool.  

 

Step 1: Click on “Reading View” icon  there to quickly change the view of your 

presentation as “Reading View”. 

 

Step 2: To go back into normal view, click on “Normal View” icon  at “Quick view 

tools”. Or click “ESC” key on keyboard to exit reading view. 

 
Figure 7.11: Reading View of Presentation 

 

7.5.2 Slide Master 

 

Slide Master is like a stylesheet of your presentations. When you open Slide Master, an 

overall theme layout for all slides and different slide layouts will be visible in 

left panel. Here if your make changes, it will be applied to all slides. To access 

the functionality of “Slide Master”, follow these steps: 

 

Step 1: Click on “View” tab to access “Slide Masters”. 

 

Step 2: In “Master Views” section, click on “Slide Master” button as show in Figure 

7.12. 



277 

 

 
Figure 7.12: Button for Slide Master 

 

Step 3: The presentation now switches to Slide Master view, and “Slide Master” tab 

will also be visible to the top Ribbon, see Figure 7.13. Thumbnails of different 

slide layouts will appear in left navigation pane.  

 

 

Figure 7.13: Slide Master View and its Layouts 

 

Step 4: Click on top first thumbnail of available layouts (little bigger thumbnail than 

others, contain 1 value). Making change in this top 1st layout will be displayed 

in all slides. Suppose, you added a company logo image, Now if you will 

change the background to green and close Master view. You will see that logo 

and background will be added in all the slides as shown in Figure 7.14. 
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Figure 7.14: Customized the Theme Layout of Slide Master 

 

There are also many other layouts available in Slide Master, these are Title Slide, Title and 

content, Section header and Two contents etc. You can also re-design these layouts. These 

are available in “Home” tab, when click “New Slide” button or “Layout” button. Let us see 

how you can make changes in specific layout:  

 

Step 1: Go to “Slide Master” view using “View” tab. See Figure 7.12. Presentation 

again switches to Slide Master view, and “Slide Master” tab will also be 

visible. 

Step 2: Click on a layout (Title Slide) and re-design this layout by changing the font 

color, size etc. and close the “Master View”. 

Step 3: To practice more options, go to Home tab and click “New Slide” button as 

shown in Figure 7.15. Here all slide layouts are available. Click any layout to 

add new slide using that layout. 

Step 4: If you want to change the layout of existing slide, then select slide using left 

slide thumbnail view panel. Go to Home tab and click on “Layout” and select 

any layout which you want to replace on existing slide. You will see that layout 

of existing be change according to new selected layout. 
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Figure 7.15: Available Layouts for New Slides 

 

7.6 Design Tab (Change Theme and Related Tools) 
 

“Design” Tab contains tools to Change Theme, color scheme, slide size and 

background of specific or all slides, and Designer. 

Let us discuss how to choose theme. 

7.6.1 Choosing a Theme 

 

A theme is collection characteristics including fonts, font colors, background 

colors, table styling, graphic effects (such as shapes styling) and table styling etc. 

For example, applying You can change particular characteristics in all slides 

individually, but this will be time taking. But applying theme will make changes 

quickly in all slides with similarity and give a decent and consistent look to your 

power point presentation. It is better approach to select and apply your theme first 

and then make/ write your slides. Let see how to choose and apply them to your 

presentation: 

 

Step 1: Click on “Design” tab to access Power Point Themes as show in Figure 7.16. 
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Figure 7.16: Design Tab to Select Theme 

 

Step 2: In the theme section, click small arrow  button. Now gallery of all themes 

will be visible as shown in Figure 7.17. 

 

Figure 7.17: Theme Gallery 

 

Step 3: Choose a theme from gallery and click it. This will apply setting of selected 

theme on all slides. 

 

You can also apply theme on some specific slides instead of all slides. To apply theme on 

some specific slides following these steps: 

Step 1: First, select one or multiple slides using left side slides thumbnails.  

Step 2: After selection of slide(s), go to the “Theme” gallery using “Design” tab. 
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Step 3: Right click on a theme which you want to apply on these selected slide(s). A 

menu will be appeared there. 

Step 4: Click on “Apply to Selected Slide(s)”. Now theme will apply only on selected 

slide(s). 

 

7.7 Home Tab (Add Slides, Text Formatting and Aligning) 
 

Home tab is a button which provides many tools and options to prepare and format 

the presentations.  

Let us discuss here some of these tools, which are frequently used in powerpoint 

presentations. 

 

7.7.1 Add New Slide  

 

When you create a new blank presentation, it only contains one blank title slide, 

and you need to add more slides. Follow these steps to add new slides: 

 

Step 1: Go to “Home” tab as show in Figure 7.18. 

Step 2: In “Slides” section tools, click on icon of “New Slide” button. 

Step 3: Click on “New Slide” button. If you want to change the layout then you have 

to follow more steps: 

Step 1: Go to “Home” tab as show in Figure 7.18. 

Step 2: In “Slides section” tools, click on “Text/Caption” of “New Slide” button. All 

available “Layouts” will be visible there. 

Step 3: Click on your required “Layout”. 

Step 4: New slide will be added with your selected layout. Now you can add text in 

this newly created slide to make your presentation. 
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Figure 7.18: New Slide Button & Slide Layouts 

 

7.7.2 Add and Edit Text 

When you add new slide, it contains different placeholders. Which are text containers, 

where text can be added and removed.  

7.7.2.1 Add text in Placeholders 

To add text in placeholders, follow these steps: 

Step 1: Click inside the text placeholder as shown in Figure 7.19. On clicking inside 

placeholder, it will become active and blinking cursor will indicate where to 

enter your desired text. 

Step 2: Now you start typing text using keyboard and text will be entered in selected 

placeholder. 

Step 3: If you want to add text in another place. Just click inside that placeholder and 

start typing. 



283 

 

 

Figure 7.19: Placeholders in Slide 

 

7.7.2.2 Add Text in Text Box 

Text box is a control element for entering non-editable(not frequently changed) text. To 

add text in to textbox, you first need to add new text box by using following steps: 

Step 1: To insert the new “Text Box”, go to “Insert” tab and click “Text Box” button 

 as shown in Figure 7.20.  

 

Figure 7.20: Insert Text Box button 

 

Step 2: After clicking on “Text Box” button, bring you mouse cursor on slide where 

you want to add textbox and click mouse button to draw a textbox. A text box 

will be created. 

Step 3: Click inside the “Text Box”, now cursor started blinking inside the “Text Box” 

as show in Figure 7.21. Now Start typing using keyboard to add text. 
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Step 1:  

Figure 7.21: Text Box Inserted in Slide 

 

7.7.2.3 Add Text inside Shape 

To add text in to shape, you first need to insert new shape if it is not already inserted, follow 

these steps to insert new shape and add text inside it: 

Step 1: Go to “Insert” tab and in “Illustrations section” as click “Shapes” button (see 

Figure 7.22). A dropdown menu will be appeared containing different shapes. 

 

 

Figure 7.22: Insert Shapes 

 

Step 2: Click on desired shape icon, which want to draw in our slide. 

Step 3: Now bring you mouse cursor on slide and click to draw shape. 

Step 4: After successful creation of shape, right click on the created shape in slide. 

Step 5: A dropdown menu will appear, now click “Edit Text” button, as show in 

Figure 7.23.  
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Step 6: The cursor inside the Shape will activated and started blinking. Now start 

typing using keyboard to add text in shape. 

 

Step 2:  

Figure 7.23: Add Text Inside the Shape 

7.7.3 Text Formatting Tools 

 
The Text formatting tools are used to change the look and feel of the text. The formatting 

text tools in powerpoint are almost same as you have learned and practiced in word 365. 

These tools are used to change font style, font size, color and other effects like bold, 

underline etc. A screenshot showing summary of text formatting tools is show in Figure 

7.24. you can practice these by selecting the text and clicking the appropriate button. 

 

 
Figure 7.24: An Overview of Font Section Tools 
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7.7.4 Paragraph Section Tools (Text Aligning, Positioning and Line Spacing) 
 

Paragraph tools are also same as that in Word 365. These tools can be used to change the 

orientation of paragraph and related text. A screenshot is are show in Figure 7.25. 

 

 

Figure 7.25: An Overview of Paragraph Section Tools 

7.7.5 Insert Text Box 
 

Normally text is added on slide in text placeholders available on slide e.g. title, content 

placeholders. Some time you need a text outside a placeholder. For this purpose, “Text 

Box” tool is available. You need to insert “Text Box” and write text inside it. To insert 

“Text Box” follow these steps: 

 

Step 1: Go to “Insert” tab. 

Step 2: In “Text” section click on “Text Box” as show in Figure 7.26. 

 

 

Figure 7.26: Text Box Button 
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Step 3: Now bring mouse cursor position inside slide where you want to add text box 
and click & hold mouse button and drag mouse right to set width of your text 
box. 
 

Step 4: Text box will be created on slide (see Figure 7.27). Now by clicking inside 
the text box, the text cursor will be activated. 
 

Step 5: Add text using keyboard inside the text box (see Figure 7.27). 
 
Note:  

 You can resize the text box whenever you need. Bring the mouse cursor on small circles 
available on border of text box, now click and hold the mouse button and drag any 
direction to resize the text box. 
 

 You can also change the design of your text box e.g. background, border color etc. Click 
on text box and go to “Format” tab. Here different options are available to change the 
border, background colors, styles of text box. 
Step 3:  
 

 

Figure 7.27: Text Box Inserted in a Slide 

 

7.7.6 Create Table 

To create a table on a slide, follow these steps. 

Step 1: Click on slide where you want to create table. 

Step 2: Go to “Insert” tab. 

Step 3: Click “Table” menu. 

Step 4: A dropdown window will appear containing grid of small boxes (see 
Figure 7.28). 
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Step 5: To insert table, drag your mouse on this grid (right and bottom side) to 
select number of column and rows. Preview will also be available 
while dragging you mouse on grid.  

Step 6: Or instead of dragging mouse on grid, you can also click on “Insert 
Table” button (see in Figure 7.28), a window will appear. Write down 
here “Number of columns” and “Number of rows” and press “OK”. 

Step 4:  

Figure 7.28: Create Table Button and Menu Location of Table 
 

Step 7: Table will be created on slide. Click on border on table and drag to change 
location of table. 

Step 8:       Click inside table cells and add text using keyboard as shown in Figure 7.29. 

 

Figure 7.29: Table Created on a Slide 
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You can change the style, size and design of your table by using “Design” and “Layout” 

Tabs. 

 

7.7.7 Insert Shape 
Different shapes i.e. arrows, boxes and circles etc. can be inserted in your slides by using 

insert shape. The steps are as follows: 

 

Step 1: Click the Insert Tab. 

 

Step 2: In “Illustrations” section, click “Shapes” button as shown in Figure 7.30. A 

dropdown window will open contains all available shapes in managed in categories 

(see  Figure 7.30).  

 

Step 3: Click on your required shape and bring mouse cursor (without further clicking) 

inside the slide where you want to add shape. 

 

Step 4: Now click and hold mouse button and drag mouse to insert your desired size shape 

on slide and leave mouse button. Shape will be inserted. 

 

 

Figure 7.30: Shape Button to Add Shape on Slide 
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Add Text Inside a Shape 

You can also add text inside the shape. To add text inside shape, follow these steps:  

Step 1: Click on already inserted shape. 

Step 2: Go to “Format” tab and click “Text Box”  button Figure 7.31.  Or simply 

“Right Click” on shape and click “Edit Text”  button from dropdown 

menu. 

Step 3: Cursor will be started blink inside the shape. Now add text using your 

keyboard. 

Note: You can also use “WordArt Styles” tools in “Format” tab to modify the style and 

design of text added inside the shape. 

 

Figure 7.31: Format Tab Tools to Modify Shape 

7.7.8 Insert Picture 

Pictures are used to make more meaningful presentations. Therefore, they are frequently 

used to prepare slides. Let us practice the steps to insert picture from your computer: 

Step 1: First of all, open the slide, where you want to add picture. 

Step 2: Go to “Insert” Tab. 

Step 3: Click on “Pictures” button as show in Figure 7.32. 

Step 4: A dialog box windows will be appeared to browse and select picture from your 

computer. 

Step 5:  Brow and select your picture and Insert button in dialog box. Now picture will 

be inserted in your slide. 
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Figure 7.32: Insert Picture from Local Source of Computer 

7.7.9 Insert Online Picture or Clip Art 

If desired picture is not available on your computer. PowerPoint provides facility 

to search your picture or clip art from the internet (online source). Follow these to 

insert picture or clip art from online source: 

Step 1: Open the slide, where you want to add picture. 

Step 2: Go to “Insert” Tab and click “Online Pictures” button as show in Figure 

7.33. By clicking “Online Picture” button a dialog box windows will be 

appeared to browse or search online picture. 

Step 3:  Browse picture by categories or enter related text in to search box and 

press enter.  
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Figure 7.33: Search and Insert Picture from Online Sources 

 

Now picture searched from online sources will be displayed. 

 

Step 4: “Filter” button is also available here to filter your images by different attributes of image. 

These are: Size, Type, Layout, Color as show in Figure 7.34. instead of using “All Type” 

you choose Photograph, Clipart, Animated, Transparent and Line Drawing using the 

“Type filter attribute”. Now images can be search according to applied filters. 

 

Step 5: Select the desired image and click the “Insert” button. Picture will be inserted on you 

slide. 
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Figure 7.34: Searched Pictures and Filter Button 

You can resize and change the location of your picture by clicking and dragging it with 

mouse.  

7.7.9.1 “Format” Tab 

When you click the picture a “Format” tab will be appeared on toolbar as shown in Figure 

7.35. You can use these tools to edit or modify the image settings. 

 

Figure 7.35: Format Tab Tools to Modify Picture 

7.7.10 Add Chart 

Charts are very useful to explain the statistical data graphically. You have already learnt 

adding charts (graphs) using MS Excel. You can also add charts into your Powerpoint 

slides. 

7.7.10.1 Create Chart using Power Point 

Follow these steps to create chart in Power Point presentation.  
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Step 1: Click on “Insert” tab. 

Step 2: Go to “Illustrations” section and click “Chart” button as show in Figure 7.36. 

A dialog box window will open dialogue box window to “Insert Chart” 

containing different type of charts in categories e.g. Column Chart, Bar Chart, 

Line Chart, Pie Chart etc as shown in Figure 7.36. 

Step 3: Click on your desired chart and press “OK” button. 

 

Figure 7.36: Chart Button and Popup Window Containing Different Charts 

 

Step 4: Chart will appear in the slide with data in MS Excel. you can enter or edit the 

data as per your requirement. 

 

Your will see that chart graphics will be changed according to added source data in the 

Excel Worksheet.  
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Figure 7.37: Chart on Slide and Embedded Excel Sheet Contain Chart Data 

7.7.10.2 Create Chart in MS Excel 

If you have a complex data source then use MS Excel to create the chart and insert into 

your slide. Here are the steps: 

Step 1: Create a new MS Excel file and enter your data in MS Excel Worksheet. 

Step 2: Create the chart as learned in MS Excel and “Save” the file as shown in 

Figure 7.38: Create Chart using in Excel Worksheet File. 
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Figure 7.38: Create Chart using in Excel Worksheet File 

 

Step 3: “Right” click on chart and select “Copy”. 

Step 4: Now go to your slide in PowerPoint Presentation where you want to add 

chart. 

Step 5: Go to “Home” tab and click “Past” button or simply right click on slide and 

click past to past the chart. 

Step 6: Chart will be added in to PowerPoint slide as shown in Figure 7.39. 

Step 7: If you edit data in MS Excel file, the graph will also be updated in 

PowerPoint. 
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Figure 7.39: Chart Copied in Power Point Slide after Creating in Excel 

You can change the setting of your chart. Just click the chart you will notice the display of 

two tabs i.e. “Design” and “Format” as shown in Figure 7.40 and Figure 7.41 respectively.  

You can use these commands to modify the design and style of your chart. 

 

Figure 7.40: Design Tab Containing Tools to Modify Chart Design 

 

Figure 7.41: Format Tab Containing Tools to Modify Chart Format 

 

7.7.11 Move & Resize Objects on Slide 

You can move or resize the objects inserted into your slides. Let us practically do it: 
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7.7.11.1 Move Object: 

Step 1: Go to slide where object is available and click on the object. Its border will be 

highlighted with small circle dots. 

Step 2: Bring mouse cursor on the object, you will notice a four side direction icon  as 

show in Figure 7.42 

Step 3: Now click and hold mouse button and drag your mouse to move the object. 

Step 4: After moving object at your desired location, leave the mouse. You object will be 

moved to new location. 

 

 

Figure 7.42: Selection of Object and Mouse Cursor Icon to Move the Object 

7.7.11.2   Resize Object: 

Follow these steps to resize object on your slide: 

Step 1: Go to slide where object is available and click on the object. 

Step 2: Object border will be highlighted with small circle dots as shown in Figure 7.43. 

A “Format” or “Layout” tab will be appeared on menu. 

Step 3: Click the “Format” tab / “Layout” tab. 

Here Height and Width tools are available to increase/ decrease the size of object. 
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There is another way to resize the object. Follow these steps to resize the object by using 

second method: 

Step 1: Go to slide where object is available and click the object. 

Step 2: By clicking object, its border will be highlighted with small circle dots. 

Step 3: By moving your mouse cursor on any “circle dot”, a “two direction aero” icon 

will be displayed with mouse. 

Step 4: Now click and hold mouse button and drag to resize the object as per you desired. 

 

 

Figure 7.43: Selection of Object, Height & Width Tools and Mouse Cursor Icon to 

Resize the Object 
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Self-Assessment Questions 
 

1. What is the use of presentations in Office Automation? 

2. What do you mean by template-based presentation file? 

3. What is the concept of layout in PowerPoint? Name any two important layouts?  

4. What is the use of Slide Sorter and Notes Page view? 

5. What is Slide Master, why we use Slide Master? Write down the procedure to add 

company logo which should appear in all slides. 

6. Write down the procedure to insert picture in a slide.  

7. Why do we use charts in PowerPoint presentations? 

8. Write down the steps to move an object outside a presentation. 

9. Write down the steps to resize an object of a slide. 

10. List down the tools available in Font section. 

 

Self-Assessment Activities 
 

1.  Start a new Presentation file and select “Slice” theme. 

2. Insert new slide with “Title & Content” layout and add some text in “Title” and “Title & 

Content” slides. 

3. Using the Slide Master add the company logo, which should be displayed in all slides. 

4. Add some text in “Title & Content” layout and change the formatting of text: 

 Text color: Blue 

 Text Size: 24 

 Text alignment: Justified 

 Add number with each new line. 

 Line spacing 1.5. 

 

5. Add a table in your slide with 3 columns and 4 rows and using “Design” tab. Also change 

the table style as “Light Style 2, Accent 2”. 

6. Insert a shape, add some text into it, and using “Design’ Tab change the shape Style as 

“Colored Fill, Dark Green, Accent 2” 

7. Add a picture in your slide and resize it by using picture tools. 
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8. ASSEMBLING AND PRESENTATING SLIDES SHOW 

 

 Introduction 

PowerPoint provides facility to add animation effects, slide transitions and insert media 

clips or photo albums. This unit focused on preparing PowerPoint presentations and apply 

special effects on the slides. 

 Objectives: 

After studying this unit, the learners will be able to: 

 Insert & delete and Reorganize slides 

 Add animation and apply transition effects. 

 Insert media clips and photo album into the slides. 

 Use different printing options. 
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 Insert Slide 

You have already learned the slide insertion in unit 7. Let us re-cap with a new method of 

slide insertion. 

Step 1: In the left panel where slide thumbnails are available, click with your mouse 

in between two slides where you want to insert a slide. 

Step 2: Go to “Home” tab and here click on text of “New Slide” button. A dropdown 

menu will appear containing different slide layouts  

Step 3: Click on your desired layout e.g. Title slide, Title & Content or anyone else as 

shown in Figure 8.1.  

Step 4: Now new slide according to selected layout will be inserted. 

Alternate way: There is another way to insert new slide. But this will insert new slide with 

default “Title & Content” layout.  Right click between two slides. A dropdown menu will 

be appeared. Now click button “New Slide” button.  

Short key: You can also use short key to insert new slide with default “Title & Content” 

layout. Click between two slides thumbnails and using keyboard press “Ctrl+M” buttons. 

New slide will be inserted. 

 
Figure 8.1: Insert New Slide 

Home tab
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two slides 
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New Slide 

button
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Slides 

Layouts
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 Delete Slide 

To delete single slide or multiple slides from your presentation follow these steps: 

Step 1: To select single slide, just right click on slide thumbnail from left panel. If you 

want to select multiple slides to be deleted then press and hold “Ctrl” key from 

keyboard, and in the slide thumbnails from left panel, click one by one on 

slides thumbnails.  

Step 2: After selection of slides, now release the “Ctrl” key and right-click the 

selection. 

Step 3: A dropdown menu will be appeared and here click on “Delete Slide”, as shown 

in Figure 8.2.  

Step 4: All selected slides will be deleted. 

Another way: After selection of the slides from left panel, press “Delete” key from 

keyboard to delete slides.  

 

 
Figure 8.2: Delete Slides 

 Duplicate Slide 

You can also make duplicate copy of the slides to save your time. Here are the steps involve 

in slide duplication: 

Selected 

Slides from 

left panel

Delete Slide 

option

Right click on 

selected slide
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8.5.1 Duplicate using Menu bar 

Step 1: To select single slide, just right click on slide thumbnail from left panel. If you 

want to select multiple slides then press and hold “Ctrl” key from keyboard, 

and in the left panel, click one by one on slides thumbnails to select multiple 

slides.  

Step 2: Go to “Home” tab and click on text of “New Slide” button. A dropdown menu 

will be appeared. 

Step 3: Here click “Duplicate Selected Slides” option as shown in Figure 8.3. 

Step 4: Now duplicate copy of slide(s) will be created.  

 

Figure 8.3: Duplicate Slides using Menu Bar 

8.5.2 Duplicate using Right click 

Step 1: To select single slide, just right click on slide thumbnail from left panel. If you 

want to select multiple slides then press and hold “Ctrl” key from keyboard, 

and in the left panel, click one by one on slides thumbnails to select multiple 

slides as shown in Figure 8.4.  

Step 2: After selection of slides, now release the “Ctrl” key, right-click the selection. 

Home tab

Selected 

Slides from 

left panel

New Slide 

button

Duplicate 

Selected 

Slides button
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Step 3: A dropdown menu will be appeared and here click on “Duplicate Slide”.  

Step 4: By clicking “Duplicate Slide”, a duplicate copy of slide(s) will be created.  

 

Figure 8.4: Duplicate Slides using Right Click 

8.5.3 Duplicate using keyboard 

After selection of the slide(s) from left panel, press “Ctrl+D” keys from keyboard to 

duplicate the selected slide(s) using the shortcut key.  

 Reorganize Slides  

Reorganizing slides mean re-arranging them by dividing into sections. It helps to organize 

the large number of slides in your presentation. 

8.6.1 Add Slide Sections 

To create sections in your presentations, follow these steps: 

Step 1: In slides “Normal View”, Select the slide from left thumbnail panel, where 

you want  to create a section. 

Step 2: Go to Home tab and click the “Section” button in menu bar. 

Step 3: A dropdown menu will appear, now click the “Add Section” button. 

 

 

Selected 

Slides from 

left panel Duplicate 

Selected 

Slides button
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Figure 8.5: Add Section Button 

Step 4: Popup menu will appear to name title of the Section as shown in Figure 8.6. 

Enter “Section name” and press “Rename” button. 

 

Figure 8.6: Popup Menu to Rename Section 

Step 5: You can see the section with the given name as shown in Figure 8.7. 
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Figure 8.7: Section Created between Slides 

8.6.2 Remove Section 

 You can also remove the section, when required using following steps: 

Step 1: In normal Presentation view, go to left panel in slides thumbnail view and click 

on “Section Title”.  

Step 2: Go to Home tab and click the “Section” button in menu bar. 

Step 3: A dropdown menu will appear containing option “Remove Section” and 

“Remove all Section” as shown in Figure 8.8. 

Step 4: Now click “Remove Section” to remove selected section. If you want to 

remove all section from your presentations then click “Remove All Sections”. 

Note that your slides will be safe, only the sections will be removed. 

 

 

Section in 

slides
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Figure 8.8: Remove Section Menu 

8.6.3 Reorder Slides 

If you want to re-arrange or reorder the slides, PowerPoint provides an efficient way. You 

can use “Slide Sorter View” to display the slides in horizontal sequences and change their 

order. Let us do it practically: 

Step 1: Click on “View” tab to access “View tools” as show in Figure 8.9 Error! 

Reference source not found.. 

Step 2: In “Presentation Views” section, click on “Slide Sorter” view. 

Step 3: This will change Presentation view into “Slide Sorter” view and all slides and 

sections will be shown in thumbnails as show in Figure 8.9. 

Step 4: Now you can easily drag and drop slides by using mouse button.  
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Figure 8.9: Slider Sorter View to Reorganize Slides 

 Slide Transitions 

Transition is a special effect which occurs during presentation (while moving from one 

slide to other). Slide transition effects are divided into three categories: 

1. Subtle: Basic type of transitions. 

2. Exciting: Complex animations. 

3. Dynamic Content: Movr only placeholders. 

To apply transition effect on slide, follow these steps: 

Step 1: Click on a slide, where you want to apply transition effect. 

Step 2: Click on “Transitions” tab, all slide transitions will be visible, as shown in 

Figure 8.10. 

Step 3: Now click on a transition which you want to apply on a slide. This will apply 

transition effect on current selected slide. 

Slides

View tabSlider Sorter

Sections
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Figure 8.10: Slide Transitions 

The transition menu contains many settings. Settings regarding slide transition (see Figure 

8.11). You can add sound, set transition duration and automatically change the slides. You 

can also apply a transition effect on the slides by using the command “Apply to all slides”, 

as shown in Figure 8.11.  

Transitions tab
Sounds

Transition 

Duration
Apply to all 

slides
Auto slide 

change time

Change on 

Mouse click

 
Figure 8.11: Transition tools 
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 Animation Effects 

Animation is also a special effect which is applied to a particular object (text, picture or 

image). Let us do it practically: 

Step 1: Select the desired object (text, image). 

Step 2: Click on “Animations” tab. Animation menu will be appeared as show in 

figure: 8.12. 

Step 3: Now click on an animation as required and see the effect.  

Step 4: You can also apply multiple animations on different text, image or shape in a 

single slide. 

 
Figure 8.12: Animation menu 

Animation TabAnimation effects
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The animation menu contain many settings regarding the object movement in animation 

tools. You can see the movement by using the commands as shown in Figure 8.13. 

Animation Tab Animation Tools

 
Figure 8.13: Animation Tools 

 Insert Media Objects 

Power Point supports to add multimedia files that can be played during the slide show. The 

media tool consist of commands to add audio, video and screen recording features. 

8.9.1 Add Audio or Video Clip: 

Follow these steps to add audio or video file in your slides: 

Step 1: First of all, select a slide where you want to add media clips. 

Step 2: Click on “Insert” tab and go to Medio Tools as show in figure: 8.14. 

Step 3: Select Audio or Video options. 

If you are adding video, then there will be two options to, select clip from your computer 

or from online source. If you are selecting Audio, then there will be two options again, 

select from your computer or record your fresh audio. 

Step 4: Select one option in step#4 and add your clip.  

Recommended Supported video formats by Microsoft: In newer versions, Microsoft 

recommend to use .mp4 files encoded with H.264 video (a.k.a. MPEG-4 AVC) and AAC 

audio. 

8.9.2 Screen Recording:  

Screen recording allows to record your computer screen. You can also select any specified 

area of your screen and record audio to explain the concept displayed on the current screen. 
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Step 1: First of all, select a slide where you want to add recorded clips of screen 

recording. 

Step 2: Click on “Insert” tab and go to Media Tools as show in figure: 8.14. 

Step 3: In Media tools select Screen Recording button.  

Step 4: Tools will be appeared for screen recording. Select area of your desired portion 

of the screen. 

Step 5: Now Start Recording by using screen recording tools or press Windows 

Key+Shift+R and keep on recording until required. 

Step 6: Press Windows key+Shift+Q to stop your recording.  

Step 7: Your recorded clip will be inserted in the slide, and will be visible to you. 

Step 8: You can resize the clip and also change location of clip on slide by using mouse 

drag and drop. 

 
Figure 8.14: Media Tools (Audio, Video, Screen Recording) 

After inserting the media clip you can change the settings by using “Play Back Tools” as 

shown in Figure 8.15. Select your recorded clip and “plug and play” with different options 

and see their effects. 

 
Figure 8.15: Playback Tools for Setting of Inserted Clips 

 

Insert Tab Video Audio
Screen 

Recording
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 Create a Photo Album Presentation 

Photo album is used to add personal or business photos in the presentation. You can 

download photo album template from online source (office.com) or create your own photo 

album. 

To create photo album, follow these steps: 

Step 1: Go to Insert tab and click the arrow under Photo Album and then click new 

Album as shown in Figure 8.16. 

 

Figure 8.16: Photo Album Button 

Step 2: In Photo album dialog box, click on “File/Disk” under “Insert Picture from” 

label as shown in figure: 8.17. 

Step 3: Select photos from your computer and click “Insert” button. 

Step 4: Set the sequence by moving or down your selected images and click “Create” 

button. Photo album will be created and all photos will be spread on slide one 

by one in sequence. 

 

 

Insert Tab

Photo Album
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Create Album

Inser File from Disk Selected images

Move up and 

down buttons

Figure 8.17: Photo Album Dialog Box 

 Print Options 

In PowerPoint, you can print your slides, your speaker notes, and also create handouts for 

the audience. Let us do it practically: 

Step 1: Go to “File” tab and click “Print” button or use the keyboard shortcut “Ctrl + 

P” keys. A dialog box containing print setting will be displayed.  

Step 2: Give following options to customize your printing: 

Copies: Select number of copies you want to print. 

Slides: From the drop-down, choose “Print all slides”, “Selected slides”, or “The current 

slide” as shown in Figure 8.18. 

Print Layout: Choose the layout (slides per page). 

Collated: Choose whether you want the sheets collated or uncollated. 

Color: Choose color (grayscale, or pure black and white). 
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Step 3: After all settings, now click on “Print” to send print command. Printing will 

be started. 

 

Figure 8.18: Print Menu Settings 
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Self-Assessment Questions 

 

1. What is the difference between PPT and PPTX? 

2. How can you apply a font effect on all slides? 

3. Write down the procedure of changing the order of slides? 

4. Differentiate between linking and embedding. 

5. What is the best way to design the layout for your slides? Explain. 

6. Which shortcut keys are available to customize your slides. 

7. What is meant by shuffling of slides? 

8. How can you apply animation to all slides? Elaborate. 

9. Write down the procedure of adding table in a slide? 

10. What is meant by template? How can you use it in Powerpoint. 

11. Explain the concept of layout in Powerpoint? 
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Self-Assessment Activities 

Prepare a presentation on the topic of your interest and perform the following actions. 

1. Insert new slides by using standard method learned. 

2. User graphics and images to format you slides 

3. Input data into tables. 

4. Apply transition and animation effects. 

5. Create a photo album and insert into your slides. 

Use screen recording feature to explain the content. 
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9. URDU WRITING USING OFFICE AUTOMATION TOOLS 

 

 Urdu Language Support using Unicode & Inpage 

Computer manipulate numbers. They convert all symbols and characters into special 

numeric  form using the character encoding systems. The initial encoding schemes like 

ASCII and EBSDIC were not capable to store the characters of all international and 

regional languages. As a result a new coding scheme Unicode was introduced. It consists 

of set of codes for character encoding of different languages using the Urdu. The character 

code of Unicode are based on different standards like UTF-8, UTF-16 and UTF-32 to 

accommodate millions of characters. It can easily be invoked in windows and other 

operating systems for use in office automation tools. In this unit you will learn, how to 

invoke Urdu language support in office tools using the Unicode. Before Unicode there were 

another software used for urdu composing. This software tool was InPage. We have also 

included basics of InPage for Urdu composing. 

 Objectives: 

After studying this unit, the learners will be able to: 

 Install/enable Unicode Urdu Language support in computer 

 Install & enable Urdu and Phonetic Keyboard 

 Type Urdu in MS Word using Unicode 

 Type Urdu using Inpage Appliation.  
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 Urdu Language using Unicode 

In this section you will learn how to install Unicode Urdu Language package, Install Urdu 

Phonetic Keyboard, Enable Language switching button in task bar, Installation of Urdu 

fonts and Writing of Urdu in MS Word. 

9.3.1 Installation of Urdu Language support 

To enable Urdu language support in Microsoft Windows, follow these steps: 

Step 1: In task bar of windows go to “search bar” and type “control panel”. 

Step 2: In “Control Panel”, find “Regions” and click to open it, as shown in Figure 9.1. 

 
Figure 0.1 Regions Settings Window in Control Panel 

Step 3: Now click on “Language Preferences” in formats tab as shown in Figure 9.2. 

Language Preferences

 
Figure 0.2 Language Preferences in Regions Settings 

Type in search “Regions”Region Settings
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Step 4: Another Settings windows will be open. Click on “Language” menu. 

Step 5: Now click “Add Preferred Language”. 

Step 6: A new window will be opened containing all available languages. Here type 

“Urdu” to search Urdu language, “Urdu Pakistan” language will be found as 

shown in Figure 9.3.  

Step 7: Click “Next” and “Install” button. 

Step 8: It will take some time and “Urdu Pakistan” ( ارود پاکستان) will be installed. Now 

computer is fully supported to use and type Urdu language. 

 

Figure 0.3 Add Language Preferred Window 

9.3.2 Switching Language (Switching Input Method) 

To enable “Switching Language” bar, follow these steps: 

Step 1: Follow the same steps of section 9.3.1 to reach the installed language.  

Step 2: At bottom of installed language click on “Choose an input method to use as 

default”, as shown in Figure 9.4. 

Type & search “Urdu”Language Bar Select “Urdu Pakistan” Language
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Figure 0.4 Choose an Input Method 

 

Step 3: New windows will be opened. Here click and enable the Option “Use the 

desktop language bar when it’s available”. 

This will show a button in task bar to switch the multiple installed languages. By clicking 

on it, all installed/available languages will popup. Click on your desired language to open 

it. 

Enable Keyboard Hot Keys for Language Switching: 

You can also add keyboard hot keys to switch between the languages. To enable hot keys, 

click on “Input language hot keys” and set your keys, as shown in Figure 9.5. 

Select “Urdu Pakistan” Language
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Figure 0.5 Advanced Keyboard Settings 

9.3.3 Install Phonetic Keyboard: 

If you want to install “Urdu Phonetic Keyboard” instead of Windows default Urdu 

Keyboard, follow these steps 

Step 1: Open Browser and open www.google.com (search engine). 

Step 2: In google search bar type “install Unicode phonetic keyboard windows 10” 

and search. 

Step 3: Now download “Unicode Phonetic Keyboard exe file” and click it to install. 

Step 4: After installing Phonetic Keyboard, go to “Language Preference”. 

Step 5: Click “Urdu Pakistan Language” (اردوپاکستان), an “Option” button will be 

displayed. Click on this “Option” button, as shown in Figure 9.6. 

 

Enable: 

Language bar on Task Manager

Enable: Keyboard Hot Keys 

http://www.google.com/
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Figure 0.6 Urdu Language in Preferred Languages 

Step 6: Here you will see that Phonetic Urdu keyboard is added. But if it is not shown 

then click on “Add Keyboard” button as shown in Figure 9.7 to add newly 

installed “Phonetic Keyboard”. After adding “Phonetic Keyboard”, You 

should remove “Urdu Keyboard” which is added as Windows Default 

Keyboard. 

Step 7: To remove “Urdu” Windows default keyboard press, click on “Urdu 

keyboard” and press “Remove” button. 

Step 8: Now keyboard for Urdu Language will be set as “Phonetic keyboard” to type 

Urdu language. 

 

Option ButtonUrdu Language
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Figure 0.7 Add Keyboard in Language Options 

9.3.4 Add of Urdu Fonts in Windows 

You can also add different Urdu fonts in your computer by using the following steps. 

Step 1: Open the Google search engine. 

Step 2: In google search bar type “Download Urdu Unicode fonts” or add desired font 

name and click on search. 

Step 3: You will find many websites where Urdu fonts will be available. Click and 

open an appropriate website from search results. A single font or Zip pack of 

Urdu Unicode will be available on website, which you can download. 

Step 4: Click “Download” button. 

Step 5: If this is zip package of fonts, then extract that folder and open the folder, as 

shown in Figure 9.8. 

Add Keyboard button
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Figure 0.8 Downloaded Urdu Fonts 

Step 6: Go to Control Panel and search “Fonts”, as shown in Figure 9.9. 

 

Figure 0.9 Fonts Settings in Control Panel 

Step 7: New window will be open containing already installed fonts. 

Step 8:  Now copy the “Fonts files” from extracted folder. Past them in Fonts window. 

New fonts will be added into your Windows, as shown in Figure 9.19. 

Step 9: Now you can use these font during Urdu writing in MS Word and other tools. 
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Figure 0.10 Available Fonts Windows and Settings in Computer 

9.3.5 Urdu Typing in Office Tools   

Once you istalled the Urdu language package, keyboard and Urdu fonts, then you can type 

the Urdu language in Office tools of windows i.e. MS Word and Powerpoint etc. Let us see 

the steps by step procedure: 

Step 1: Enable “Multi Language switching button” it will be available in task bar 

(bottom right of desktop) as shown in Figure 9.11. Click on this button to select Urdu 

language.  

 
Figure 0.11 Input Language Switch Button Task Bar 

Language Bar Urdu Pakistan Language
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Step 2:   Open MS Word tool. 

Step 3: Go to “Home” tab and change “Text Direction” from “Right to Left”, as shown 

in Figure 9.12.  

Step 4: Select you desired font e.g. Jameel Noori Nastaleeq. 

Step 5: Start typing as shown in Figure 9.12.  

Other composing setting will be same as your already learn MS Word in previous Units. 

 
Figure 0.12 Urdu typing Settings in MS Word 

  Urdu Writing using Inpage Application 

Before the introduction of Unicode, the Urdu typing was mostly carried out using a special 

tool called the InPage. It is a page layout and word processing tool, developed in 1994. It 

gained popularity for creating documents using the Nastaleeq font. It consists of vast 

library of ligature with more then 28,000 options. In this section we will give an overview 

of using InPage. Please download and install it on your computer from Google search 

engine. Let us see some basic use of Inpage.  

9.4.1 Creating New Document  

To create new document, follow these steps: 

Step 1: Go to “File” menu and click “New” as shown in Figure: 9.13 

Fonts

Urdu Writing in MS Word

Fonts Size Text Direction (Right to Left)
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Fonts New

 
Figure 0.13 Create New File 

Step 2: A popup window will be opened with page setting options as show in figure: 

9.14. Make your settings for the page. 

Page Size Margin OK button

Cancel 

button
Page 

Orientation

Number of page
 

Figure 0.14 Document Page Settings 

Step 3: Click “OK” and start typing in Urdu. 

9.4.2 Create New Page 

To insert new page in your current document, follow these steps: 

Step 1: Go to Insert menu and click “Page” button as show in figure 9.15. 

Step 2: A window will be opened. Enter number of required pages. 

Step 3: Click “OK". 
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Insert menu

Number of page

Page button

 
Figure 0.15 Insert New Page 

Step 4: In order to switch in between the pages the buttons will be available at the 

bottom right corner of the application as shown in Figure 9.16. click on the buttons and see 

their effects. 

Current page status

Next Page buttonBack Page button
 

Figure 0.16 Page Next/Back Button and Current Page Status 

9.4.3 Save File 

Here are the steps: 

Step 1:  Go to “File” menu. 

Step 2:  Click “Save” button. 

Step 3: Type file name and click “Save” button. 

Keyboard Key: Pres Ctrl+S key to save file. 

9.4.4 Change Keyboard 

Different Keyboards preferences e.g. Monotype, Aftab, Muqtadra and phonetic are 

available in InPage. They can be used to change the orientation and style of characters 

typing. Let us see practically: 

Step 1: Go to “Edit” mene and click the “Preferences”, inside the preferences click 

“Keyboard Preferences” as show in figure 9.17. 
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Edit Menu

Keyboard 

Preferences

Preferences

 
Figure 0.17 Keyboard Preferences 

Step 2: Select your desired keyboard from the available list as shown in Figure 9.18. 

Step 3: Click “OK”. 

Step 4: Start typig your text. 

 
Figure 0.18 List of available Keyboard in Keyboard Preferences 
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9.4.5 Alignment and Formatting Menu 

Inpage provide alignment and formatting menu for text, as shown in Figure 9.19. Select 

the desired text and apply the change as required.  

 
Figure 0.19 Text Formatting Tools 

9.4.6 Formatting Document/ Page 

To change the document formatting follow these steps: 

Step 1: Go to “Format” menu and click “Document” option as show in figure 9.29. A 

menu containing document/ page setting will be open. 

 

Alignment Line height

Line space Fonts Urdu

Fonts English Font Size

Line over TextText Selected
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Figure 0.20 Format the document/ Page. 

 

Step 2: Make your desired setting e.g. page size, page margins etc  

Step 3: Click “OK” button. 

 

 

Figure 0.21 Document/ Page Setting 
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9.4.7 Insert Picture  

To insert picture in your documents, follow these steps: 

Step 1: Move your cursor where you want to insert picture. 

Step 2: Go to “Insert” menu and click “Picture” button as shown in Figure 9.22. 

Step 3: Browse picture from your computer. 

Step 4: Click “Open” to select the picture. 

 

Figure 0.22 Insert Picture Button 

9.4.8 Making Table 

To create table, follow these steps: 

Step 1: Move your cursor where you want to create table. 

Step 2: Go to “Insert” menu and click “Table” button as shown in Figure: 9.23. 

Step 3: Set number of columns and rows. 

Step 4: Click “OK” to insert the table. 
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Figure 0.23 Create Table button 

9.4.9 Print Document 

Here are the steps required to print the document: 

Step 1: Go to “File” menu and press “Print” button or using keyboard press “Ctrl+P” 

keys. A menu will be opened containing printing setting. 

Step 2: Set printing options as shown in Figure 9.24. 

Step 3: Click “OK” to print the pages.

 
Figure 0.24 Print Menu 
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Self-Assessment Questions 

1. Explain the basic concept of Unicode. 

2. What is meant by the UTF. How many standards of UTF are available? 

3. What are the characteristics of Unicode Text File (UTF)? 

4. Explain the differnces between UTF-8, UTF-16 and UTF-32. (Search the internet to 

find the answer). 

5. What is the use of language packages? 

6. Discuss the purpose of phonetic keyboard while installing a language package. 

7. List down some important Urdu fonts with brief description. 

8. Explain the importance and usage of InPage application software. 

Self-Assessment Activities 

1. Install Unicode on your computer. 

2. Enable phonetic keyboard. 

3. Take any page of Urdu newspaper and prepare the same in MS-Word application. 

4. Install inpage application and prepare a urdu document. 

5. Practice urdu typing with different settings and options using MS-Word and Inpage. 



341 

 

10- References 

1. Abbbott Katz. "Beginning Microsoft Excel 2010", Springer Science and Business 

Media LLC, 2010 

2. http://www.apexnet.com.ar/downloads/EAUserGuide6.1.pdf 

3. http://www.tutorialspoint.com/powerpoint/pdf/powerpoint_broadcast_slide_show.p

df 

4. https://epdf.tips/mcse-windows-server-2003-environment-management-and-

maintenance-study-guide-70-284cad9036927f8e63e98462bcb2ebd0c47521.html 

5. http://www.softmaker.net/down/pm2018manual_en.pdf 

6. http://docslide.net/education/mos-2010-study-guide-for-microsoft-word-excel-

power-point-and-outlook.html 

7. ttps://support.microsoft.com/en-gb/office/paste-special-e03db6c7-8295-4529-957d-

16ac8a778719?ad=gb&rs=en-gb&ui=en-us 

8. https://support.microsoft.com/en-us/office/apply-or-remove-highlighting-

1747d808-6db7-4d49-86ac-1f0c3cc87e2e 

9. https://epdf.pub/microsoft-office-2010-all-in-one-for-dummies.html 

10. Guy Hart-Davis. "Beginning Microsoft Office 2010", Springer Science and Business 

Media LLC, 2010 

11. https://mafiadoc.com/thinkfree-user-guide-40-en-

0729_59c641a01723dd830e59ff37.html 

12. https://manualzz.com/doc/29466648/1-introduction-to-computer 

13. https://epdf.tips/mcse-windows-server-2003-environment-management-and-

maintenance-study-guide-70-284cad9036927f8e63e98462bcb2ebd0c47521.html 

14. http://www.tutorialspoint.com/powerpoint/pdf/powerpoint_broadcast_slide_show.p

df 

15. http://www.riftvalleyuniversity.net/Distance/EResources/Modules/Common/Introd

uctiion%20to%20Computer%20Applications1.doc 

16. http://www.riftvalleyuniversity.net/Distance/EResources/Modules/Common/Introd

uctiion%20to%20Computer%20Applications1.doc 

17. https://www.coursehero.com/file/46531013/Mail-Merge-Tutorialpdf/ 

18. Ty Anderson, Guy Hart-Davis. "Beginning Microsoft Word 2010", Springer Science 

and Business Media LLC, 2010 

19. https://docplayer.net/3437770-Kingsoft-spreadsheet-2012.html 

20. https://forwardthinking.pcmag.com/how-to/how-to-protect-your-microsoft-word-

documents 

http://link.springer.com/10.1007/978-1-4302-2956-8
http://link.springer.com/10.1007/978-1-4302-2956-8
http://www.apexnet.com.ar/downloads/EAUserGuide6.1.pdf
http://www.tutorialspoint.com/powerpoint/pdf/powerpoint_broadcast_slide_show.pdf
http://www.tutorialspoint.com/powerpoint/pdf/powerpoint_broadcast_slide_show.pdf
https://epdf.tips/mcse-windows-server-2003-environment-management-and-maintenance-study-guide-70-284cad9036927f8e63e98462bcb2ebd0c47521.html
https://epdf.tips/mcse-windows-server-2003-environment-management-and-maintenance-study-guide-70-284cad9036927f8e63e98462bcb2ebd0c47521.html
http://www.softmaker.net/down/pm2018manual_en.pdf
http://docslide.net/education/mos-2010-study-guide-for-microsoft-word-excel-power-point-and-outlook.html
http://docslide.net/education/mos-2010-study-guide-for-microsoft-word-excel-power-point-and-outlook.html
https://support.microsoft.com/en-gb/office/paste-special-e03db6c7-8295-4529-957d-16ac8a778719?ad=gb&rs=en-gb&ui=en-us
https://support.microsoft.com/en-gb/office/paste-special-e03db6c7-8295-4529-957d-16ac8a778719?ad=gb&rs=en-gb&ui=en-us
https://support.microsoft.com/en-us/office/apply-or-remove-highlighting-1747d808-6db7-4d49-86ac-1f0c3cc87e2e
https://support.microsoft.com/en-us/office/apply-or-remove-highlighting-1747d808-6db7-4d49-86ac-1f0c3cc87e2e
https://epdf.pub/microsoft-office-2010-all-in-one-for-dummies.html
http://link.springer.com/10.1007/978-1-4302-2950-6
http://link.springer.com/10.1007/978-1-4302-2950-6
https://mafiadoc.com/thinkfree-user-guide-40-en-0729_59c641a01723dd830e59ff37.html
https://mafiadoc.com/thinkfree-user-guide-40-en-0729_59c641a01723dd830e59ff37.html
https://manualzz.com/doc/29466648/1-introduction-to-computer
https://epdf.tips/mcse-windows-server-2003-environment-management-and-maintenance-study-guide-70-284cad9036927f8e63e98462bcb2ebd0c47521.html
https://epdf.tips/mcse-windows-server-2003-environment-management-and-maintenance-study-guide-70-284cad9036927f8e63e98462bcb2ebd0c47521.html
http://www.tutorialspoint.com/powerpoint/pdf/powerpoint_broadcast_slide_show.pdf
http://www.tutorialspoint.com/powerpoint/pdf/powerpoint_broadcast_slide_show.pdf
http://www.riftvalleyuniversity.net/Distance/EResources/Modules/Common/Introductiion%20to%20Computer%20Applications1.doc
http://www.riftvalleyuniversity.net/Distance/EResources/Modules/Common/Introductiion%20to%20Computer%20Applications1.doc
http://www.riftvalleyuniversity.net/Distance/EResources/Modules/Common/Introductiion%20to%20Computer%20Applications1.doc
http://www.riftvalleyuniversity.net/Distance/EResources/Modules/Common/Introductiion%20to%20Computer%20Applications1.doc
https://www.coursehero.com/file/46531013/Mail-Merge-Tutorialpdf/
http://link.springer.com/10.1007/978-1-4302-2953-7
http://link.springer.com/10.1007/978-1-4302-2953-7
https://docplayer.net/3437770-Kingsoft-spreadsheet-2012.html
https://forwardthinking.pcmag.com/how-to/how-to-protect-your-microsoft-word-documents
https://forwardthinking.pcmag.com/how-to/how-to-protect-your-microsoft-word-documents


342 

 

21. http://documents.mx/education/statistical-analysis-with-excel-for-dummies.html 

22. http://www.businesseducationmsde.com/uploads/4/6/2/4/4624229/2012_mos_word

__excel_handbook.pdf 

23. http://www.gcflearnfree.org/excel2010/4/print 

24. https://docplayer.net/24363335-Version-reference-guide.html 

25. https://www.urbanpro.com/online-self-paced-class/excel-a-2-z-an-in-depth-tutorial-

with-simplest-logics/1975999 

26. Adam Aspin. "Data Mashup with Microsoft Excel Using Power Query and M", 

Springer Science and Business Media LLC, 2020 

27. http://swcorpcomput.blogspot.com/2011/10/word-2010-guide.html 

28. https://www.slideshare.net/mahantaanjan/step-by-step-microsoft-office-

powerpoint-2007 

29. https://www.stl-training.co.uk/hints-tips-word-15.html 

30. http://www.nassauboces.org/cms/lib5/NY18000988/Centricity/Domain/129/Excel

%202010%20Upgrade%20Manual.pdf 

31. http://media.glnsrv.com/pdf/sos_manual/SOS_ReferenceGuide_School2008_Assig

nments.pdf 

32. http://www.isd309.k12.mn.us/tech_inte/Office%202007%20Handouts/References

%20Ribbon%20in%20Word.pdf 

33. Walkenbach, . "Conditional Formatting and Data Validation", Excel® 2010 

Formulas Walkenbach/Excel, 2011. 

34. Weverka, Peter. "Inserting and Handling Slides", Microsoft® PowerPoint® 2010 

All-in-One for Dummies®, 2014. 

35. https://online.midstate.edu/Downloads/Publications/Student_Handbook.pdf 

36. Building a SharePoint 2016 Home Lab, 2016. 

37. http://www.unitec.ac.nz/shadomx/apps/fms/fmsdownload.cfm?file_uuid=A172EA

EB-145E-6A3C-6EE8-A99EB7D820C0&siteName=unitec 

38. http://www.computerhope.com/jargon/p/pastespe.html 

39. https://www.urbanpro.com/online-self-paced-class/excel-a-2-z-an-in-depth-tutorial-

with-simplest-logics/1975999 

40. http://www.systems2win.com/c/worksheets.html 

 

http://documents.mx/education/statistical-analysis-with-excel-for-dummies.html
http://www.businesseducationmsde.com/uploads/4/6/2/4/4624229/2012_mos_word__excel_handbook.pdf
http://www.businesseducationmsde.com/uploads/4/6/2/4/4624229/2012_mos_word__excel_handbook.pdf
http://www.gcflearnfree.org/excel2010/4/print
https://docplayer.net/24363335-Version-reference-guide.html
https://www.urbanpro.com/online-self-paced-class/excel-a-2-z-an-in-depth-tutorial-with-simplest-logics/1975999
https://www.urbanpro.com/online-self-paced-class/excel-a-2-z-an-in-depth-tutorial-with-simplest-logics/1975999
http://link.springer.com/10.1007/978-1-4842-6018-0
http://link.springer.com/10.1007/978-1-4842-6018-0
http://swcorpcomput.blogspot.com/2011/10/word-2010-guide.html
https://www.slideshare.net/mahantaanjan/step-by-step-microsoft-office-powerpoint-2007
https://www.slideshare.net/mahantaanjan/step-by-step-microsoft-office-powerpoint-2007
https://www.stl-training.co.uk/hints-tips-word-15.html
http://www.nassauboces.org/cms/lib5/NY18000988/Centricity/Domain/129/Excel%202010%20Upgrade%20Manual.pdf
http://www.nassauboces.org/cms/lib5/NY18000988/Centricity/Domain/129/Excel%202010%20Upgrade%20Manual.pdf
http://media.glnsrv.com/pdf/sos_manual/SOS_ReferenceGuide_School2008_Assignments.pdf
http://media.glnsrv.com/pdf/sos_manual/SOS_ReferenceGuide_School2008_Assignments.pdf
http://www.isd300.k12.mn.us/tech_inte/Office%202007%20Handouts/References%20Ribbon%20in%20Word.pdf
http://www.isd300.k12.mn.us/tech_inte/Office%202007%20Handouts/References%20Ribbon%20in%20Word.pdf
http://dx.doi.org/10.1002/9781118257630.ch19
http://dx.doi.org/10.1002/9781118257630.ch19
http://dx.doi.org/10.1002/9781118983904.ch5
http://dx.doi.org/10.1002/9781118983904.ch5
https://online.midstate.edu/Downloads/Publications/Student_Handbook.pdf
http://dx.doi.org/10.1007/978-1-4842-2170-9
http://www.unitec.ac.nz/shadomx/apps/fms/fmsdownload.cfm?file_uuid=A172EAEB-145E-6A3C-6EE8-A99EB7D820C0&siteName=unitec
http://www.unitec.ac.nz/shadomx/apps/fms/fmsdownload.cfm?file_uuid=A172EAEB-145E-6A3C-6EE8-A99EB7D820C0&siteName=unitec
http://www.computerhope.com/jargon/p/pastespe.html
https://www.urbanpro.com/online-self-paced-class/excel-a-2-z-an-in-depth-tutorial-with-simplest-logics/1975999
https://www.urbanpro.com/online-self-paced-class/excel-a-2-z-an-in-depth-tutorial-with-simplest-logics/1975999
http://www.systems2win.com/c/worksheets.htm

	Inner Title.pdf
	Unit-1.pdf
	Unit-2.pdf
	Unit-3.pdf
	Unit-4.pdf
	Unit-5.pdf
	Unit-6.pdf
	Unit-7.pdf
	Unit-8.pdf
	Unit-9.pdf



